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Lab: Installing Microsoft- Exchange Server 2007

Lab: Installing Microsoft Exchange Server 2007

¢ Exercise 1: Installing Exchange Server 2007

¢ Exercise 2:Performing a command line
install of Exchange Server 2007

Time estimated: 60 minutes
Lab objectives
After completing this lab, you will be able to:

Verify prerequisites for a new Microsoft® Exchange Server 2007 installation.
Install the Hub Transport Server and Mailbox Server roles on a single server.
Verify a successful installation.

Use the built-in Exchange Server Best Practices Analyzer (EXBPA) to verify whether the new
installation complies with recommended best practices.

Use the command line to perform an Exchange Server 2007 server role installation.

Introduction
In this lab, you will use the INSTALL_SMBEXO01 virtual computer.



Exercise 0: Preparing the Environment

Prepare the environment

Summary Detailed Steps
e To prepare for this lab, 1. Start the INSTALL_SMBEXO1 virtual server.
start the

INSTALL _SMBEXO01
virtual server.



Exercise 1: Installing Exchange Server 2007

Introduction

In this exercise, you will install a new Exchange Server 2007 server with the Mailbox and Hub
Transport Server roles on a single server using the GUI installation tools. You will learn to check the
prerequisites using a prerequisites scanner built into the Exchange installation program. You will then
install a new Exchange Server 2007 server with Mailbox and Hub server roles.

Scenario

Northwind Traders, a small gourmet food distribution company, has made a decision to implement
Exchange Server 2007 as their e-mail system. They wish to install Exchange Server 2007 on a single
server. Northwind Traders must make sure that the server is adequately prepared and that their
network environment meets the prerequisites for a new Exchange installation.

Prepare for a new Exchange Server 2007 installation

Summary Detailed Steps

e  Open the Exchange 1. Onthe INSTALL_SMBEXO1virtual server, log on to the
Server 2007 Setup NWTRADERS domain as Administrator with a password
Program and verify that of P@sswOrd
all prerequisites are 2. Click Start, point to All Programs, point to Accessories,

installed. and then click Windows Explorer.

Navigate to D:\ and then double-click Setup.exe.

On the first screen notice the five steps listed under Install:
Step 1: Install .NET Framework 2.0

Step 2: Install Microsoft Management Console (MMC)
Step 3: Install Microsoft Windows PowerShell

Step 4: Install Microsoft Exchange

Step 5: Get Critical Updates for Microsoft Exchange

Notice that steps 1 through 3: Install NET Framework 2.0,
Install Microsoft Management Console and Install Microsoft
Windows PowerShell links are grayed out. These prerequisite
components have already been installed for you.

Select options for a new Exchange Server 2007 installation

Summary Detailed Steps

e Choose to install Mailbox 1. On the Start screen, in the Install list, click Step 4: Install
and Hub Transport server Microsoft Exchange.
roles. 2. On the Introduction page, click Next.

3. On the License Agreement page, review the agreement, and
then click I accept the terms in the license agreement, and
then click Next.

4. On the Error Reporting page, verify that No is checked, and
then click Next.

5. On the Installation Type page, click Custom Exchange



Server Installation, and then click Next.

6. On the Server Role Selection page, check the boxes for
Mailbox Role and Hub Transport Role, and then click
Next.

Note Notice that Management Tools gets automatically checked when you
select to install any server role.

7. On the Client Settings page, verify that No is checked, and
then click Next.

Setup will now perform the prerequisite checks for each role.
(Approximately 1 minute).

Important If there were any prerequisites that were needed, setup would
discontinue and provide a link to download the necessary files. For the
purposes of this lab, all required components have been preinstalled.

Install Microsoft Exchange Server 2007
Summary Detailed Steps

e Scan the installation

prerequisites again and Note The Installation Readiness Checks have been completed successfully.

roceed with the Read the warning that Outlook Web Access and ActiveSync will not work
p . until a Client Access role is installed, and the warning regarding the 32-bit
installation of Exchange . . X
Server 2007 version of Exchange Server 2007 not being supported for production use.

1. On the Readiness Checks page, click Install.

2. Observe the progress of the installation as it is displayed. The
installation program is now:

e Copying Exchange files (2 minutes)
o Installing the Hub Transport Role (7 minutes)
e Installing the Mailbox Role (10 minutes)

Important When installing for the first time, the first step during installation
would prepare Active Directory for Exchange Server 2007. To save time in
this lab, Active Directory has already been prepared.

On the Completion page, click Finish.

On the Exchange Server 2007 Install screen, click Close.
In the Confirm Exit dialog box, click Yes.

The Exchange Management Console will open. Minimize it.

N o g bk~ w

Close Windows Explorer.

View server configuration in Exchange Management Console
Summary Detailed Steps



e Explore the Exchange
Management Console.

Answer Key

4.

Switch to the Exchange Management Console. In the
Navigation pane, click Server Configuration.

In the Microsoft Exchange licensing dialog box, click OK.
What roles have been installed?

In the Actions pane, click Manage Mailbox Role.

Has a database been created?

Leave Exchange Management Console running.

2. Hub Transport and Mailbox roles.

3. Yes, a database named Mailbox Database.

Ensure that the new installation complies with best practices (Optional)
Detailed Steps

Summary

e  Use the Microsoft
Exchange Best Practices
Analyzer tool to scan the
new installation for
compliance with
recommended best
practices.

1.

10.

11.

12.
13.

In the Navigation pane of the Exchange Management
Console, click Toolbox.

In the Toolbox, double-click Best Practices Analyzer.

On the Update and Customer Feedback page, select Do not
check for updates on startup, select I don’t want to join
the program at this time, and then at the bottom of the page
click Go to Welcome Screen.

On the Welcome page, click Select Options for a new scan.

On the Connect to Active Directory page, click Connect to
the Active Directory server.

On the Start a New Best Practices Scan page, verify Heath
Check is selected and then click Start scanning.

Wait for the Best Practices Analyzer tool to scan.
(approximately 4 minutes)

When the scan has completed, click View a report of this
Best Practices scan.

In View Best Practices Report, click the All Issues tab.
Browse through the issues.

Did the scan report any critical issues?
Click Export Report.

In Export Report, type NWTraders Post-Install report and
click Save.

Click the Informational Items tab, review the detailed
information gathered.

Close the Best Practices Analyzer.

Open Windows Explorer, navigate to C:\Documents and
Setting\Administrator\Application
Data\Microsoft\ExBPA and then double-click NWTraders



14.

Answer Key

Post-Install report.xml.

View the report, and then close Internet Explorer and
Windows Explorer.

8. No, only some warnings and best practices messages.

Create a new user

Summary Detailed Steps

e Create a user named Mike 1. Onthe INSTALL SMBEXAOL1 virtual server, maximize the
Ray using the Exchange Exchange Management Console.
Management Console. 2. In the Exchange Management Console, in the Navigation

10.
11.

12.
13.
14.

Tree, click Recipient Configuration.
In the Action Pane, click New Mailbox.

On the Introduction page, verify that User Mailbox is
selected and click Next.

On the User Type page, select New user and click Next.

On the User Information page, click Browse to select an
Organizational Unit.

In Select Organizational Unit, click Managers and then click
OK.

In the First Name box, type Mike.
In the Last Name box, type Ray.
In the User logon name box, type mike.

In the Password and Confirm Password boxes, type
P@sswOrd and click Next.

On the Mailbox Settings page, click Next.
On the New Mailbox page, click New.
On the Completion page, click Finish.



Exercise 2: Performing a command line install on Exchange Server 2007

Introduction

In this exercise, you will install an additional server role, Client Access, on the Exchange Server 2007
server INSTALL_SMBEXO01 by using command-line tools.

Scenario

Northwind Traders wants to add the Client Access server role to the company’s Exchange Server 2007
infrastructure. A consultant hired by Northwind Traders recently created instructions for installing
Exchange configurations by using command-line tools. You will follow these instructions to install
the Client Access server role.

Install the Client Access server role using the command-line.

Summary Detailed Steps

e Perform a command-line 1. OnINSTALL_SMBEXO01, click Start, point to All
install of the Client Programs, point to Accessories, and then click Command
Access server role. Prompt.

2. At the command prompt, type the following command and
then press ENTER:

Exsetup /roles:ClientAccess /mode:install

3. Observe the command-line installation progress through the
following stages:

a. Client Access Role Checks (less than 1 minute)

b. Copying Exchange files (approximately 3 minute)

c. Installing Client Access Role (approximately 4 minutes)
Wait for the Client Access Role to be installed.

4. When the The Microsoft Exchange server setup operation
completed successfully message appears, close the
command prompt by typing exit and then pressing ENTER.

View server configuration in Exchange Management Console
Summary Detailed Steps

1. Switch to the Exchange Management Console. If it is not
already running, click Start, point to All Programs, point to
Microsoft Exchange Server 2007, and then click Exchange
Management Console.

e Review the configuration
of the newly installed
server in the Exchange
Management Console.

2. Inthe Exchange Management Console, in the Navigation
pane, click Server Configuration.

3. Inthe Action Pane, click Refresh.
What roles have been installed?
4. Leave the Exchange Management Console running.



Answer Key

3. Client Access, Hub Transport, and Mailbox roles

Log onto Outlook Web Access
Summary

e Use Microsoft Office
Outlook® Web Access to
confirm Client Access
Role.

Detailed Steps

1.

Click Start, point to All Programs, and then click Internet
Explorer.

In Internet Explorer, in the Address bar, type
https://SMBEX01.nwtraders.com/OWA and then press
ENTER.

On the Certificate Error page, click Continue to this
website.

Note The default certificate installed during setup is a self-signed certificate
that is not trusted. In a production environment, you would use a trusted
certificate.

4.

5.

Log on to Outlook Web Access as mike with a password of
P@sswOrd

On the Accessibility page in Outlook Web Access, click OK.

Ensure mail flow by using Outlook Web Access
Detailed Steps

Summary

e Send a test e-mail
message to verify mail
flow.

1.

2.

In Outlook Web Access running as Mike Ray, click New to
create a new message.

In the new e-mail message, in the To box, type mike and
then press CTRL + K to resolve the name.

In the Subject line, type Exchange Installed Successfully!

In the message body, type Installed Exchange Server 2007
today.

Click Send.
Wait a minute for the new mail to send, and then in Outlook

:
Web Access, click Check Messages = |

Note that the new message has arrived and is visible in the
preview pane.

In Outlook Web Access, click Log Off.
Close Internet Explorer.



Lab: Using the Exchange Server 2007 Management Console and
Shell

Lab: Using the Exchange Server 2007 Management
Console and Shell

¢ Exercise 1: Using the Exchange
Management Console

¢ Exercise 2: Using the Exchange
_ Management Shell

-

-« Exercise 3: Administering Outlook Web

Access Features Using the Exchange
e Management Console and Exchange
Pj Management Shell

4 ¢ Exercise 4: Creating and Using
Administrative Scripts

o>
§IREY

Time estimated: 60 minutes
Introduction

In this lab, you will use the SMBEXO01 and Client01 virtual computers to gain hands-on experience
using the Microsoft® Exchange Management Console and Exchange Management Shell.

Lab objectives
After completing this lab, you will be able to:
e Use the Exchange Management Console to perform common administrative tasks.
e Use the Exchange Management Shell prompt to view information about an Exchange server.

o Use the Exchange Management Shell to perform Exchange administrative tasks from the
command line.

o Create reusable administrative scripts to automate routine administration tasks.

Prerequisites
This lab does not depend on any previous labs being completed.



Exercise 0: Preparing the Environment

Prepare the environment

Summary
e  Start the SMBEXO01 and 1.
CLIENTOL1 virtual
servers.
2.
3.
4,

Detailed Steps

Click Start, point to All Programs, point to Microsoft
Virtual Server, and then click Virtual Server
Administration Website.

On the Virtual Server Administration Website, move the
mouse pointer over SMBEXO01, and then click Turn On.

Once the Status of SMBEXO01 shows as Running, move the
mouse pointer over SMBEXO01, and click Remote Control.

When SMBEXO01 has fully started, on the Virtual Server
Administration Website, move the mouse pointer over
CLIENTO1, and then click Turn On.



Exercise 1: Using the Exchange Management Console

Introduction

In this exercise, you will use the Exchange Management Console to perform common administrative

tasks.

Scenario

You are the Exchange administrator at Northwind Traders. The company recently implemented
Exchange Server 2007, and you would like to take a tour of the features of the new Exchange
Management Console. In particular, you want to find new ways to perform administrative tasks by

using the new interface.

Log on to SMBEX01
Summary

e Logonto SMBEXO1.

Detailed Steps

1. Onthe SMBEXO0L1 Virtual Server console, press the RIGHT-

ALT and DELETE keys.

2. Log on to the NWTRADERS domain as Administrator

with a password of P@sswOrd

Explore the Exchange Management Console

When performing this exercise, you can refer to the following illustration of the Exchange
Management Console and its various user interface (Ul) components.

Em:hange Management Console

Recipient Configuration
=8 Toolbox

NAVIGATION TREE

RESULT PANE

G SMBEXO01 4 objects

Database Management |

M ame | Databage File Path

= 7 First Storage Group
i Mailbox Databaze
= 7 Second Storage Group
“IPublic Folder Database  C:\Program Files\Micosoft\Exchange 5

C:\Program Files\Microsoft\Exchange S

WORK PANE

i =]
File Action View Help
« = |@m 2
:,’;! Microsoft Exchange Es Mailbox TN [Actions
= Errirlil s :
2 Wig »
Hub Tra Refresh
= Unified Messaging @ Help

ACTION PANE +
SMBEX01

7= Manage Hub Transport...
5% Manage Client Access ...
: Mesw storage group...

Properties

Mailbox Database
: "5 Mowve Database Files, ..

|9 Dismount Database

x Remove
Properties

@ Help

4| | |




Summary

Explore the Exchange
Management Console.

Detailed Steps

1.

10.

11.

12.

13.

On the SMBEXO01 virtual server, click Start, click All
Programs, click Microsoft Exchange Server 2007, and
then click Exchange Management Console.

Wait for the Exchange Management Console environment
to load.

In the navigation tree, expand Server Configuration, and
then click Client Access.

Notice the pane in the top-center area of the screen that
displays all client access servers. This is the Results Pane.

In the Results Pane, click SMBEXO01.

Notice the pane on the right side of the screen that displays
all available actions. This is the Action Pane.

In the Action Pane under SMBEXO01, click Properties.

Notice that the properties of the SMBEXO01 Exchange
Server are displayed.

In the SMBEXO01 Properties window, click OK.

Notice the pane in the lower-center area of the screen. This
is the Work Pane.

In the Work Pane, double-click owa (Default Web Site).

In the owa (Default Web Site) Properties window, click the
Segmentation tab.

Notice the features in Microsoft Office Outlook® Web
Access that can be enabled or disabled here.

In the owa (Default Web Site) Properties window, click
Cancel.

In the Action Pane, click Manage Mailbox Role.

Notice that Mailbox is selected in the navigation tree, and
that the Work Pane displays Storage Groups and Databases.

In the Work Pane, under First Storage Group, click
Mailbox Database.

In the Action Pane under Mailbox Database, click
Properties.

Notice the three tabs and the configurable settings on each
of these tabs.

Click Cancel to close the Mailbox Database Properties
window.

In the navigation tree, click Toolbox.
Here you can access:
e Best Practices Analyzer
o Database Recovery Management
o Database Troubleshooter



Enable a mailbox for the user Preeda Ola

Summary

Create a mailbox for a new user

On the SMBEX01
mailbox server, enable a
mailbox for the user
Preeda Ola.

Summary

On the SMBEX01
mailbox server, create a
mailbox for a new user.

e Mail Flow Troubleshooter

e Message Tracking

e Queue Viewer

e Performance Monitor

e Performance Troubleshooter

Detailed Steps

1.

7.
8.
9.

In the Exchange Management Console, in the navigation
tree, expand Recipient Configuration.

Under Recipient Configuration, click Mailbox.

In the Results Pane, view the mailboxes that have already
been enabled.

In the Action Pane, click New Mailbox.

On the Introduction page, verify that User Mailbox is
selected, and then click Next.

On the User Type page, select Existing user and then click
Browse.

In the Select User window, double-click Preeda Ola.
On the New Mailbox page, click Next.
On the Mailbox Settings page, click Next.

10. Review the Configuration Summary, and then click New.

11. On the Completion page, click Finish.

In the Results Pane, note that a mailbox has been enabled
for Preeda Ola.

Detailed Steps

1.

In the Exchange Management Console, in the Action Pane,
click New Mailbox.

On the Introduction page, ensure that User Mailbox is
selected, and then click Next.

On the User Type page, verify that New user is selected,
and then click Next.

On the User Information page, click Browse to select an
Organizational Unit.

In Select Organizational Unit, click Production, and then
click OK.

In the First name box, type Dan



10.
11.
12.

Create mailboxes for meeting rooms
Detailed Steps

Summary

e Onthe SMBEX01
mailbox server, enable
mailboxes for Meeting
Room Michigan and
Meeting Room Huron.

Create a new storage group
Summary
o Create a new storage

group, placing log files
and system files on the

1.

© © N o o

12.

13.

In the Last name box, type Park
In the User logon name box, type Dan

In the Password and Confirm Password boxes, type
P@sswOrd and then click Next.

On the Mailbox Setting page, click Next.
On the New Mailbox page, click New.
On the Completion page, click Finish.

In the Results Pane, notice that a mailbox has been enabled
for Dan Park.

In the Exchange Management Console, in the Action Pane,
click New Mailbox.

On the Introduction page, select Room Mailbox and then
click Next.

On the User Type page, select Existing user and then click
Browse.

In the Select User window, double-click Meeting Room
Michigan.

Note: Only Disabled accounts are available for selection
when Resource Mailbox is chosen for the mailbox type.

On the User Type page, click Next.

On the Mailbox Settings page, click Next.

Review the Configuration Summary and then click New.
On the Completion page, click Finish.

Repeat steps 1 through 8 for Meeting Room Huron.

. In the Results Pane, click Create Filter.
11.

In the Results Pane, in the first drop-down list, select
Display Name, and then in the operator drop-down list,
select Starts With.

In the value box, type Meeting and then click Apply Filter.
Notice that all mailbox-enabled meeting rooms are listed.
In the Results Pane, click Remove Filter.

Detailed Steps

1.

2.

In the Exchange Management Console, in the navigation
tree, under Server Configuration, click Mailbox.

In the Results Pane, select SMBEXO01.



C:\Disk 1 mounted drive.

w

In the Action Pane, click New Storage Group.

On the New Storage Group page, in the Storage group
name box, type Fourth Storage Group

Next to Log files path, click Browse, select
C:\Disk1\SG4\L ogs, and then click OK.

Next to System files path, click Browse, select
C:\Disk1\SG4, and then click OK.

On the New Storage Group page, click New.

Notice how the Completion page shows the Management
Shell command you could have used from the Exchange
Management Shell to perform the same task. You will work
with the Exchange Management Shell in the next exercise.

Click Finish.



Exercise 2: Using the Exchange Management Shell

Introduction

In this exercise, you will learn how to use the Exchange Management Shell to perform common tasks
and export information about Exchange Server configuration.

Scenario

You are the Exchange administrator at Northwind Traders. The company recently implemented
Exchange Server 2007, and you have been tasked with investigating how routine administrative tasks
and reporting could be performed more efficiently. You explore the Exchange Management Shell, a
command-line language that allows you to easily script administrative tasks and produce reports.

Explore the Exchange Management Shell environment

Summary Detailed Steps

e Using the Exchange 1. Onthe SMBEXO1 virtual server, click Start, click All
Management Shell, Programs, click Microsoft Exchange Server 2007, and
practice common then click Exchange Management Shell.
Exchange Management Wait for the Exchange Management Shell environment to

Shell commands such as

get-help, and practice
date and string 2. Atthe PowerShell (PS) prompt, type cd \ and then press

manipulation. ENTER. (Note: there is a space between CD and \.)

load. (This may take up to 30 seconds.)

This will make the command line more visible.
3. Atthe PS prompt, type get-help and then press ENTER.

Notice that the “Introduction to the Microsoft Shell (PS)”
Help topic is shown.

4. Atthe PS prompt, type get-help about_* and then press
ENTER.

Notice that all Help topics starting with “about_” are listed.

5. At the PS prompt, type get-help about_if and then press
ENTER.

Notice that a Help topic on the if flow control statement is
shown.

6. At the PS prompt, type get-date and then press ENTER.
Notice that the current date and time are shown.

7. Create a variable named $today and assign it the value
returned from the get-date commandlet. To do this, type the
following text and then press ENTER:

$today = get-date

Notice that there is no output displayed from this
command.

8. Atthe PS prompt, call the ToShortTimeString method of
the date variable you just created. To do this, type the
following text and then press ENTER:

$today.ToShortTimeString()



At the PS prompt, call the ToString method of the $Today
variable, passing it in the format of MMMM (long month
only). Then, call the ToUpper method of the resulting string
to convert it to uppercase format. To do this, type the
following text and then press ENTER:

Stoday.ToString(“MMMM”).ToUpper()

Notice that the output shows the current month name in
uppercase format.

Use the Exchange Management Shell pipeline

Summary

Pipe the results of the get-
excommand commandlet
through to C:\Labs\ems\
ExchangeCommands.txt.

Create a new Mailbox
Database by using the
Exchange Management
Shell.

Mount and dismount the
Mailbox Database.

Detailed Steps

1.

At the PS prompt, type get-excommand and then press
ENTER.

Notice that a list of Exchange commands was returned.

Redirect the output of the commandlet to a text file named
C:\Labs\ems\ExchangeCommands.txt. To do this, type
the following text and then press ENTER:

get-excommand >> C:\Labs\ems\ExchangeCommands.txt

Notice that there is no output displayed from this
command.

Open Microsoft Windows® Explorer and navigate to
C:\Labs\ems.

Double-click ExchangeCommands.txt to open this file in
Notepad.

Notice that a list of Exchange administration commands is
displayed in the text file.

Click the Edit drop-down menu, select Find.

In the Find What box, type dismount and then click Find
Next.

Do any Exchange Management Shell commands allow you
to dismount a database?

In the Name column, locate the noun mailbox by doing a
search for -mailbox. Items in the Name column are in the
form of verb-noun.

What mailbox verbs can be performed with Exchange
Management Shell?

Close Notepad.
Switch back to the Exchange Management Shell.

Tip Atthe PS prompt, type get-help new-MailboxD and then press the
TAB key. Notice how the command is auto-completed. Press ENTER.

10. At the PS prompt, type the following text and then press

ENTER:



10

New-MailboxDatabase -StorageGroup ""SMBEX01\Fourth
Storage Group' -Name ""Mailbox Database 4" -EdbFilePath
"'c:\disk1\SG4\db\mailbox database 4.edb™

Notice that the properties of the new mailbox database are
displayed.

11. Switch to the Exchange Management Console, expand
Server Configuration, and then click Mailbox. Notice that
the new mailbox database is displayed in the console. Click
Refresh in the Action Pane if necessary.

12. Switch to the PS prompt and type the following to mount
the database and press ENTER:

Mount-Database ""Mailbox Database 4"

Notice that there is no output displayed from this
command.

When the command has completed, open Windows
Explorer and navigate to the C:\disk1\SG4\db and
C:\disk1\SG4\logs folders. Notice how the database and
supporting files have been created.

13. Switch to the Exchange Management Console and then
press F5 to refresh the view.

Answer Key

5. Yes, Dismount-Database
6. connect, disable, enable, export, get, move, new, remove, restore, set

Use Exchange commandlets

Summary Detailed Steps

e View the output of the 1. Atthe PS prompt, type get-mailbox and then press ENTER.
get-mailbox command. Notice that a list of all mailboxes and some properties are

o Pipe the results of the get- displayed in a table.
mailbox commandlet to 2. To display more mailbox information, pipe the results of the
other commands. getmailbox command to format-list by typing the following

e Configure the Send Quota and then pressing ENTER. Remember to press TAB to auto-
for all mailboxes with a complete.
single command line. get-mailbox Spencer | format-list

3. Set the Send Quota for all mailboxes to 18 MB by typing the
following text and then pressing ENTER:

get-mailbox | set-mailbox -ProhibitSendQuota 18MB
Notice that there is no output displayed from this command.
4. Confirm that the Send Quota limit has been set for all
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mailboxes by typing get-mailbox and then pressing ENTER.

5. Create a variable named $mailbox and assign it the value
returned from the get-mailbox "*Administrator"
commandlet. To do this, type the following text and then
press ENTER:

$mailbox = get-mailbox " Administrator"
Notice that there is no output displayed from this command.

6. View the value of the PrimarySMTPAddress property of
the mailbox object. To do this, type the following text and
then press ENTER:

$mailbox.PrimarySMTPAddress. ToString()

Notice that the primary SMTP address for this mailbox is
displayed.

Export object information using the Exchange Management Shell

Summary

Export the output of the
get-exchangeserver
commandlet to a comma-
separated value (CSV)
file.

Export the output of the
get-storagegroup
commandlet to an
Extensible Markup
Language (XML) file.

Detailed Steps

1. Atthe PS prompt, type get-help export-* and then press
ENTER.

Notice that the available export functions are listed.

2. Use the export-csv command to export the output of the get-
exchangeserver commandlet to a CSV file named
C:\Labs\ems\MyServer.txt. To do this, type the following
text and then press ENTER:

export-csv -Path ""C:\Labs\ems\MyServer.txt" -InputObject
(get-exchangeserver)

Notice that there is no output displayed from this command.

3. Switch to Windows Explorer and navigate to the
C:\Labs\ems\ folder.

4. Double-click MyServer.txt to open it in Notepad.

Notice that a comma-separated list of Exchange Server
properties and their values has been exported.

What is the value of the DataPath property?
Close Notepad.

Switch to the Exchange Management Shell and use the
export-clixml command to export the output of the get-
storagegroup "'First Storage Group® commandlet to an
XML file named C:\Labs\Lab1\FirstSG.xml. To do this,
type the following text and then press ENTER:

export-clixml -Path "'C:\Labs\ems\FirstSg.xml"* -InputObject
(get-storagegroup “First Storage Group”)

Notice that there is no output displayed from this command.

7. Switch to Windows Explorer and navigate to the
C:\Labs\ems\ folder.
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8. Double-click FirstSG.xml to open it in Microsoft Internet
Explorer.

Notice that an XML representation of the storage group
object and all of its properties is shown. Based on the XML
report, perform searches to answer the following questions:

a. What is the value of the PathName property?

b. Is circular logging enabled on this storage group? (Search
for “CircularLogging”.)

c. Is online defragmentation enabled on this storage group?
(Search for “OnlineDefrag”.)

d. What is the RDN (Relative Distinguished Name) of the
server this storage group resides on?

9. Close Internet Explorer.

Answer Key

4. C:\Program Files\Microsoft\Exchange Server\Mailbox

8. a. C:\Program Files\Microsoft\Exchange Server\Mailbox\First Storage Group
b. No
c. Yes
d. CN=SMBEX01

Use the Exchange Management Shell to create a mail-enabled group and add a user to it

Summary Detailed Steps

e Use the Exchange 1. At the PS prompt, call the New-DistributionGroup
Management Shell Add- commandlet and pass parameters to create a new group. To
DistributionGroupMem do this, type the following text and then press ENTER:
ber commandlet to add New-DistributionGroup -Name "IT Staff*

Spencer Low to the mail-

-OrganizationalUnit "*'nwtraders.com/Information
enabled group IT Staff.

Technology' -SamAccountName "'IT Staff'" -Type
“Distribution”

Notice the new distribution group properties are displayed.

2. Atthe PS prompt, call the
Add-DistributionGroupMember Exchange commandlet,
passing the group name to the Identity parameter. To do
this, type the following text and then press ENTER:

Add-DistributionGroupMember -Identity **IT Staff*
-Member spencer

Notice that there is no output from this command.

3. Atthe PS prompt, call the Get-DistributionGroupMember
Exchange commandlet, passing the group name to the
Identity parameter. To do this, type the following text and
then press ENTER:

Get-DistributionGroupMember -ldentity "IT Staff"
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Notice that Spencer is a member of the IT Staff distribution
group.

Use the Exchange Management Shell to display a property of the mail-enabled group
Summary

Use the Write-Host
command to display the
PrimarySmtpAddress
property of the IT Staff
distribution group by
using the Get-
DistributionGroup
Exchange commandlet.

Detailed Steps

1. Atthe PS prompt, use the Write-Host command to display
the PrimarySmtpAddress property of the IT Staff
distribution group by using the Get-DistributionGroup
Exchange commandlet. To do this, type the following text
and then press ENTER:

Write-Host (get-DistributionGroup "nwtraders\IT
Staff'").PrimarySmtpAddress

2. To view the names of all properties of the group object, type
the following and then press ENTER:

Get-DistributionGroup | Get-Member -MemberType
Property

Scroll up to review the names of all of the properties.

Use the Exchange Management Shell to check the health of the Exchange services
Summary

Use Test-ServiceHealth
to check the health of the

Exchange services

running on this computer.

Detailed Steps

1. Atthe PS prompt, type the following text and then press
ENTER:

Test-ServiceHealth

Notice how this commandlet displays the role of the server,
along with the required services and whether they are
running or not.
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Exercise 3: Administering Outlook Web Access Features Using the Exchange
Management Console and Exchange Management Shell

Introduction
In this exercise, you will administer Outlook Web Access (OWA) features as follows:

e Use the new Exchange Management Console to enable access to Remote File Shares using OWA.
e Use the Exchange Management Shell to enable/disable features of Outlook Web Access.

e Configure Exchange Server 2007 to provide features differently for Public and Private access to
Outlook Web Access.

Scenario

Northwind Traders has a number of file servers installed internally. In the past, the company’s IT
Department had to configure remote access server (RAS)/virtual private network (VPN) access to
these documents. The company’s vice president, Spencer Low, wants to investigate the new features
of Outlook Web Access that provide external access to internal file share documents without
RAS/VPN. She wants to investigate how the company’s IT team can manage Outlook Web Access
features by using the Exchange Management Console and Exchange Management Shell. She also
wants to determine which features can be enabled and disabled.

Important Please verify you have started the Client01 virtual server as instructed in Exercise 0
before starting this lab.

Configure Exchange Server 2007 to allow access to internal file shares through Outlook Web Access
Summary Detailed Steps

e Using the Exchange 1. Onthe SMBEXOL1 virtual server, click Start, click All
Management Console, Programs, and then click Internet Explorer.
configure the host name 2. In Internet Explorer, in the Address bar, type
of an internal file server http://SMBEX01.nwtraders.com/OWA and then press
to be on the Allow list. ENTER.

e Use Outlook Web 3. Log on to Outlook Web Access as spencer with a password
Access to access the of P@sswOrd

internal file share. In the bottom-left pane, click Documents.

In the left pane, click Open Location.

In Open Location, type \\client0O1\PublicDocs and then
click Open.

Note: The file share will not open. This is intentional.

7. Read the Location Blocked dialog box stating that Outlook
Web Access has been configured to prevent access to this
folder, and then click OK.

8. Click the X to close the Open Location dialog box.

On SMBEX01, switch to the Exchange Management
Console.

10. In the Exchange Management Console, expand Server
Configuration, click Client Access, and then wait for the
Results Pane to populate.
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12.

13.
14.

15.
16.
17.
18.

19.

20.

21.

15

. In the Work Pane, click owa (Default Web Site), and then
in the Action Pane under owa (Default Web Site), click
Properties.

In owa (Default Web Site) Properties, click the Remote
File Servers tab.

On the Remote File Servers tab, click Allow.

In the Allow Liist field, type clientO1 and click Add, and
then click OK.

Click OK to close owa (Default Web Site) Properties.
Switch to Outlook Web Access running as Spencer Low.
In the left pane, click Open Location.

In the Open Location field, type \\clientO1\PublicDocs and
then click Open.

Notice that the file share is now accessible from Outlook
Web Access.

In Outlook Web Access running as Spencer Low, right-click
Project X, and then click Open.

Click Add to Favorites, and notice how Project X now
appears in the Favorites list in the left pane of OWA. Click
OK.

Click Log Off to log off Spencer Low from Outlook Web
Access, and then close Internet Explorer.

Manage Outlook Web Access settings using the Exchange Management Shell

Summary

Use the Exchange
Management Shell
to determine the
enabled settings for
Outlook Web
Access.

Detailed Steps

1. Switch to the Exchange Management Shell.

2. At
Get-Ow.

the PS prompt, type the following and then press ENTER:
aVirtualDirectory -identity *‘owa (Default Web Site)" | FL

3. Scroll through the list of results and find the value for

Re

moteDocumentsAllowedServers.

4. Filter the results of this command to list only the values that
contain the word “enable.” At the PS prompt, type the following
and then press ENTER:

Get-Ow.

aVirtualDirectory -identity *‘owa (Default Web Site)" | FL

*enable*

5. Filter the results of this command to list only the values that
contain the word “webready.” At the PS prompt, type the

fol
Get-Ow.

lowing and then press ENTER:
aVirtualDirectory -identity ""owa (Default Web Site)" | FL

*webready*

Notice how the
ForceWebReadyDocumentViewingFirstOnPublicComputers
value is set to False.
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6.

Set the
ForceWebReadyDocumentViewingFirstOnPublicComputers
value to True. At the PS prompt, type the following and then
press ENTER:

Set-OwaVirtualDirectory -identity "owa (Default Web Site)"
-ForceWebReadyDocumentViewingFirstOnPublicComputers
$True

7.

10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

Confirm that the setting has taken effect. In the Exchange
Management Console, expand Server Configuration, click
Client Access, and then wait for the Results Pane to populate.

In the Results Pane, click owa (Default Web Site), and then in
the Action Pane under owa (Default Web Site), click
Properties.

In the owa (Default Web Site) Properties dialog box, click the
Public Computer File Access tab.

On the Public Computer File Access tab, notice that the Force
WebReady Document Viewing when a converter is available
check box is selected, and then click OK.

Note: The configuration you made above could have been set by
using this dialog box. However, for the purposes of this lab, you
set this configuration by using the Exchange Management Shell

method.

Click Start, click All Programs, and then click Internet
Explorer.

In Internet Explorer, in the Address bar, type
http://SMBEXO01.nwtraders.com/OWA and then press
ENTER.

On the Outlook Web Access logon page, click This is a public
or shared computer.

Log on to Outlook Web Access as spencer with a password of
P@sswOrd.

In Outlook Web Access running as Spencer Low, in the bottom-
left corner, click Documents.

In Outlook Web Access running as Spencer Low, in the
Documents pane, click Project X.

Right-click the Sales Figures document and then click Open as
Web Page.

Notice how the document is converted and opens as a read-only
copy in Internet Explorer.

Close the document, log off from Outlook Web Access running
as Spencer Low, and then close Internet Explorer.

Configure Outlook Web Access to prohibit viewing of
documents from public computers by performing the following
steps. In the Exchange Management Console, expand Server
Configuration, click Client Access, and then wait for the
Results Pane to populate.



20.

21.

22.

23.

24.

25.

26.

27.

28.

29.

30.
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In the Work Pane, click owa (Default Web Site), and then in the
Action Pane under owa (Default Web Site), click Properties.

In the owa (Default Web Site) Properties dialog box, click the
Public Computer File Access tab.

On the Public Computer File Access tab, clear all of the check
boxes, and then click OK.

Click Start, click All Programs, click Accessories, click
Command Prompt, and then wait for the command prompt to
open.

At the command prompt, type iisreset /noforce and then press
ENTER to run IISRESET. Wait for the services to restart, and
then close the command prompt.

Click Start, click All Programs, and then click Internet
Explorer.

In Internet Explorer, in the Address bar, type
http://SMBEXO01.nwtraders.com/OWA and then press
ENTER.

In the Forms-Based Authentication dialog box that appears,
click This is a public or shared computer.

Log on to Outlook Web Access as spencer with a password of
P@sswOrd.

Notice that there is no longer a Documents button in the lower-
left pane of Outlook Web Access.

Log off from Outlook Web Access and then log on again as
Spencer, but this time click This is a private computer on the
logon screen.

Notice that the Documents button now appears because you
have logged on while selecting the Private Computer option.

Log off from Outlook Web Access and close Internet Explorer.
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Exercise 4: Creating and Using Administrative Scripts
Introduction

In this exercise, you will create a reusable Exchange Management Shell script to create users from a
custom text file and then mailbox-enable these users. Initially, you will run the New-Mailbox
command on a single line. You will then user the Import-CSV command to read a CSV file and pass
the text to the New-Mailbox command. Finally, you will create a reusable script file that parses a
CSV file, creates users and mailboxes, and sets the password.

Scenario

Northwind Traders has a large sales force, including temporary sales staff members who begin new
assignments every day. As the company’s Exchange administrator, you want to automate the task of
creating user accounts and mailboxes for the new temporary sales personnel. The current human
resources (HR) system exports all new users to a comma separated value (CSV) text file at the end of
each day. You will use the Exchange Management Shell to write a script that will parse the CSV file,
create users, and enable mailboxes for all new sales staff exported from the HR system. You plan to
schedule the file to run every night.

Use the New-Mailbox commandlet to create a user and a mailbox
Summary Detailed Steps

e Use the New-Mailbox 1. Switch to the Exchange Management Shell.
commandlet to create a

user and a mailbox by
passing parameters to it.

2. Create a new user and mailbox by typing the following text
and then pressing ENTER:

new-mailbox -alias Sven -UserPrincipalName
Sven@nwtraders.com -Name "'Sven Buck'" -Database
"mailbox database" -OrganizationalUnit Sales

3. When prompted for the password, type P@sswOrd and
then press ENTER.

4. Switch to the Exchange Management Console, expand
Recipient Configuration, and then click Mailbox. Press
F5 to refresh the view. You will see the new mailbox for
Sven in the Results Pane.

Note: Although this is a useful one-line command, it is
not ideal for creating multiple users. In the next section,
you will use a CSV file as the input for creating multiple
mailboxes by using the new-mailbox command.

Use the Import-csv commandlet to create users and mailboxes from a CSV file

Summary Detailed Steps

e Create a number of users 1. Using Windows Explorer, navigate to the C:\Labs\ems\
and mailboxes, taking the folder.
input from a CSV file. 2. Double-click the file Usersl.csv to open it.

Notice the format of the Usersl.csv file.
Close the Usersl.csv file.

4. Create the four users and mailboxes detailed in the CSV by
typing the following text at the PS prompt and then
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pressing ENTER:

import-csv c:\labs\ems\usersl.csv | foreach {new-mailbox
-name $_.name -alias $_.alias -userprincipalname $_.UPN
-reset:$false -org Sales -database ""Mailbox Database''}

5. Each time you are prompted for a password, type
P@sswOrd and then press ENTER.

Note: Although this is an improvement on the single-line
method for creating multiple users, it is still necessary to
enter the password for each user as they are created. In the
next steps, you will create a function to provide the
password for you.

Create and run an Exchange Management Shell script

Summary Detailed Steps
e Review and run a script 1. Using Windows Explorer, navigate to the C:\Labs\ems\
that contains a function to folder.
set the password on user 2. Double-click the file Users2.csv to open it.
accounts as they are read ] )
and created from a CSV Notice the format of the Users2.csv file.
file. 3. Close the Users2.csv file.

In the same folder, double-click CreateMailboxes.psl

Review the format of this reusable script and then close
Notepad when finished.

6. Switch to the Exchange Management Shell, type
C:\labs\ems\CreateMailboxes.ps1 and then press
ENTER.

7. Switch to the Exchange Management Console, expand
Recipient Configuration, and then click Mailbox. Press
F5 to refresh the view. You will see the new mailboxes in
the Results Pane.
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Introduction

In this lab, you will use the SMBEXO01 virtual computer for Exercises 1 and 2 and you will use
SMBEXO01 and CLIENTO1 for Exercise 3.

Lab objectives
After completing this lab, you will be able to:

e Use the Microsoft® Exchange Management Shell to balance mailboxes across multiple
mailbox databases.

e Use the Exchange Server 2007 Toolbox, including the Best Practices Analyzer (ExBPA)
and the Performance Troubleshooter (ExXPA).

e Understand the AutoDiscover feature of Exchange Server 2007 with Microsoft Office
Outlook® 2007.

Prerequisites
This lab does not depend on any previous labs being completed.



Exercise 0: Preparing the Environment

Prepare the environment
Summary Detailed Steps

e Prepare the environment. 1. To complete this lab, use the SMBEXO01 and CLIENTO1 virtual
servers.



Exercise 1: Moving Mailboxes between Mailbox Databases Using the Exchange
Management Shell
Introduction

In this exercise, you will review an Exchange Management Shell script that load-balances mailboxes
equally between mailbox databases based upon the item count in each mailbox. You will use
Exchange Management Shell commands such as get-mailboxstatistics, get-mailbox, and
move-mailbox. You will also learn how to apply filters to the output of Exchange Management Shell
commands.

Scenario

After implementing Exchange Server 2007 at Northwind Traders, you created two mailbox databases
on different disks for the purposes of performance and disaster recovery. You will use an Exchange
Management Shell script that will move mailboxes between two mailbox databases to keep the
number of messages per database the same, and to ensure an equal load on each disk drive.

Log on to SMBEX01
Summary Detailed Steps
e Log onto SMBEXOL. 1. Onthe SMBEXO1 Virtual Server console, press the RIGHT-

ALT and DELETE keys.

2. Log on to the NWTRADERS domain as Administrator
with a password of P@sswOrd

Examine the distribution of mailboxes in the Northwind Traders organization

Summary Detailed Steps
e Open the Exchange 1. On SMBEXO01, click Start, click All Programs, click
Management Console and Microsoft Exchange Server 2007, and then click
examine the distribution Exchange Management Console.
of mailboxes across 2. In the Exchange Management Console, in the navigation
databases. tree, expand Recipient Configuration, and then click
Mailbox.

3. Inthe Action Pane, click View, and then click Add/Remove
Columns.

4. Inthe Available columns list, select Database, click Add,
click Move Up four times, and then click OK.

5. In the Result Pane, view the configuration of mailboxes.
You can see the location of a user’s Mailbox Database and
Storage Group in the Database column.

6. Describe the distribution of mailboxes across mailbox
databases. (You might need to slide the horizontal scroll bar
to see the mailbox databases.)

7. Leave the Exchange Management Console running.

Answer Key

6. All mailboxes except two are in the database named Mailbox Database.



View the item count of mailboxes in the source database
Detailed Steps

Summary
e Usethe
ShowsStatsCurrent.psl

script to view the item
count of the current
database

1.

10.

Open Microsoft Windows® Explorer and navigate to the
C:\Labs\managing\ folder.

Right-click the ShowStatsCurrent.psl script, click Open
With and then click Notepad.

Review the ShowStatsCurrent.psl script.

Note that the get-mailboxstatistics command is being used
to display the mailboxes and their item count.

Next note how the results are filtered. The System and
attendant mailboxes are filtered from the results using the
$_.displayname variable.

Close Notepad.

Click Start, point to All Programs, point to Microsoft
Exchange Server 2007, and then click Exchange
Management Shell.

At the PS prompt, type
C:\Labs\managing\ShowStatsCurrent.psl and then press
ENTER.

Notice how the contents of Mailbox Database are displayed
along with the individual mailbox item count.

At the PS prompt, type
C:\Labs\managing\ShowStatsDestination.ps1 and then
press ENTER.

There is no output from this script, meaning that Mailbox
Database 4 is currently empty.

Review an Exchange Management Shell script used to distribute mailboxes equally between

databases
Summary

e Openthe
BalanceMailboxes.psl
script and modify it to
distribute mailboxes
evenly between
databases.

1.

3.
4.
5

6.

Detailed Steps

Open Microsoft Windows® Explorer and navigate to the
C:\Labs\managing\ folder.

Right-click the BalanceMailboxes.ps1 script, click Open
With, and then click Notepad.

Review the BalanceMailboxes.ps1 script.

In Notepad, click Edit, and then click Go To.

In the Line Number box, type 13 and then click OK.
On line 14, locate the variable $mbx.

Notice how this command uses the get-mailboxstatistics
command to filter and sort a list of mailboxes based on their item
count, similar to Step 4 in the previous section, and places the



results into the variable $mbx.

7.

Go to line 18 and locate the command foreach. In this
function, the results obtained on line 14 are parsed to
determine the total number of mailboxes. This value is used
to determine how to evenly divide the mailboxes in the
following steps.

Go to line 24 and locate the variable $itemcount. This line
takes the total number of mailboxes and divides the value in
half.

Go to line 29 and locate the command foreach. In this
section, approximately half the mailboxes are moved to the
previously specified destination database.

10. Close Notepad.

Run the script to distribute the mailboxes evenly

Summary

Open the Exchange
Management Shell (PS)
and run the script to
distribute mailboxes.

Detailed Steps

1.
2.

10.

Switch to the Exchange Management Shell.

At the PS prompt, type
C:\Labs\managing\BalanceMailboxes.ps1 and then press
ENTER.

The script will prompt for the name of the server to move
the mailboxes to. For this exercise, type SMBEX01, and
then press ENTER.

The script will now prompt for the name of the source
database. Type Mailbox Database and press ENTER.

The script will now prompt for the name of the destination
database that mailboxes will be moved to. Type Mailbox
Database 4 and press ENTER.

Wait for the script to run, and then view the output of the
script. The script will take about 10 minutes to run.

At the PS prompt, type
C:\Labs\managing\ShowStatsCurrent.psl and press
ENTER

View the output of the script.

Notice how there are fewer mailboxes in the current
database.

At the PS prompt, type
C:\Labs\managing\ShowStatsDestination.psl and press
ENTER.

Notice how Second Database now contains the mailboxes
moved from the original database.



Verify that the script has distributed the mailboxes evenly

Summary Detailed Steps

e Examine the distribution 1. Switch to the Exchange Management Console and press F5
of mailboxes across the to refresh the display.
databases. 2. In the Result Pane, view the configuration of mailboxes.

3. Describe the distribution of mailboxes across mailbox
databases.

Answer Key

3. The mailboxes are evenly distributed across databases based upon their individual item
counts.



Exercise 2: Using the Exchange Server 2007 Admin Tools (ExBPA and ExPA)

Introduction

In this exercise, you will run tools from the Exchange Server 2007 Toolbox by starting them from the

Exchange Management Console.

Scenario

After implementing Exchange Server 2007 at Northwind Traders, you want to examine the
troubleshooting tools provided with Exchange Server 2007.

Perform a server health check by using the Exchange Best Practices Analyzer Tool
Detailed Steps

Summary

e Run the Exchange Best
Practices Analyzer
(ExBPA) tool and
perform a health check.

1.

10.
11.
12.
13.

14.
15.

In the Exchange Management Console, in the navigation
tree, click Toolbox.

In the Toolbox, click Best Practices Analyzer.

In the Action Pane under Best Practices Analyzer, click
Open tool and wait for tool to start.

On the welcome screen, click Select Options for a new
scan.

Click Connect to the Active Directory server.

In Start a New Best Practices scan, in the text box, type
SMBEXO0L1 first scan

Confirm that the type of scan to be performed is Health
Check, and then click Start scanning.

Wait for the scan to complete. This will take approximately
4 minutes.

. After the scan is complete, click View a report of this Best

Practices scan.

In Select Report Types, click List Reports.

In the Arrange by drop-down list, select Severity.
Click the first Database backup critical warning.

Click Tell me more about this issue and how to resolve it.
Briefly read the Help topic that pops up.

Close the Help topic dialog box.
Close ExBPA.

Resolve a problem using the Exchange Server 2007 Performance Troubleshooter
Detailed Steps

Summary

e  Stop the Information
Store service and then run
the Performance
Troubleshooter to analyze
the server.

1.

On SMBEXO01, stop the Information Store service. To do
this, click Start, click Administrative Tools, and then click
Services.

In Services, scroll down, right-click Microsoft Exchange
Information Store, and then click Stop.



10.

11.

12.
13.
14.

15.

Minimize the Services window.

Switch to the Exchange Management Console, and then in
the navigation tree, click Toolbox.

In the Toolbox, scroll down, select Performance
Troubleshooter, and then in the Action Pane, click Open
Tool.

Wait for the Performance Troubleshooter to start. (This
may take a few minutes.)

After the tool starts, click Go to Welcome screen.

In the Enter an identifying label for this analysis text box,
type SMBEXO01 Analysis 1

Confirm that the What symptoms are you seeing drop-
down list is set to Multiple users are complaining of
delays while using Outlook, or are seeing the Outlook
cancellable RPC dialog frequently, and then click Next.

In both the Server Name and Global Catalog Server text
boxes, type SMBEXO01 and then click Next.

Wait until the Troubleshooting Assistant completes its
analysis.

In Connectivity Test Results, notice that the Store service
is not running.

Switch to Services, start the Information Store, and then
close Services.

Switch to the Troubleshooting Assistant.
Go back to the previous screen by clicking Previous.
Run the test again by clicking Next.

Wait for the results and confirm that the issue is now
resolved and that the Connectivity test was passed.

Close the Troubleshooting Assistant.



Exercise 3: Configuring Exchange Server 2007 AutoDiscover Using Outlook
2007

Introduction

In this exercise, you will observe the AutoDiscover feature in Microsoft Office Outlook® 2007
automatically discover the e-mail settings for Peter Houston, and automatically configure his profile to
connect to the Exchange Server 2007 server.

Scenario

You are the Exchange administrator for Northwind Traders. The company recently implemented
Outlook 2007 throughout the organization. You are asked to reduce the administrative cost associated
with configuring Outlook profiles for users. To do this, you demonstrate the AutoDiscover feature of
Exchange Server 2007 and Outlook 2007 that allows users to automatically configure their own
profiles.

For security reasons, you should run AutoDiscover over a Secure Sockets Layer (SSL) channel.
However, for the purposes of this lab, you will not require certificate checking and the SSL channel
for AutoDiscover.

Create a profile using the AutoDiscover feature of Outlook 2007 and Exchange Server 2007
Summary Detailed Steps

e Test AutoDiscover by 1. Switch to the CLIENTO1 virtual server.
automaucally_ creating an 2. Log on to the nwtraders domain as peter with a password
Outlook Profile for Peter of P@ssword.
Houston.

3. Click Start, and then click E-mail Microsoft Office
Outlook.

On the Outlook welcome screen, click Next.

Verify that Yes is selected on the E-mail Accounts screen,
and then click Next.

Notice how Outlook automatically discovers Peter’s account
information.

6. On the Auto Account Setup page, click Next.
7. On the Configuring page, click Finish.

8. On the User Name dialog box, in the Name field, type Peter
Houston, in the Initials field type PH and then click OK.

9. On the Privacy Options page, click OK.

Note: Outlook 2007 will now log on to Peter’s mailbox and
create a local cached copy of the mailbox.

10. On the Microsoft Office Outlook dialog box, click OK to
acknowledge that Windows Desktop Search is not installed.

11. When finished, close Outlook and log off of ClientO1.
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Time estimated: 60 minutes
Introduction

In this lab, you will use the SMBEXO01 and CLIENTO1 virtual computers to gain hands-on experience
with compliance and retention features.

Lab objectives
After completing this lab, you will be able to:

Create a new Messaging Records Management folder.

Create Messaging Records Management content settings by using the Microsoft® Exchange
Management Console.

Create a Messaging Records Management mailbox policy and link it to the Managed Custom
folder.

Assign a Messaging Records Management mailbox policy to a user’s InboX.

Enforce compliance by creating an ethical wall using Hub Transport Rules.

Create a message classification.

Create a Hub Transport Rule to act upon the message classification.

Import message classifications into Microsoft Office Outlook® 2007.

Work with message classifications in both Microsoft Outlook Web Access and Outlook 2007.



Prerequisites
This lab does not depend on any previous labs being completed.



Exercise 0: Preparing the Environment

Prepare the environment
Summary Detailed Steps

e Prepare the environment. 1. To complete this lab, use the SMBEX01 and CLIENTO01
virtual servers.



Exercise 1: Configuring Messaging Records Management Policies

Introduction

In this exercise, you will create a Managed Custom folder to appear in your users’ Inboxes. You will
create Messaging Records Management content settings for the Managed Custom folder to ensure that
e-mail messages in the folder expire after two years. You will then use the Exchange Management
Console to create and link a Messaging Records Management mailbox policy to the folder and assign
it to a user. Finally, you will configure all items in the users’ Inboxes to expire after seven days.

Scenario

For the purpose of compliance, Northwind Traders is required to keep all e-mail related to the Contoso
project on file for two years. However, all items in users’ Inboxes expire after 7 days. Therefore, you
configure a new Managed Custom folder with a different expiration period than that for the Inbox, and
request that the users place all Contoso-related e-mail in the new folder.

Log on to SMBEX01
Summary Detailed Steps
e Logonto SMBEXO1. 1. Onthe SMBEXO01 Virtual Server console, if not already

logged in, press the RIGHT-ALT and DELETE keys.

2. Log ontothe NWTRADERS domain as Administrator
with a password of P@sswOrd

Create a Managed Custom folder

Summary Detailed Steps
e In the Exchange 1. On SMBEXO01, click Start, point to All Programs, point to
Management Console, Microsoft Exchange Server 2007, and then click
create a managed custom Exchange Management Console.
folder named Contoso 2. In the Exchange Management Console, in the navigation
Project. tree, expand Organization Configuration, and then click
Mailbox.

In the Action Pane, click New Managed Custom Folder.

On the New Managed Custom Folder page, type Contoso
Project as the Name.

5. Inthe Display the following comment when the folder is
viewed in Outlook text box, type All items related to the
Contoso Project should be posted here and retained for 2
years.

6. Select the Do not allow users to minimize this comment
in Outlook check box and then click New.

7. On the Completion page, review the completion report and
then click Finish.



Create Messaging Records Management content settings for the new Managed Custom folder
Detailed Steps

Summary

Using the Exchange
Management Console,
create Messaging Records
Management content
settings to preserve all
items in the Contoso
Project for two years.

1.

In the Exchange Management Console, in the Work Pane,
click the Contoso Project Managed Custom folder.

In the Action Pane under Contoso Project, click New
Managed Content Settings.

On the Introduction page, in the Name of the managed
content settings to be displayed in the Exchange
Management Console text box, type Preserve for 2 years.

In the Message type drop-down list, select All Mailbox
Content.

Select the Length of retention period (days) check box
and then type 731 in the text box.

In the Retention period starts drop-down list, select When
the item is moved to the folder.

In the Action to take at the end of the retention period
drop-down list, select Permanently Delete and then click
Next.

On the Journaling page, click Next.

On the New Managed Content Settings page, review the
summary, and then click New.

10. On the Completion page, click Finish.

Create a Managed Folder Mailbox Policy and link it to a mailbox
Detailed Steps

Summary

Use the Exchange
Management Console to
create a new mailbox
policy and link it to Peter
Houston’s mailbox.

1.

In the Exchange Management Console, in the Action Pane,
click New Managed Folder Mailbox Policy.

In New Managed Folder Mailbox Policy, in the Managed
folder mailbox policy name text box, type NWTraders
Mailbox Policy and then click Add.

On the Select Managed Folder page, select Contoso Project
and then click OK.

Click New and then click Finish.

In the navigation tree, click Recipient Configuration. In
the Result Pane, click Peter Houston, and then in the
Action Pane under Peter Houston, click Properties.

In Peter Houston Properties, click the Mailbox Settings
tab, click Messaging Records Management, and then click
Properties.

Select the Managed folder mailbox policy check box, and
then click Browse.

In Select Managed Folder Mailbox Policy, select
NWTraders Mailbox Policy and then click OK three



times.

At the Microsoft Exchange prompt regarding older versions
of Outlook, click Yes to return to the Exchange
Management Console.

Create a Managed Folder Schedule on the SMBEX01 server

Summary

Use the Exchange
Management Shell, to
create a Messaging
Records Management
schedule and then restart
the Exchange Mailbox
Assistants.

Detailed Steps

1.

On SMBEXO01, click Start, point to All Programs, point to
Microsoft Exchange Server 2007, and then click
Exchange Management Shell.

At the PS prompt, type set-mailboxserver -id SMBEX01
-ManagedFolderAssistantSchedule
"*Sun.12:00-Sun.11:00"" and then press ENTER.

Notice that there is no output displayed from this
command.

At the PS prompt, type net stop
msexchangemailboxassistants and then press ENTER.

At the PS prompt, type net start
msexchangemailboxassistants and then press ENTER.

Use the Managed Custom folder from Outlook Web Access
Detailed Steps

Summary

In Outlook Web Access
running as Peter Houston,
drag all e-mail related to
Contoso into the new
Contoso Project Managed
Custom folder.

1.

Click Start, point to All Programs, and then click Internet
Explorer.

In Internet Explorer, in the Address bar, type
http://[SMBEXO01.nwtraders.com/OWA and then press
ENTER.

Log on to Outlook Web Access as peter with a password of
P@sswOrd.

In the Mail folders list, expand Managed Folders.
Notice that the Contoso Project managed folder is present.
Click the Contoso Project managed folder.

Notice how the description is displayed at the top of the
Item view.

In the Mail folders list, select Inbox.

In the Search Inbox field, type Contoso, and then click the
drop-down arrow and select All Folders and Items. Press
ENTER.

Click the first item, scroll to the last message, press and hold
down the SHIFT key, and then click the last message to
select all items that have been displayed.

Drag all of the selected items into the Contoso Project



managed folder. Notice the age of some of the older
messages.

10. In the Search Inbox field, where you typed Contoso, click
the X to clear the search.

Write down the number of e-mail items remaining in the
Inbox. You can find this information in the lower-middle
area of the page.

11. In the Mail folders list in the left pane, select Contoso
Project.

Write down the number of e-mail items in the Contoso
Project Managed Custom folder.

12. Close Outlook Web Access.

Configure a retention period on the Inbox

Summary

Create Messaging
Records Management
content settings to delete
all items in the Inbox after
one year.

Detailed Steps

1. Switch to the Exchange Management Console.

Expand Organization Configuration, and then click
Mailbox.

3. Inthe Result Pane, select the Managed Default Folders tab
and then click Inbox.

4. Inthe Action Pane under Inbox, click New Managed
Content Settings.

5. On the Introduction page, in the Name of the managed
content settings to be displayed in the Exchange
Management Console text box, type Delete after one year

6. Inthe Message type drop-down list, select All Mailbox
Content.

7. Select the Messages expire after (days) check box, and
then type 365 in the text box.

8. Inthe Retention period starts drop-down list, verify that
When delivered, end date for calendar and recurring
tasks is selected.

9. Inthe Action to take at the end of the retention period
drop-down list, verify that Move to the Deleted Items
folder is selected, and then click Next.

10. On the Journaling page, click Next.

11. On the New Managed Content Settings page, review the
summary, and then click New.

12. On the Completion page, click Finish.

13. In the Result Pane, select the Managed Folder Mailbox
Policies tab.

14. Click NWTraders Mailbox Policy, and then in the Action
Pane, under NWTraders Mailbox Policy, click Properties.



15. On the NWTraders Mailbox Policy Properties page, click

Add.

16. On the Select Managed Folder page,, click Inbox, and then

click OK twice.

Apply the updated NWTraders Mailbox policy to a user mailbox
Detailed Steps

Summary

e  Apply the updated
Managed folder to Peter
Houston’s Inbox.

1.
2.

Switch to the Exchange Management shell.

At the PS prompt, type net stop
msexchangemailboxassistants and then press ENTER.

At the PS prompt, type net start
msexchangemailboxassistants and then press ENTER.

Test the Inbox Messaging Records Management content settings
Detailed Steps

Summary

e In Outlook Web Access
running as Peter Houston,
ensure that all e-mail
items older than one year
have been removed from
the Inbox but remain in
the Contoso Project
managed custom folder.

Answer Key

1.

Click Start, point to All Programs, and then click Internet
Explorer.

In Internet Explorer, in the Address bar, type
http://SMBEXO01.nwtraders.com/OWA and then press
ENTER.

Log on to Outlook Web Access as peter with a password of
P@sswOrd

Click Inbox.

How many e-mail items are in the Inbox, and how does this
number compare to the number you wrote down
previously?

Expand Managed Folders and then click Contoso Project.

How many e-mail items are in the Inbox, and how does this
number compare to the number you wrote down
previously?

Close Outlook Web Access.

4. There are fewer items because the older items have been removed by the Managed

Folder Mailbox policy.

5. The number is unchanged; even the messages older then 1 year are present.



Exercise 2: Enforcing Compliance by Creating an Ethical Wall
Introduction

In this exercise, you will create rules to enforce compliance. You will do this by creating an ethical
wall between two groups of users that prohibits them from e-mailing each other except in certain
circumstances.

Scenario

Yan Li and Frank Miller work in separate departments at Northwind Traders. Yan is with the Market
Analysts group and Frank is with the Brokers and Dealers group. To comply with regulations
affecting Northwind Traders, these two groups must not be able to e-mail each other. You decide to
configure a global rule that prohibits these two groups of users from sending e-mail to each other.
However, you want to make an exception so that the executives of both departments are still able to
mail each other.

Verify normal mail flow between Yan Li and Frank Miller

Summary Detailed Steps

e  Verify that messages can 1. On SMBEXO01, click Start, point to All Programs, and then
be sent and received click Internet Explorer.
between Yan Li and 2. In Internet Explorer, in the Address bar, type
Frank Miller by using http://SMBEXO01.nwtraders.com/OWA and then press
Outlook Web Access. ENTER.

3. Log on to Outlook Web Access as Yan with a password of
P@sswOrd

At the first screen in Outlook Web Access, click OK.
From Yan’s Inbox, click New.

In the new e-mail message, in the To box, type Frank and
then press CTRL+K to resolve the name.

7. Inthe Subject line, type Information about the latest
prices

8. Inthe message body, type | have interesting info about
stock prices.

9. Click Send.
Leave Outlook Web Access running.

10. Click Start, point to All Programs, and then click Internet
Explorer.

11. In the Address bar, type
http://[SMBEXO01.nwtraders.com/OWA and then press
ENTER.

12. Log on to Outlook Web Access as Frank with a password
of P@sswOrd

13. At the first screen in Outlook Web Access, click OK.

Notice that the new message has arrived and is visible in
the preview pane.

14. In the Inbox, select the new message, and then click Reply.
15. In the message body, type | also have insider info, want to
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Create a Hub Transport Rule
Summary

Using the Exchange
Management Console,
create a new Hub
Transport Rule to prohibit
the Market Analysts and
Brokers and Dealers
groups from sending e-
mail to each other. Add an
exception to the rule
allowing e-mail from
either group to be sent to
Peter Houston or Ursula
Fliegl.

16.

17.

trade? and then click Send.

Switch to Outlook Web Access running as Yan Li, and click
Check Messages.

Confirm that the message arrived successfully.

Detailed Steps

1.

10.

11.

12.

13.

14.
15.

16.

17.

Switch to the Exchange Management Console. If it is not
already running, click Start, point to All Programs, point to
Microsoft Exchange Server 2007, and then click
Exchange Management Console.

In the Exchange Management Console, in the Navigation
Pane, expand Organization Configuration, and then click
Hub Transport.

In the Result Pane, click the Transport Rules tab.
In the Action Pane, click New Transport Rule.

In the New Transport Rule Wizard, in the Name box, type
Ethical Wall - Market Analysts and Traders

In the Comment box, type the comment Ethical wall
configured to restrict mail between Market Analysts and
Traders and ensure that Enable Rule is selected. Click
Next.

In the Step 1: Select condition(s) dialog box, select
between members of distribution list and distribution
list.

In the Step 2: Edit the rule description dialog box, click
the first distribution list link.

In the Select recipient distribution list dialog box, click
Add.

In the Select Mail Enabled Group dialog box, click
Brokers and Dealers, and then click OK twice.

In the Step 2: Edit the rule description dialog box, click
the second distribution list link.

In the Select recipient distribution list dialog box, click
Add.

In the Mail Enabled Group dialog box, click Market
Analysts and then click OK twice.

On the New Transport Rule Wizard page, click Next.

In the Step 1: Select action(s) dialog box, select send
bounce message to sender with enhanced status code.

In the Step 2: Edit the rule description dialog box, click
the Delivery not authorized, message refused link.

In the Specify bounce message dialog box, type Due to
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compliance restrictions you are prohibited from
contacting this person and then click OK.

18. On the New Transport Rule Wizard page, click Next.

19. In the Step 1: Select exceptions if necessary dialog box,
select except when the message is sent to people.

20. In the Step 2: Edit the rule description dialog box, click
the people link.

21. In the Select Recipients dialog box, click Add.

22. In the Select Recipient User or Contact dialog box, select
Peter Houston and Ursula Fliegl and then click OK twice.

23. On the New Transport Rule page, click Next, review the
rule description, and then click New.

24. Review the completion summary and then click Finish.

25. In the Result Pane, on the Transport Rules tab, verify that
the rule is enabled.

26. Leave the Exchange Management Console running.

Test the Hub Transport Rule

Summary Detailed Steps
o Verify that messages 1. Switch to Outlook Web Access running as Yan Li.
cannot be sent between 2. In Outlook Web Access, click New.

Yan Li and Frank Miller. ] ]
3. Inthe new e-mail message, in the To box, type Frank and

then press CTRL+K to resolve the name.
In the Subject line, type Advice on the Stock Market

In the message body, type Please can you give me some
advice on the Stock Market?

Click Send.
Switch to Outlook Web Access running as Frank Miller.
Click Check Messages.
Notice that the message has not arrived.
9. Switch to Outlook Web Access running as Yan Li.
10. Click Check Messages.

11. View the Undeliverable message. Scroll down and note that
the message states that “Due to compliance restrictions you
are prohibited from contacting this person” per the transport
rule definition.

12. Switch to Outlook Web Access running as Frank Miller.
13. In Outlook Web Access, click New.

14. In the new e-mail message, in the To box, type Yan and
then press CTRL+K to resolve the name.
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15.
16.
17.
18.
19.

20.

21.

22.

23.

24,
25.

26.
217.

In the Subject line, type Let’s make some big money!
In the message body, type I’ve got some great insider info.
Click Send.
Switch to Outlook Web Access running as Yan Li.
Click Check Messages.
Notice that the message was not delivered.
In Outlook Web Access, click New.

In the new e-mail message, in the To box, type Frank and
then press CTRL+K to resolve the name. Also in the To
box, type Peter and press CTRL+K to resolve the name.

In the Subject line, type Emergency: Flood on the 2nd
floor!

In the message body, type Please cover all equipment with
plastic.

Click Send.
Click Check Messages.

Notice that the postmaster message states that your
message could not be delivered to Frank. However, it was
delivered to Peter.

Note: If time permits, log on to Outlook Web Access as
Peter to confirm that the message was delivered.

Close Outlook Web Access running as Frank Miller.
Close Outlook Web Access running as Yan Li.
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Exercise 3: Working with Message Classifications in Outlook Web Access and
Outlook 2007

Introduction

In this exercise, you will use the built-in message classifications in Outlook Web Access to classify
messages based on policy requirements. You will also build a custom message classification and
create transport rules to act upon message classifications.

In the second half of this exercise, you will import message classifications into the Outlook 2007
client and learn how to use message classifications with Outlook 2007.

Scenario

Spencer Low and the steering committee of Northwind Traders have decided that certain information
relating to Project X must not leave the organization. Spencer has been asked to implement a policy
within Exchange Server 2007 that enables staff working on Project X to create mail items that cannot
be forwarded or accidentally sent out of the organization. Spencer decides to use the new Hub
Transport Rules and Message Classifications to achieve these requirements.

View Default Message Classifications

Summary Detailed Steps
e View the existing 1. Onthe SMBEXO1 virtual server, switch to the Exchange
Message Classifications. Management Shell. If it is not already running, click Start,

point to All Programs, point to Microsoft Exchange
Server 2007, and then click Exchange Management Shell.

Wait for the Exchange Management Shell environment to
load.

2. In the Exchange Management Shell, type
Get-MessageClassification and then press ENTER.

Note: You can use the TAB key as a shortcut for typing
this command; for example, if you type Get-MessageC and
then press TAB, the full command will be completed
automatically.

3. To view detailed information about recipient and sender
descriptions, in the Exchange Management Shell, type Get-
MessageClassification | ft DisplayName,
SenderDescription, RecipientConfiguration, -wrap and
then press ENTER.

Notice that detailed descriptions of the existing Message
Classifications and what functions they perform are

displayed.
Create a new Message Classification
Summary Detailed Steps
e Create a new Message 1. In the Exchange Management Shell, type
Classification that meets New-MessageClassification -Name *"*Project X
your requirements and Confidential" -DisplayName "'Project X Confidential"'
that accurately describes -SenderDescription "*This message is classified as

Confidential Project X information. This information
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its purpose.

should not be sent externally** -RecipientDescription
"This message you have received is classified as
Confidential Project X information. This information
should not be sent externally**

To confirm that the new Message Classification has been
created, type Get-MessageClassification | ft DisplayName,
SenderDescription, RecipientConfiguration, -wrap

Note You should see your new Message Classification at
the end of the list.

Create a Hub Transport Rule for the new Message Classification

Summary

Create a Hub Transport
Rule that will bounce any
messages marked with the
Project X Confidential
classification when an
attempt is made to send
the message to an external
address.

Detailed Steps

1.

10.

11.

12.

On SMBEXO01, switch to the Exchange Management
Console.

In the Exchange Management Console, expand
Organization Configuration, and then click Hub
Transport.

In the Action Pane, click New Transport Rule.

In the New Transport Rule Wizard, in the Name field, type
Prevent Project X Confidential from being sent
externally.

In the Comment field, type This rule will prevent
messages that have been marked with the Project X
Confidential Message Classification from being sent to
external recipients

Ensure that the Enable Rule check box is selected and then
click Next.

In the Conditions dialog box, in Step 1, select Sent to
users inside or outside the corporation, and then in Step
2, click Inside.

In the Select Scope dialog box, click the drop-down list,
select Outside, and then click OK.

In the Conditions dialog box, in Step 1, scroll down and
select Marked With Classification, and then in Step 2,
click Classification.

In Select Message Classification, click Project X
Confidential, click OK, and then click Next.

In Actions, in Step 1, scroll down and select send bounce
message to sender with enhanced status code, and then in
Step 2, click Delivery not Authorized Message Refused.

In Specify Bounce Message, type This message is marked
as Project X Confidential. Delivery is not allowed to
external addresses and delivery has been refused. Click
OK and then click Next.



13.
14.

15.
16.

Test the new Hub Transport Rule

Summary

Send a message addressed
to both an internal and an
external user and confirm
that the Transport Rule
works as expected.

15

On the Exceptions page, click Next.

On the Create Rule page, review the summary, and then
click New.

Review the completion summary, and then click Finish.

Wait for the new Transport Rule to appear in the Result
Pane of the Exchange Management Console.

Detailed Steps

1.

10.

11.

On SMBEXO01, click Start, click All Programs, and then
click Internet Explorer.

In the Address bar, type
http://[SMBEXO01.nwtraders.com/OWA and then press
ENTER.

Log on to Outlook Web Access as Spencer with a password
of P@sswOrd

Click New to create a new message.

In the To field, type Peter and then press CTRL+K to
resolve the name. Also in the To field, type Spencer and
then press CTRL+K to resolve the name. Also in the To
field, type Claus.Hansen@contoso.com

Note: The message should now have three recipients: Peter,
Spencer, and Claus Hansen.

Click the Message Classification N button and select
Project X Confidential.

Notice that the Sender Description appears below the
toolbar.

In the Subject field, type Project Milestones, and then in
the Text field, type All project X milestones are on track.
Regards, Spencer.

Click Send.

Wait for a few seconds and then click the Check Messages
button in Outlook Web Access.

Open the message addressed to Spencer and notice that the
Recipient Description is inserted below the Subject line.

Open the Undeliverable message and scroll down to the
Diagnostic Information for Administrators. Notice the
Bounce Message text you defined in the Transport Rule.

Export the Message Classification definitions to an XML file

Summary

Export the Message

Detailed Steps

1.

On SMBEXO01, switch to the Exchange Management Shell.
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Classifications to an XML
file for later importation
into Outlook 2007.

10.
11.

12.

13.
14.
15.

16.
17.

18.
19.
20.

21.
22.

If it is not already running, click Start, point to All
Programs, point to Microsoft Exchange Server 2007, and
then click Exchange Management Shell.

Wait for the Exchange Management Shell environment to
load.

At the Exchange Management Shell (EMS) prompt, type cd
""¢c:\Program Files\Microsoft\Exchange Server\Scripts"
and then press ENTER.

At the EMS prompt, type Get-MessageClassification |
JExport-OutlookClassification.PS1 >
c:\labs\classifications.xml and then press ENTER.

Notice that there is no output displayed from this
command.

Switch to CLIENTO1 and log on as nwtraders\peter with a
password of P@sswOrd

After you have logged on, click Start, click Run, and then
in the Run box, type \\smbex01\c$ and press ENTER.

In Connect to SMBEXO01.nwtraders.com, enter the
credentials nwtraders\administrator with a password of
P@sswOrd and then click OK.

In windows explorer, navigate to and open the labs folder.
Right-click the classifications.xml file, and then click copy.

In labs, click Folders, navigate to My Computer, Local
Disk (C:), click labs, and then in the right pane, right-click
and then select Paste.

Close Windows Explorer.

On CLIENTO1, click Start, click Run, type Regedit and
then press ENTER.

Navigate to
[HKEY_CURRENT_USER\Software\Microsoft\Office\l
2.0\Common\]

Right-click Common, click New, and then click Key.
Type Policy as the name of this new key.

Right-click Policy, point to New, and then click String
Value.

In the String Value name, type AdminClassificationPath

Double-click AdminClassificationPath, type
C:\labs\Classifications.xml and then click OK.

Right-click Policy, point to New, and then click DWORD.
In the DWORD name, type EnableClassifications

Double-click EnableClassifications, type 1 and then click
OK.

Close the Registry Editor.
If Outlook 2007 is running, restart Outlook and click Yes or



23.

24.

25.

26.

27.
28.

29.

30.

17

OK to any prompts that may appear.

In the Outlook 2007 Inbox, click New to create a new
message.

In the To field, type Peter and press CTRL+K to resolve the
name. Also in the To field, type Spencer and press
CTRL+K to resolve the name. Also in the To field, type
Claus.Hansen@contoso.com

Note: Your message should now have three recipients:
Peter, Spencer, and Claus Hansen.

Click the down arrow next to the Permission button =T
and then select Project X Confidential.

Notice that the sender description appears below the
toolbar.

In the Subject field, type Project Milestones and then in
the Text field, type All project X milestones are on track.
Regards, Peter.

Click Send.

Wait for a few seconds and then click the Send/Receive
button.

Open the message addressed to Peter Houston and notice
that the Recipient Description is inserted below the Subject
line.

Open the Undeliverable message and scroll down to
Diagnostic Information for Administrators. Notice the
Bounce Message text you defined in the Transport Rule.
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Introduction

In this lab, you will explore several of the new Microsoft® Office Outlook® Web Access Calendar,
Search, and Address Book features. You will also gain hands-on experience using a mobile device
with Microsoft Exchange Server 2007.

Lab objectives

After completing this lab, you will be able to:
e Use the new Calendar, Search, and Address Book features of Outlook Web Access.
e Configure mobile e-mail for a Microsoft Windows Mobile®—powered device.
e Use a Windows Mobile 4 device with Exchange Server 2007.

Prerequisites
This lab does not depend on any previous labs being completed.



Exercise 0: Preparing the Environment

Prepare the environment
Summary Detailed Steps

e Prepare the environment. e  To prepare for this lab, start the SMBEXOL1 virtual server.



Exercise 1: Using New Outlook Web Access Calendar Features
Introduction
In this exercise, you will use the new Outlook Web Access calendar features to:

e Create and move appointments.

e Use advanced calendar functionality to determine the best time to schedule a meeting with
multiple attendees and resources.

e Configure the Out of Office Assistant from Outlook Web Access.

Scenario

Northwind Traders requires many of its employees to check their e-mail and calendar information
over the Internet from computers on client sites. As the company’s Exchange administrator, you
implement Outlook Web Access to address this need.

Spencer Low, the company’s vice president, wants to schedule a meeting with the rest of the
management team. She uses the “suggested times” feature of Outlook Web Access to determine the
optimal time for the meeting. She also configures the Out of Office Assistant in Outlook Web Access
to send messages notifying senders when she is away from the office.

Log on to SMBEX01
Summary Detailed Steps
e Logonto SMBEXO01. 1. Onthe Virtual Server Administration Website, start the

SMBEXO0L1 virtual server.

2. Logontothe NWTRADERS domain as Administrator
with a password of P@sswOrd

Move appointments in Outlook Web Access

Summary Detailed Steps

e Create an appointment in 1. Onthe SMBEXO1 virtual server, click Start, click All
Outlook Web Access and Programs, and then click Internet Explorer.
move it around in the 2. In Internet Explorer, in the Address bar, type
Work Week view to view http://SMBEXO01.nwtraders.com/OWA and then press

the transparency feature. ENTER.
3. Log on to Outlook Web Access as spencer with a password
of P@sswOrd
In the left pane, click Calendar.

In the Calendar, click Work Week to switch to the Work
Week view.

6. In the numerical calendar on the left, click a date in the next
week.

7. Inthe Work Week view, double-click the intersection of
Tuesday and 9:00AM to create a new appointment.

In the Subject box, type Prepare analysis for Fabrikam
Click Save and Close.



10.

11.

In the Work Week view, click the Prepare Analysis for
Fabrikam meeting and drag it over Thursday 9:00 AM to
Friday 9:00 AM.

Notice that the appointment becomes partially transparent
as it is dragged.

Drop the appointment onto the Friday 9:00 entry.

Use advanced calendar features in Outlook Web Access
Detailed Steps

Summary

Create a calendar
appointment with multiple
attendees and resources,
and determine the most
and least optimal times
for this appointment.

1.

© N o v

10.

11.
12.

13.

14.

15.

16.

17.

In Outlook Web Access, click New to create a new
appointment.

In the Subject box, type Quarterly Review Meeting
Click the Scheduling Assistant tab.

In the Select Attendees list, click inside the box under
Spencer Low, type Peter and then press ENTER.

In the next line, type Ursula and then press ENTER.
In the next line, type Claire and then press ENTER.
In the next line, type Mike and then press ENTER.

Click the arrow to the left of Mike Ray once to change the
attendance of Mike Ray to Optional.

Notice how the availability of each attendee is displayed.
Click Select Rooms and then click More.

Notice that resources such as meeting rooms are listed,
along with details on their availability.

In the All Rooms list, select Meeting Room Superior and
then click the Rooms = button in the lower-left corner.

Click OK in the lower-right corner.

In the Select Rooms list, select the Meeting Room
Superior check box.

On the right side of the page, in the Duration drop-down
list, select 4 hours.

In the Suggested Times box, note how Good, Fair, and Poor
times are displayed on the calendar according to the color
legend at the bottom of the page.

On the calendar, click Friday of next week.

Notice that suggestions are made regarding optimal
meeting times.

On the calendar, click next Friday of next week.
Notice the suggested meeting times.

Click the 1 PM suggestion.
Notice that the meeting is scheduled for 1:00 P.M.



18.

19.
20.

21.

22.

23.

Configure the Out of Office Assistant

Summary

Configure the Out of
Office Assistant from
Outlook Web Access.

Click the Appointment tab.

Notice that the resources are displayed separately from the
attendees.

Click Send.

Click Start, click All Programs, and then click Internet
Explorer.

In Internet Explorer, in the Address bar, type
http://SMBEXO01.nwtraders.com/OWA and then press
ENTER.

Log on to Outlook Web Access as Claire with a password
of P@sswOrd.

Notice that the meeting request has been sent to you, and that
you can Accept or Decline the request directly from the
preview pane.

In the preview pane of the meeting request, click Accept,
and then click Send the response now.

Detailed Steps

1.
2.
3.

10.

11.
12.

13.
14.

Switch to Outlook Web Access running as Spencer Low.
At the top of the page, click Options.

In the left pane, in the Options list, click Out of Office
Assistant.

On the Out of Office Assistant page, click Send Out of
Office auto-replies.

Select the Send Out of Office auto-replies only during
this time period check box.

In the Start time list, select today with a start time of 6:00
AM.

In the End time list, select Friday of this week with an end
time of 8:00 PM.

In the message body, type | will be out of the office until
next Monday

(Optional) Format the message with the colors and fonts of
your choice.

Clear the Send Out of Office auto-replies to External
Senders check box.

Click Save, and then in the left pane, click Mail.

Switch to Outlook Web Access running as Claire
O’Donnell.

From Claire’s Inbox, click New.
In the new e-mail message, in the To box, type Spencer and



15.
16.

17.
18.

19.
20.
21.

22.

23.
24.

then press CTRL+K to resolve the name.
In the Subject line, type Naming standards document

In the message body, type Please could you give me an
estimate as to when you could deliver this document?

In the new message, click Send.
Click Check Messages.

Notice that you have received the customized Out of Office
message.

Switch to Outlook Web Access running as Spencer Low.
At the top of the page, click Options.

In the left pane, in the Options list, click Out Of Office
Assistant.

On the Out of Office Assistant page, select the Do not send
Out of Office auto-replies check box.

Click Save.
In the left pane, click Mail.



Exercise 2: Using New Outlook Web Access Search and Address Book
Features

Introduction
In this exercise, you will use the new Outlook Web Access Search features to:

e Search a mailbox folder for all items containing a search word.
e Search all folders in a mailbox folder for all items containing a search word

e  Use the new Outlook Web Access View by Conversation feature.

You will also use the new Outlook Web Address Book features to:

o Use the Exchange Management Console to set Organization attributes of users to appear in the
Outlook Web Access Address Book. More information about the new Exchange Management
Console is presented in the next Module.

e Browse the Global Address List (GAL).

e Look up a contact in the Address Book and view the new Organization properties of users in the
Address Book.

Scenario

Spencer Low, the company’s vice president, wants to increase efficiencies in the workplace by
providing accurate, easy-to-use information on staff management within the Address Book. Spencer
also wants to investigate the new Search features of Outlook Web Access.

Search a mailbox folder for all items containing a search term

Summary Detailed Steps
e  Use the improved search 1. Onthe SMBEXO1 virtual server, switch to Outlook Web
features of Outlook Web Access running as Spencer Low.
Access to search for all 2. In the Search Inbox field, type Contoso and then press
mail items in Spencer
. - ENTER.
Low’s mailbox containing . )
the word “Contoso.” How many mail items are displayed?
e Arrange the results of the 3. Click the drop-down arrow next to the Search Inbox field,

search by Conversation. and then select All Folders and Items.
How many mail items are now displayed?

4. Click the drop-down arrow next to the Arrange By field,
and then select Conversation.

Notice how all “related” messages are arranged together,
making it much easier to follow a conversation thread.

5. Click the red X next to the search box to clear the search
and return to the Inbox.

Answer Key



Use the Exchange Management Console to configure a user’s organization attributes

Summary

Use the Exchange
Management Console to
configure Peter Houston
as the manager of staff
members Ursula Fliegl
and Holly Holt.

Detailed Steps

1.

On the SMBEXO1 virtual server, click Start, click All
Programs, click Microsoft Exchange Server 2007, and
then click Exchange Management Console.

In the Exchange Management Console, click Recipient
Configuration.

In the Result Pane, select Ursula Fliegl, and then in the
Action Pane, under Ursula Fliegl, click Properties.

In the Ursula Fliegl Properties dialog box, click the
Organization tab, and then select the Manager check box.

Click Browse.

In the Select Recipient User or Contact window, click Peter
Houston, and then click OK.

In the Department field, type Sales and then click OK to
return to the Exchange Management Console.

Repeat steps 3-7 for Zheng Mu using the same settings.
Close the Exchange Management Console.

Use the Address Book features to determine a recipient’s manager and group members

Summary

Use the new Address
Book features of Outlook
Web Access to determine
Ursula Fliegl’s manager
and group members.

Detailed Steps

1.

N

On the SMBEXO01 virtual server, switch to Outlook Web
Access running as Spencer Low.

Click New to create a new mail item.
In the Untitled Message dialog box, click To.

In the Address Book dialog box, notice how the Default
Global Address List is displayed.

In the Global Address List, scroll down and select Peter
Houston.

Notice how Peter’s availability is displayed in the right
pane. In the Availability box, click the down arrow and
select any Wednesday. Notice that Peter is not available on
Wednesdays.

In the Peter Houston box, click Organization to expand
his details.

Who are Peter’s Direct Reports?
Under Direct Reports, click Zheng Mu.

Notice how Zheng Mu’s information now appears, showing
his Department and Manager, as well as his availability.

Close all windows.



Answer Key

6. Ursula Fliegl and Zheng Mu



Exercise 3: Using Mobile Devices with Exchange Server 2007

Introduction

In this exercise, you will use a Microsoft Windows Mobile 5.0 device to synchronize e-mail data with
Exchange Server 2007. You will also remotely wipe your own Windows Mobile 5.0 device from
Outlook Web Access.

Scenario

Spencer Low, the vice president of Northwind Traders, wants to use her new Windows Mobile 5.0
device to read and send e-mail while out of the office. You configure her Windows Mobile device to
synchronize directly with the Exchange server by using Exchange Direct Push Technology. When
Spencer loses her device in a restaurant, you instruct her to connect to Outlook Web Access and wipe
the device remotely for security purposes.

Configure Microsoft Exchange ActiveSync® on a Windows Mobile device to synchronize with
Exchange

Summary Detailed Steps

e  Start the Pocket PC 1. On SMBEXO01, click Start, click All Programs, click
Emulator on the Microsoft Device Emulator Preview, and then click Device
SMBEXO1 virtual server. Emulator Manager.

e Configure ActiveSync to 2. In the Device Emulator Manager, click File, click Restore
connect to the Exchange Image, navigate to the folder C:\Program
server. Files\Microsoft\Device Emulator Preview, select the

, pocketpc.dess file, and then click Open.
e Open Spencer Low’s

mailbox on the Pocket PC 3. At the Device Emulator prompt asking you to enable the
device. network card, click Yes.

4. On the Pocket PC Emulator, click the Start icon E click
Programs, and then click ActiveSync.

5. Read the ActiveSync screen information and then click the set
up your device to sync with it link.

In the Server Address box, type SMBEXO01.nwtraders.com

Clear the This server requires an encrypted (SSL)
connection check box.

8. In the Security warning message, click OK, and then click
Next.

Note: Secure Sockets Layer (SSL) encryption should always
be used with ActiveSync. However, for the purposes of this
lab, you will not be using an SSL connection.

9. In the User name text box, type Spencer

10. In the Password text box, type P@sswOrd

11. In the Domain text box, type Nwtraders

12. Select the Save password check box, and then click Next.

13. In the Choose the data you wish to synchronize box, click
Calendar, and then click Settings.

14. In the Synchronize only the past drop-down list box, select



Test Direct Push Technology
Summary

Send an e-mail message
from Peter Houston to
Spencer Low by using
Outlook Web Access.

View your messages on
the Pocket PC Emulator.

View the reply to Peter in
Outlook Web Access.

Accept a meeting request
by using the Pocket PC
Emulator.

Synchronize tasks by
using the Pocket PC
Emulator.

15.

16.

17.

18.

19.

20.

21.
22.
23.

All, and then in the upper-right corner, click OK.

In the Choose the data you wish to synchronize box, click E-
Mail, and then click Settings.

In the Include the previous drop-down list box, select All, and
then in the upper-right corner, click OK.

Confirm that the four check boxes are selected, and then click
Finish.

Wait for ActiveSync to synchronize with the Exchange server.
Watch as Contacts, Calendar, Email, and Tasks are
synchronized from the Exchange server to the device. The
synchronization may take several minutes in this emulator
environment.

After synchronization is complete, click the Start icon E
and then click Today to return to the Today screen.

On the Pocket PC Emulator, click Start, and then click
Messaging.

Click a message to open and then read the message.
Click OK to close the message.
Click the X in the upper-right corner to close Outlook E-Mail.

Detailed Steps

1.

On the SMBEXO01 virtual server, click Start, click All
Programs, and then click Internet Explorer.

In Internet Explorer, in the Address bar, type
http://SMBEXO01.nwtraders.com/OWA and then press
ENTER.

Log on to Outlook Web Access as peter with a password of
P@sswOrd

Click New, and then in the To field, type Spencer and then
press CTRL+K to resolve the name.

In the Subject line, type IMPORTANT: New information
regarding prospective factory in Seoul

In the message body, type Contoso Inc. is willing to invest in
our new Seoul factory

Click the Importance: High button and then click Send.
Switch to the Pocket PC Emulator.

Notice the animated Synchronization arrows indicating that
the device is automatically synchronizing, triggered by the
arrival of a message in Spencer’s mailbox.

Wait for the Pocket PC device to complete synchronization.



10.

11.

12.

13.
14.

15.
16.

17.

18.

19.

20.

21.

22.
23.

24,

25.

26.
27.

28.

29.

30.

At the bottom of the Today screen, view the notification stating
that a new message has arrived. Click View and open the new
message from Peter.

You want to add Peter to your contacts. Click Peter Houston
in the mail item, and then in the Messaging dialog box, click
Yes to add Peter to your contacts.

Click OK to close the Contacts window and return to the e-
mail message.

Click Reply at the bottom of the message window.

In the message body, type Excellent — please start the legal
paperwork and then click Send.

Note the animated Synchronization arrows again indicating
that the device is automatically synchronizing to send the
message.

Switch to Outlook Web Access running as Peter Houston.

Click Check Messages or press F5 to refresh the screen, and
then confirm that the message from Spencer was received.

Click Calendar, and then click New.

Click the Invite Attendees j button, and then in the
Required field, type Spencer

Change the start time of the appointment to be 1 hour from
now.

In the Subject field, type Management Meeting and then in
the Location field, type Peter’s Office

In the message body, type Meeting to discuss opening factory
in Seoul

Click Send.

Switch to the Pocket PC Emulator and wait for the device to
synchronize.

If it is not already open, open the device’s Inbox. After the
Inbox is in sync, click the meeting request at the top of the
message list.

Click Accept at the bottom of the Messaging window, verify
that Send the response now is selected, and then click OK.

Click OK in the upper-right corner to close the message.

Click the X in the upper-right corner to close the Inbox. The
meeting should now appear on the Today screen.

Wait for synchronization to complete, and then switch to
Peter’s Outlook Web Access.

Click Mail in the left pane, click Check for New Messages,
and then verify that the meeting request was accepted.

Log off from Outlook Web Access running as Peter, and then
close Microsoft Internet Explorer.



31. Switch to the Pocket PC Emulator.

32. Click Start, click Programs, and then click Tasks.

33. At the bottom of the Tasks screen, click New.

34. In the task Subject line, type Request auditor’s report
35. In the Priority drop-down list box, select High.

36. In the Starts: drop-down list box, select today’s date.

37. Click OK in the upper-right corner and notice that the task is
being synchronized. Wait for synchronization to complete.

38. Click the X in the upper-right corner to close Tasks, and then
click it again to close Programs.

Notice that a new Active Task shows on the Today screen that
is High priority.

Remotely wipe a mobile device from Outlook Web Access

Summary Detailed Steps
e Log on to Outlook Web 1. Onthe SMBEXO01 virtual server, click Start, click All
Access as Spencer Low Programs, and then click Internet Explorer.
and remotely wipe the 2. In Internet Explorer, in the Address bar, type
mobile device. http://SMBEXO01.nwtraders.com/OWA and then press
ENTER.
3. Log on to Outlook Web Access as spencer with a password
of P@sswOrd

At the top of the page, click Options.
In the left pane, in the Options list, click Mobile Devices.

Select the device in the device list, and then click Wipe All
Data from Device.

7. Click OK to confirm that you want to wipe all data from
your device.

8. Switch to the Device Emulator.

9. Click the Start icon m , click ActiveSync, and then click
Sync.

10. Click OK to accept the policy notification.
The device will now be wiped.

11. Close the Device Emulator without saving state, and then
close the Device Emulator Manager.

12. Close Outlook Web Access.






Lab: Using Exchange Server 2007 Local Continuous Replication

Lab: Using Exchange Server 2007 Local
Continuous Replication

¢« Exercise 1: Configuring Local Continuous
Replication

N%

Time estimated: 45 minutes
Introduction

In this lab, you will use the SMBEXO01 virtual server to configure Local Continuous Replication
(LCR).

Lab objectives
After completing this lab, you will be able to:

e Enable LCR on a Microsoft® Exchange Storage Group.
e Recover from a disk failure by using the copy taken by LCR.

Prerequisites
This lab does not depend on any previous labs being completed.



Exercise 0: Preparing the Environment

Prepare the environment
Summary Detailed Steps

e  Prepare the environment. 1. To prepare for this lab, use the SMBEXO1 virtual server.



Exercise 1: Configuring Local Continuous Replication

Introduction

In this exercise, you will configure and test Local Continuous Replication to quickly recover from
database corruption.

Scenario

Northwind Traders recently implemented Microsoft Exchange Server 2007. As the company’s
Exchange administrator, you have been tasked with ensuring that recovery time is minimized in the
event of disk failure. You implement LCR to ensure that a copy of the mailbox database exists on a
separate disk at all times.

Log on to SMBEX01
Summary Detailed Steps
e Log onto SMBEXOL. 1. Onthe SMBEXO1 Virtual Server console, press the RIGHT-

ALT and DELETE keys.

2. Log on to the NWTRADERS domain as Administrator
with a password of P@sswOrd

Enable LCR on the Third Storage Group

Summary Detailed Steps

e Using the Enable Storage 1. On SMBEXO01, click Start, click All Programs, click
Group Local Continuous Microsoft Exchange Server 2007, and then click
Backup Wizard, enable Exchange Management Console.
LCR for the Third Storage 2. In the Exchange Management Console, expand Server

Group. Configuration, and then click Mailbox.

3. Inthe Work Pane, click Third Storage Group, and then in
the Action Pane, click Enable local continuous
replication.

4. On the Introduction page, click Next.

5. On the Set Paths page, in the Local continuous replication
system files locations dialog box, click Browse, select
C:\Disk2, and then click OK.

6. Inthe Local continuous replication log files locations
dialog box, click Browse, select C:\Disk2\logs, and then
click OK.

7. Click Next to continue.

8. On the Mailbox Database 3 page, in the Local continuous
replication Exchange database file path box, click
Browse, select C:\Disk2\db, click Open, and then click
Save.

9. Click Next to continue.

10. Review the information on the Enable page and verify that
the correct paths have been configured.



Verify the results of LCR
Summary

Verify that LCR is
functioning by sending
a large e-mail message
and observing the log
file activity.

11. Click Enable to enable Local Continuous Replication for

the storage group. Wait for the process to complete and then
click Finish.

12. In the Work Pane, click Third Storage Group, scroll to the

right, and notice that the Copy Status is showing as
Healthy.

Detailed Steps

1.

10.
11.

12.

13.

14.

15.

16.

17.

18.

Open Microsoft Windows® Explorer and navigate to
C:\Disk2\logs.

Examine the contents of the C:\Disk2\logs folder and
compare the contents with the contents of C:\Disk1\logs.

Make a note of the highest log file number on disk1; for
example, E0200000039.LOG.

Click Start, click All Programs, and then click Internet
Explorer.

In Internet Explorer, in the Address bar, type
http://[SMBEXO01.nwtraders.com/OWA and then press
ENTER.

Log on to Outlook Web Access as spencer with a password
of P@sswOrd.

Click New.

In the new e-mail message, in the To box, type Holly and
then press CTRL+K to resolve the name.

In the Subject box, type Acquisition Analysis
In the message body, type Please review this document.

In the New Message dialog box, click Attach file, click
Browse, and then select C:\labs\lcr\Analysis.doc.

In the Attach Files dialog box, click Attach.

In the New Message dialog box, click Send.

Switch to Windows Explorer and navigate to C:\Disk1\logs.
a. What is the highest log file number now?

b. Has the log file sequence been incremented?

Navigate to C:\Disk2\logs.
Has the newest log file been copied to this path?

Click Start, click All Programs, and then click Internet
Explorer.

In Internet Explorer, in the Address bar, type
http://[SMBEXO01.nwtraders.com/OWA and then press
ENTER.

Log on to Outlook Web Access as holly with a password of



P@sswOrd
19. At the first screen in Outlook Web Access, click OK.
20. Ensure that the e-mail message from Spencer is displayed.
21. Leave Outlook Web Access running.

Answer Key

14. a. Log number varies. b. Yes.
15. Yes.

Simulate database corruption

Summary Detailed Steps
e Dismount Mailbox 1. Switch to the Exchange Management Console.
Database 1 and delete the 2. Verify that the Copy Status of the Third Storage Group is

database file to simulate

; Healthy. You may need to refresh the screen.
database corruption.

3. Right-click Mailbox Database 3 and then click Dismount
Database.

At the Microsoft Exchange prompt, click Yes.

Switch to Windows Explorer and navigate to C:\Disk1\db.
Delete the Mailbox Database 3.edb file.

Switch to the Exchange Management Console.

Right-click Mailbox Database 3 and then click Mount
Database.

© N o O o~

9. Read the Microsoft Exchange error message, and then click
No.

Note: This is now a corrupted store.

Recover from the corruption

Summary Detailed Steps

e Swap Disk 2 (containing 1. Inthe Exchange Management Console, in the Work Pane,
the Local Continuous click Third Storage Group.
Replication copy) for 2. Inthe Action Pane, click Disable Local Continuous

Disk 1 (containing the
corrupted files to recover
from the failure).

Replication.

At the Microsoft Exchange prompt, click Yes.

At the Microsoft Exchange Warning prompt, click OK.
Switch to Windows Explorer and navigate to C:\Disk1\logs.
Copy the C:\Disk1\logs\E02.log file to C:\Disk2\logs.

Click Start, click Administrative Tools, and then click
Computer Management.

N o o bk~ ow

8. Inthe Navigation Pane, click Disk Management.



10.

11.
12.

13.

14.
15.

16.

17.

18.

19.

20.

21.
22.

23.

24,

25.

26.

217.

Answer Key

In the Result Pane, right-click Disk 1, and then click
Change Drive Letter and Paths.

In the Change Drive Letter and Paths for New Volume
dialog box, click Remove.

In the Confirm dialog box, click Yes.

In the right pane, right-click Disk 2, and then click Change
Drive Letter and Paths.

In the Change Drive Letter and Paths for New Volume
dialog box, click Remove.

In the Confirm dialog box, click Yes.

In the Result Pane, right-click Disk 2, and then click
Change Drive Letter and Paths.

In the Change Drive Letter and Paths for Disk2 dialog
box, click Add.

In the Add Drive Letter or Path dialog box, select the
Mount in the following empty NTFS folder option, and
then type C:\Diskl

In the Add Drive Letter or Path dialog box, click OK.
Switch to Windows Explorer and navigate to C:\Disk1\db.
Confirm that the Mailbox Database 3.edb file is present.
Switch to the Exchange Management Console.

Right-click Mailbox Database 3, and then click Mount
Database.

Notice that the database has been mounted successfully.

Switch to Outlook Web Access running as Holly Holt and
press F5 to refresh the screen.

Confirm that the mail item you sent earlier as Spencer Low
is present and that service has been resumed.

Click Start, click Administrative Tools, and then click
Event Viewer.

In the Application log, find the first event with the ID of
301.

What does this event represent?
Close Event Viewer.

26. The log file is being replayed into the database.



Lab: Using Exchange Server 2007 Cluster Continuous Replication

Lab: Using Exchange Server 2007 Cluster
Continuous Replication

¢« Exercise 1: Configuring Windows Server
2003 Cluster Services

e Exercise 2: Installing and Configuring
~  Active and Passive Exchange Server 2007

7 Nodes
Ere\ ¢« Exercise 3: Moving Exchange Server 2007
| Pi) Resources Between Cluster Nodes

V>
NIREY

Time estimated: 90 minutes
Lab objectives
After completing this lab, you will be able to:

o Install Microsofte Windows Server™ 2003 cluster services to support Exchange Server 2007
Cluster Continuous Replication (CCR).

e Configure a Majority Node Set (MNS) quorum with file share witness.

o Install and configure the Exchange Server 2007 active and passive nodes in the cluster.

Introduction
In this lab, you will use the SMBEXO01, EXBEO1, and EXBEO2 virtual servers.



Exercise 0: Preparing the Environment
Prepare the environment

Summary Detailed Steps
e To prepare for this lab, 1. To prepare for this lab, start the EXBEO1, EXBEQ2, and
start the EXBEOQL, SMBEXO01 virtual servers.

EXBEO02, and SMBEX01
virtual servers.



Exercise 1: Configuring Windows Server 2003 Cluster Services

Introduction

In this exercise, you will configure Windows Server 2003 cluster services in preparation for the
installation of Exchange Server 2007.

Scenario

Northwind Traders recently implemented Exchange Server 2007. As the company’s Exchange
administrator, you have been tasked with ensuring that the Exchange environment is highly available.
However, the company has no shared disk resources, such as a Storage Area Network (SAN). You are
aware that Exchange Server 2007 can use CCR, which does not require shared storage. To prepare for
the Exchange Server 2007 installation and the use of CCR, you need to configure Windows

Server 2003 Cluster services.

Create the cluster service account
Summary Detailed Steps

e Create the cluster service

account. 1. On SMBEXO01, log on to the NWTRADERS domain as

Administrator with a password of P@sswOrd

2. Click Start, click Administrative Tools, and then click
Active Directory Users and Computers.

3. In Active Directory Users and Computers, expand
nwtraders.com, right-click the Users OU, click New, and
then click User.

4. On the New Object — User page, in the Last name field,
type ClusterSVC and then in the User logon name field,
type ClusterSVC and click Next.

5. In the Password and Confirm password fields, type
P@sswOrd

6. Clear the User must change password at next logon
check box, select the Password never expires check box,
click Next, and then click Finish.

7. Close Active Directory Users and Computers.

Configure the first and subsequent nodes of the cluster
Summary Detailed Steps

e Use the Server Cluster
Wizard to create a new
cluster and install the first

node in the cluster. 2. Click Start and then click Run.

¢ Install the second and
subsequent nodes in the
cluster. 4. At the command prompt, type cluster /cluster:EXCluster
e Verify that the cluster [create /wizard and then press ENTER.

service is running. 5. On the New Server Cluster Wizard page, click Next.

1. On EXBEO1, log on to the NWTRADERS domain as
Administrator with a password of P@sswO0rd

w

Type CMD and then click OK.



Enable networks for
cluster use.

10.

11.

12.

13.

14.

15.

16.
17.

18.
19.

20.
21.

22.

23.

On the Cluster Name and Domain page, click the Domain
drop-down list, click nwtraders.com, verify that the
Cluster name is EXCluster, and then click Next.

On the Select Computer page, verify that EXBEOL is
selected, and then click Next.

Note: Under Finding common resources on nodes and
Checking cluster feasibility, you will receive a warning
that a sharable quorum resource could not be located. This
is expected behavior.

Review the analysis results and then click Next.

On the IP Address page, in the IP Address field, type
10.0.0.70 and then click Next.

On the Cluster Service Account page, in the User name
field, type clustersvc and then in the Password field, type
P@sswOrd

Verify that the Domain is nwtraders.com and then click
Next.

On the Proposed Cluster Configuration page, click
Quorum.

Click the drop-down list, select Majority Node Set, and
then click OK.

On the Proposed Cluster Configuration page, verify that
the information is correct, and then click Next.

After the tasks have been completed, click Next, and then
click Finish.

Leave the command prompt window open.
Click Start, click Administrative Tools, and then click
Cluster Administrator.

The EXBEOL node in the results pane should be listed in
an Up state.
Switch to the command prompt.

At the command prompt, type cluster /cluster:EXCluster
/add /wizard and then press ENTER.

On the Welcome to Add Nodes Wizard page, click Next.

On the Cluster Name and Domain page, click the Domain
drop-down list and then click nwtraders.com.

Verify that the cluster name shown is EXCluster and then
click Next.

In the Computer name field, type EXBEO2 and click



24.
25.

26.

27.

28.

29.

30.
3L

32.

33.

34.

35.

36.

37.
38.

Add, and then click Next.
After the analysis is complete, click Next.

On the Cluster Service Account page, in the Password
field, type P@sswOrd and then click Next.

Review the cluster configuration information and then
click Next.

After the tasks have been completed, click Next, and then
click Finish.

Switch to the Cluster Administrator management console.
Click EXCLUSTER.

You should now see EXBEO2 added as a node to the
cluster with the State shown as Up.

In the navigation pane, expand Groups, and then click
Cluster Group.

The three current cluster resources should be listed as
Online.
Expand Cluster Configuration, and then click Networks.

In the details pane, right-click Private Connection, and
then click Properties.

Verify that Enable this network for cluster use is
selected, select Internal cluster communications only
(private network), and then click OK.

Right-click Public Connection, and then click Properties.

Verify that the Public Connection is configured for All
communications (mixed network), and then click OK.

In the console tree, right-click EXCLUSTER and then
click Properties.

On the Network Priority tab, in the Networks used for
internal cluster communication section, verify that
Private Connection is at the top. If it is not, click Private
Connection, click Move Up, and then click OK.

Close the Cluster Administrator management console.

Leave the command prompt window open.

Convert the MNS quorum to an MNS quorum with file share witness
Summary Detailed Steps

e Create a share and 1.
configure permissions on

Switch to SMBEXO01.



the share and the folder. 2. Click Start, and then click Run.

Configure MNS to use the 3. Type CMD and then click OK.
new share as a witness. _
4. At the command prompt, create a folder to use as the file

share witness by typing the following and then pressing
ENTER after each line.

CD\
mkdir MNS_FSQ DIR_EXCluster

5. Share the folder as MNS_FSQ_EXCluster by typing the
following and then pressing ENTER:

Confirm the settings.

net share
MNS_FSQ_EXCluster=C:\MNS_FSQ_DIR_EXCluster
IGRANT :nwtraders\clustersve,FULL

Note This is a single long command.

6. Set permissions for the share by typing the following
command and then pressing ENTER:

cacls MNS_FSQ_DIR_EXCluster /G
BUILTIN\Administrators:F ClusterSVC:F

Note This is a single long command.

7. When prompted Are you sure (Y/N)?, press Y and then
press ENTER.

8. Switch to EXBEO1.

At the command prompt, configure MNS to use the file
share by typing the following and then pressing ENTER:

Cluster res ""Majority Node Set" /priv
MNSFileShare=\SMBEX01\MNS_FSQ_EXCluster

Note This is a single long command.

10. When this command completes, a warning message
appears indicating that the resource must be restarted for
the change to take effect.

11. At the command prompt, type the following and then press
ENTER:

Cluster group ""Cluster Group"' /move
12. Repeat step 11.

13. Verify that the properties are configured correctly by
running the following command:

Cluster res ""Majority Node Set" /priv
14. Confirm that the results are set to the following values:

e MNSFileShare =
\SMBEX01\MNS_FSQ_EXCluster



o  MNSFileShareCheckinterval = 240 (0xf0)
o MNSFileShareDelay = 4 (0x4)
15. Leave the Command Prompt open.



Exercise 2: Installing and Configuring Active and Passive Exchange
Server 2007 Nodes

Introduction

In this exercise, you will install and configure Exchange Server 2007 on the active and passive nodes
of the cluster.

Scenario

Now that the cluster has been prepared, you must install Exchange Server 2007 on the active and
passive nodes of the cluster. You will add the domain user clustersvc to the Local Administrators
group on the server, and assign the ServerAdmin role to the ClusterSVC account. You will then bring
the clustered Exchange Server 2007 resources online.

Install the Mailbox Server role on the active and passive nodes

Summary

Install the Mailbox Server
role on the active cluster
node.

Delegate Server
Administrator
permissions to the cluster
service account.

Bring the Exchange
Server 2007 cluster
resources online.

Install the Mailbox Server
role on the passive cluster
node.

Detailed Steps

1.

On EXBEOQ1, at the command prompt, type D:\setup.com
/roles:M and then press ENTER.

Wait for the prerequisite checks, file copy, and installation
of the Mailbox Server Role to complete (approximately 15
minutes).

After the Mailbox Server Role has installed successfully,
switch to the Exchange Server directory by typing the
following and then pressing ENTER:

cd ""C:\Program Files\Microsoft\Exchange Server\bin"'

4.

Install the Cluster Role by typing the following and then
pressing ENTER:

exsetup.exe /mode:install /clustered /CMSname:EXCCRO01
/CMSIPAddress:10.0.0.80
/DomainController:SMBEXO01.nwtraders.com

Note This is a single long command.

More Info: After the clustered mailbox server has been installed, it
will be listed as failed. This is because the ClusterSVC account
does not have permission to bring the database online.

5.

On EXBEO1, click Start, point to Administrative Tools,
and then click Computer Management.

In Computer Management, expand Local Users and
Groups, and then click Groups.

Double-click the Administrators group.

In Administrator Properties, verify
nwtraders\ClusterSVC is listed, and then close Computer
Management.

Switch to EXBEOQ2 and perform steps 5-8 to verify that the
ClusterSVC account is a member of the local
Administrators group.

10. Switch to EXBEOL, click Start, click All Programs, click



11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

Microsoft Exchange Server 2007, and then click
Exchange Management Shell.

At the Exchange Management Shell (PS) prompt, type the
following and then press ENTER:

Add-ExchangeAdministrator -Role ServerAdmin
-Identity nwtraders\clustersvc -Scope EXCCRO01

Ignore the Warning, because you have already addressed
it in the preceding steps. You should see the output of the
command assigning the ClusterSVC account the
ServerAdmin role. Close the Exchange Management
Shell.

Click Start, click Administrative Tools, and then click
Services.

In the details pane, right-click Cluster Service and then
click Restart. After the service restarts, close the Services
management console.

Click Start, click Administrative Tools, and then click
Cluster Administrator.

In the Cluster Administrator console, in the navigation
pane, expand Groups, and then click EXCCRO01 and wait
for the resources to come online.

You should now see that all of the EXCCRO01 resources
are online and that EXBEO1 is listed as the owner.

Switch to EXBEO2 and, if you are not already logged on,
log on as Administrator with a password of P@sswOrd

On EXBEO2, click Start, click Administrative Tools, and
then click Services.

In the Services management console, right-click Cluster
Service and then click Restart. After the service has
restarted, close the Services management console.

On EXBEO2, open a command prompt, type the following,
and then press ENTER:

D:\setup.com /roles:M

Wait for the prerequisite checks, file copy, and installation
of the Mailbox Server Role to complete (approximately 15
minutes).



Exercise 3: Moving Exchange Server 2007 Resources Between Cluster Nodes
Introduction

In this exercise, you will test the cluster by moving resources from the active node to the passive node
and then sending e-mail in order to increment the log files.

Scenario

Moving resources between nodes might be required for events such as patching or applying Service
Packs. As the Exchange administrator for Northwind Traders, you must verify that Exchange

Server 2007 resources can be successfully moved and that databases are mounted and connectivity is
established after the Exchange Server 2007 resources have been brought online.

Test connectivity to the CCR-enabled Exchange Server 2007 server

Summary Detailed Steps
e Move a user’s mailbox to 1. Switch to SMBEXO01, click Start, click All Programs,
the CCR-enabled click Microsoft Exchange Server 2007, and then click
Exchange Server 2007 Exchange Management Console.
Mailbox server. 2. In the Exchange Management Console, in the navigation
e Use Performance Monitor tree, click Recipient Configuration, and then in the
and Microsoft Windows® Results Pane, click Holly Holt.
Explorer to view 3. In the Action Pane, click Move Mailbox.

incremented transaction . . .
log files and log file On the Introduction page, confirm that the Server is

replication. EXCCRO01, and then click Next.
On the Move Options page, click Next.

&

On the Move Schedule page, click Next.
On the Move Mailbox page, click Move.
On the Completion page, click Finish.

Switch to EXBEO1, click Start, click All Programs, click
Accessories, and then click Windows Explorer.

© ©® N o o

10. Navigate to C:\Program Files\Microsoft\Exchange
Server\mailbox\First Storage Group.

11. Make a note of the latest transaction log file; for example,
E0000000010.log.

12. Switch to EXBEQ2, click Start, click All Programs, click
Accessories, and then click Windows Explorer.

13. Navigate to C:\Program Files\Microsoft\Exchange
Server\ mailbox\First Storage Group.

14. Make a note of the latest transaction log file, for example,
E0000000010.log.

15. On EXBEO?2 click Start, click Run, and then in the Run
field, type perfmon and click OK.

16. Click X (the Delete key) three times to remove the existing
counters.

17. Click + (Add) to add counters.
18. Click the Performance object drop-down list and then



19.
20.
21.

22.
23.

24.

25.
26.
27.

28.
29.
30.
31.
32.
33.
34.
35.

36.

37.

38.

39.

40.

41.

42.
43.

click MSExchange Replication.
Click All counters, click Add, and then click Close.
Press CTRL+R to change to Report View.

Make a note of the value of the CopyGenerationNumber
and CopyNotificationGenerationNumber.

Switch to SMBEXO1.

On SMBEXO01, click Start and then click Internet
Explorer.

In the Address field, type
http://smbex01.nwtraders.com/owa and then click Go.

Log on as holly with a password of P@sswOrd
In Microsoft Outlook® Web Access, click New.

In the To field, type Holly and then press CTRL+K to
resolve her address.

In the Subject field, type Attachments

Click the paperclip icon to attach a file.

On the Attach Files page, click Browse.

Navigate to C:\ExchangeSetupL ogs.

Click ExchangeServer.msilog and then click Open.
Click Attach to attach the files to the e-mail message.
Click Send to send the message.

The attachments will generate enough data to cause the
Exchange Server transaction log files to increment.

Click Check Messages.

You might need to do this two or three more times because
of the file size. After the message has been received,
proceed to the next step.

Leave Outlook Web Access running.

Switch to EXBEO2 and then switch to Performance
Monitor.

Notice that the CopyGenerationNumber and the
CopyNotificationGenerationNumber value have been
incremented.

Switch to Windows Explorer and notice that the
transaction log files have incremented.

Switch to EXBEO1 and then switch to Windows Explorer.

Notice that the transaction log files have incremented by
the same amount.



Move Exchange Server 2007 resources using the Exchange Management Shell

Summary

Use the Exchange
Management Shell to
move Exchange
Server 2007 resources
between nodes.

Test connectivity by using
Outlook Web Access.

Generate e-mail traffic to
increment the transaction
log files and view the
transaction log file
replication status.

Detailed Steps

1.
2.

10.

11.
12.
13.

14.
15.
16.
17.

18.

19.

20.

21,

22,
23.

Switch to EXBEO2.

Click Start, click All Programs, click Administrative
Tools, and then click Cluster Administrator.

In the navigation pane, expand Groups, and then click
EXCCRO1.

Right-click EXCCRO0L1, and then click Move Group.

Wait for the resources to be moved from EXBEO1 to
EXBEO?2.

After all of the resources have been moved and are online,
switch to SMBEXO0L1.

On SMBEXO01, switch to Outlook Web Access running as
Holly Holt.

In Outlook Web Access, click Check Messages.
Notice how the command completes.

In Outlook Web Access, click the message that you just
sent, and then click Forward.

In the To field, type Holly and then click Send.
Click Check Messages.

You might need to do this two or three more times because
of the file size. After the message has been received,
proceed to the next step.

Switch to EXBEOQ1 and then switch to Windows Explorer.
Notice that the transaction log files have been incremented.
Switch to EXBEOQ2 and then open Windows Explorer.

Note that the transaction log files have also incremented
here, matching EXBEOL.

On EXBEOQ?2, click Start, click All Programs, click
Microsoft Exchange Server 2007, and then click
Exchange Management Shell.

At the PS prompt, type Get-StorageGroupCopyStatus |
FL and then press ENTER.

Note the LatestAvailableLogTime, which represents the
date and time of the last available replicated log. Also note
the LastL.ogCopied value.

Switch to Performance Monitor.
Check the CopyGenerationNumber.

This number will generally match, or differ slightly on a
busy server, from the LastLogCopied value you observed
in the Get-StorageGroupCopyStatus output.



Lab: Configuring an Exchange Server 2007 Edge Transport Server
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Time estimated: 60 minutes
Introduction

In this lab, you will use the SMBEXO01, EDGEO1, CLIENTO1, and IMAILO1 virtual computers to gain
hands-on experience configuring and using the features of the Microsoft® Exchange Server 2007
Edge Transport server role.

Lab objectives
After completing this lab, you will be able to:

o Create a new Edge Transport server subscription.

e Configure an Edge Transport server.

e Create Edge Transport rules to protect your environment.

¢ Configure a quarantine mailbox.

e Configure the Content Filter feature to filter spam messages.
e Quarantine e-mail messages rated as spam.

e  Use the Safe Senders function of Microsoft Office Outlook® 2007 to allow messages from
specific domains to be delivered regardless of their Spam Confidence Level (SCL) rating.



Exercise 0: Preparing the Environment

Prepare the environment
Summary Detailed Steps

e Prepare the environment. e To prepare for this lab, start the SMBEXO01, IMAILO1,
CLIENTO1, and EDGEO1lvirtual servers.



Exercise 1: Implementing an Edge Transport Server

Introduction

In this exercise, you will use the Exchange Management Console to create an Edge Transport server

subscription.

Scenario

You are the Exchange administrator at Northwind Traders. The company recently implemented
Exchange Server 2007, and you would like to take advantage of the security benefits provided by an
Exchange Server 2007 Edge Transport server. You have installed the Edge Transport server role on a
stand-alone server named EDGEOQ1 and now need to perform an Edge Subscription and configure the

Edge Transport server role.

Create an Edge Subscription

Summary

1. Addthe EDGEO1
server to the
nwtraders.com zone
in DNS.

2. Create a new Edge
Subscription.

3. Verify mail flow
through the new Edge
Transport server.

Detailed Steps

1.

10.

Log on to SMBEXO01 as nwtraders\administrator with a
password of P@sswOrd

On SMBEXO01, click Start, click Administrative Tools,
and then click DNS.

Note: Because the EDGEOL1 server is not a member of the
domain and therefore is not automatically registered in
Domain Name System (DNS), you need to register the
EDGEOL1 server in DNS. You also would need to change
your public mail exchange (MX) record to resolve to your
Edge Transport server.

In DNS, expand SMBEXO01, expand Forward Lookup
Zones, and then click nwtraders.com.

Right-click nwtraders.com and then click New Host (A).

In the New Host field, type EDGEOQ1 and then in the IP
Address field, type 10.0.0.50

Clear the Create associated pointer (PTR) record check
box and then click Add Host.

Click OK to the DNS prompt and then click Done.

Note: In the real world, you would also need to change
your public MX record to resolve to your Edge Transport
server. This change has been simulated for this lab.

Close DNS.

Switch to EDGEO1 and then click Start=> All Programs—>
Microsoft Exchange Server 2007-> Exchange
Management Shell.

At the Microsoft PowerShell (PS) prompt, type following
command and then press ENTER:

New-EdgeSubscription -file c:\\EdgeSubscriptionExport.xml

11.
12.

At the Confirm prompt, type A and then press ENTER.

Switch to SMBEXO01, click Start, click Run, type
\\edge01\c$ and then click OK.



13.

14.

15.

16.

17.

18.
19.

20.
21.

22.

23.

24.

25.

26.

217.

28.
29.

30.

In the \\edge01\C$ folder, right-click
EdgeSubscriptionExport.xml and then click Copy.

On SMBEXO01, open Microsoft Windows® Explorer and
navigate to C:\labs\Edge.

Right-click the Edge folder, click Paste, and then close both
Windows Explorer windows.

On SMBEXO01, click Start=> All Programs—> Microsoft
Exchange Server 2007 Exchange Management
Console.

In the navigation tree, expand Organization Configuration
and then click Hub Transport.

In the Action pane, click New Edge Subscription.

On the New Edge Subscription page, click Browse, browse
to the C:\labs\edge folder, click the
EdgeSubscriptionExport.xml file, click Open, and then
click New.

Note: On the completion page, notice the warning stating
that the Hub Transport servers need to be able to resolve
the IP Address of EDGEO1.nwtraders.com. This was done
by creating the A record for EDGEOL earlier.

On the Completion page, click Finish.

In the Exchange Management Console, notice how the new
Edge Subscription is displayed on the Edge Subscriptions
tab. Click the Send Connectors tab and notice how a Send
connector to the Edge Transport server has been created.

On SMBEXO01, click Start=> All Programs=> Microsoft
Exchange Server 2007-> Exchange Management Shell.

At the PS prompt, type Start-EdgeSynchronization and
then press ENTER.

After the command has completed, switch to the EDGEO1
server and then switch to the Exchange Management Shell.

At the PS prompt, type Get-AcceptedDomain to confirm
that the subscription was successful. You will see the
domain nwtraders.com in the result.

Switch to IMAILO1 and then click Start=> All Programs->
Outlook Express.

Outlook Express will now load as a user named Steve in the
Contoso.com domain.

In Outlook Express, click Create Mail, and then in the To
box of the new message, type spencer@nwtraders.com

In the Subject line, type Meeting next week

In the message body, type Hi Spencer, Is it OK if I bring
my new Sales Manager to the meeting next week?
Regards, Steve

Click Send.



31.

32.

33.

34.

35.

36.
3r7.

Switch to SMBEXO01 and then click Start> All
Programs-> Internet Explorer.

In Internet Explorer, in the Address bar, type
http://[SMBEXO01.nwtraders.com/OWA and then press
ENTER.

In the User Name field, type spencer and then in the
Password field, type P@sswO0rd and then click Log On.

In Outlook Web Access, open the new message from Steve
and then click Reply.

In the reply, type Hi Steve, Yes that is fine, please do
bring your new Sales Manager, Regards, Spence

Click Send.

Switch back to Outlook Express on IMAILO1 and click
Send/Receive to confirm that the reply from Spencer has
arrived in Steve’s mailbox.



Exercise 2: Protecting Your Edge Transport Server Using Transport Rules

Introduction

In this exercise, you will create and use an Edge Server Transport Rule to protect Northwind Traders
from a potential new virus.

Scenario

You are the Exchange administrator at Northwind Traders. You have received urgent news that a new
e-mail virus has been circulating on the Internet. Because the new virus is only a few hours old, your
virus-scanning provider has not yet provided you with a new virus signature file to protect against the
virus. You know that the virus always comes in an e-mail message with the words “I LOVE YOU” in
the subject line. You need to create a temporary Edge Server Transport Rule to stop the virus from
coming into the organization until you receive the new virus signature file.

Create an Edge Server Transport Rule

Summary Detailed Steps
e Use the Exchange 1. On EDGEQL1, start the Exchange Management Console.
Management Console to 2. In the Exchange Management Console, in the navigation

create an Edge Server
Transport Rule that is .
configured so that any e- 3. In the Work pane, click the Transport Rules tab.

mail messages sent to the Notice that currently there are no transport rules.
organization with the

words “I LOVE YOU” in

tree, click Edge Transport.

In the Action pane, click New Transport Rule.

the Subject line are to be 5. In the New Transport Rule window, in the Name field, type

put into quarantine and Temp Rule Blocking | LOVE YOU Virus and then in the

not delivered to the Comment field, type Temporary Rule to block the I

recipient. LOVE YOU virus until we can download a new virus
signature

6. Ensure that the Enable Rule check box is selected and then
click Next.

7. On the Conditions page, in Step 1, select when the Subject
field contains specific words, and then in Step 2, click
specific words.

8. In the Specify words field, type I LOVE YOU and then
click Add. Click OK.

9. On the Conditions page, click Next.

10. On the Actions page, in Step 1, select Put message in spam
quarantine mailbox and then click Next.

11. On the Exceptions page, click Next.
12. On the Create Rule page, click New.
13. On the Completion page, click Finish.

Configure a mailbox to store quarantined mail
Summary Detailed Steps

e Create a mailbox named 1. Switch to SMBEXO01 and then switch to the Exchange



Quarantine Mailbox and
configure the Edge
Transport server to
deliver all quarantined
mail to that mailbox.

10.

11.

12.

13.

14.
15.

Test the Edge Server Transport Rule
Detailed Steps

Summary

Send a message from
outside the organization
to Spencer Low with the
subject line “I LOVE
YOU” and then examine
the quarantine mailbox to

1.

Management Console.

In the Exchange Management Console, expand Recipient
Configuration, and then in the Action pane, click New
Mailbox.

On the Introduction page, confirm that User Mailbox is
selected and then click Next.

On the User Type page, confirm that New User is selected
and then click Next.

On the User Information page, in the First Name text box,
type Quarantine Mailbox and then in the User logon name
text box, type quarantine

In the Password and Confirm password text boxes, type
P@sswOrd and then click Next.

On the Mailbox Settings page, click Next.
On the New Mailbox page, click New.
On the Completion page, click Finish.

Switch to EDGEO1 and then switch to the Exchange
Management Shell.

In the Exchange Management Shell, type the following and
then press ENTER:

Get-contentfilterconfig

Notice that the value for QuarantineMailbox is empty,
meaning that no Quarantine Mailbox is configured.

In the Exchange Management Shell, configure the new
mailbox as the mailbox in which quarantined mail should be
stored by typing the following and then pressing ENTER:

Set-ContentFilterConfig -QuarantineMailbox
quarantine@nwtraders.com

Repeat the Get-ContentFilterConfig command and
observe that a mailbox is now configured.

Switch to SMBEXOL1.

At the PS prompt, type Start-EdgeSynchronization and
then press ENTER.

Wait for the command to complete.

Switch to IMAILO1 and then switch to Outlook Express
running as Steve in the Contoso.com domain.

In Outlook Express, click Create Mail, and then in the To
box in the new message, type spencer@nwtraders.com

In the Subject line, type | LOVE YOU



confirm that the message
was not delivered to
Spencer but was
quarantined.

Click Send.

On SMBEXO01, click Start=> All Programs—> Internet
Explorer.

In Internet Explorer, in the Address bar, type
http://[SMBEXO01.nwtraders.com/OWA and then press
ENTER.

In the User Name field, type quarantine and then in the
Password field, type P@sswO0rd and then click Log On.
Click OK.

On the first page in Outlook Web Access, click OK.

In Quarantine - Outlook Web Access, confirm that the |
LOVE YOU message has been quarantined.

Note: In the real world, you would have configured the
Edge Transport Rule to drop these mail items; however, for
the purposes of this lab, you configured it to quarantine the
e-mail. If you had configured the rule to drop the mail, the
mail would never have entered your internal environment
and would have been dropped at the Edge Transport server.



Exercise 3: Anti-Spam and Antivirus Protection in Exchange Server 2007
Introduction

In this exercise, you will examine the anti-spam and antivirus features available on the
Exchange Server 2007 Edge Transport server.

Scenario

You are the Exchange administrator at Northwind Traders. You have many users using both Outlook
Web Access and Office Outlook 2007. You want to work out the optimal settings for the Content
Filter feature on the Edge Transport server. You also want to determine a method for seeing how
much spam is entering the organization. To allow users to view mail that is designated as spam, you
have decided to quarantine messages that have been rated as spam rather than dropping the messages.

Configure the Content Filter feature and use Performance Monitor to identify the SCL ratings of
incoming e-mail

Summary Detailed Steps

e Configure the Content 1. Switch to EDGEO1 and then switch to the Exchange
Filter feature of the Edge Management Console.
Transport server. 2. In the Exchange Management Console, in the navigation

e Add performance tree, click Edge Transport.
counters to System 3. Inthe Result pane, click the Anti-Spam tab and read
Monitor to monitor the through the list of configurable options that are possible
Spam Confidence Level with the Edge Transport server anti-spam features.
(SCL) of items arriving in ) ) ]

In IP Block List Properties, click the Blocked Addresses
tab and notice that there are no blocked addresses by
default. Click Cancel to return to the Exchange
Management Console.

6. On the Anti-Spam tab, double-click Content Filtering.

In Content Filtering Properties, click the Action tab and
notice that the default setting of Reject messages that
have an SCL rating larger or equal to is set to 7. Click
Cancel to return to the Exchange Management Console.

8. On EDGEQ1, click Start, point to Administrative Tools,
and then click Performance.

9. On the System Monitor graph toolbar, click the X (Delete)
button three times to remove all current counters.

10. On the toolbar, click the + (Add) button.

11. Inthe Add Counters box, in the Performance Object list,
select MsExchange Content Filter Agents.

12. Click All counters, click Add, and then click Close.

13. In System Monitor, press CTRL+R to change the view to
Report view.

14. Switch to IMAILO1 and open Windows Explorer.

15. Navigate to C:\Labs\edge and then double-click the script
SendSpam.vbs.



16.
17.

18.

19.

20.

21.

22.

23.

24.

25.

26.
27.

28.
29.
30.

This script will send spam messages to Spencer Low.
In the Messages Sent dialog box, click OK.

Switch to SMBEXO01, and then switch to Outlook Web
Access running as Spencer Low.

In Outlook Web Access, click the Send/Receive button.

Note: You might need to wait a while for the messages to
be processed in this lab environment.

View the messages that are delivered to the Inbox folder.
Notice that unsolicited commercial e-mail has been
delivered to the Inbox.

On EDGEO01, switch to Performance Monitor and view the
SCL ratings assigned to the messages that were just sent by
looking at the values of the Messages with SCL 0-9
counters.

On EDGEOL, in the Exchange Management Console,
expand Edge Transport, and then in the Work pane, on the
Anti-Spam tab, double-click Content Filtering.

In the Content Filtering Properties dialog box, click the
Action tab.

In the Reject Messages that have a SCL rating larger or
equal to drop-down list, select 6 and then click OK to
return to the Exchange Management Console.

Switch to IMAILO1, and then switch to Windows Explorer.

In Windows Explorer, navigate to C:\Labs\edge and
double-click SendSpam.vbs.

In the Messages Sent dialog box, click OK.

Switch to SMBEXO01, and then switch to Outlook Web
Access running as Spencer.

In Outlook Web Access, click the Send/Receive button.
Confirm that only two items now arrive in Spencer’s Inbox.

Switch to EDGEOQ1, switch to Performance Monitor, and
then view the SCL ratings assigned to the messages that
were just sent by looking at the values of the Messages
with SCL 0-9 counters.

Configure the Edge Server to archive spam mail

Summary

Configure the Content
Filter to archive spam
mail.

Send spam to Peter to
confirm that the
appropriate spam mail

Detailed Steps

1.
2.

On EDGEO1, switch to the Exchange Management Console

In the Work pane, on the Anti-spam tab, double-click
Content Filtering.

In the Content Filtering Properties dialog box, click the
Action tab.



items are being archived.

10.

11.
12.
13.
14.

15.

16.

In the Reject messages that have a SCL rating larger or
equal to drop-down list, select 5.

Select the Quarantine messages that have a SCL rating
larger or equal to check box, and then in the drop-down
list, select 6.

Notice that the Quarantine Mailbox e-mail address is
automatically set to the quarantine mailbox you set in the
previous exercise.

Click OK to close Content Filtering Properties.
Switch to IMAILO1, and then switch to Windows Explorer.

In Windows Explorer, navigate to C:\Labs\edge and then
double-click SendSpam.vbs.

In the Messages Sent dialog box, click OK.

Switch to SMBEXO0L1, and then switch to Outlook Web
Access running as Spencer.

In Outlook Web Access, click the Send/Receive button.
Confirm that only two items arrive in Spencer’s Inbox.
On SMBEXO01, click Start=> All Programs—> Explorer.

In Internet Explorer, in the Address bar, type
http://SMBEXO01.nwtraders.com/OWA and then press
ENTER.

In the User Name field, type quarantine and then in the
Password field, type P@sswO0rd and then click Log On.

In Quarantine - Outlook Web Access, click
Send/Receive and confirm that the three messages have
been quarantined.



Exercise 4: Propagating an Outlook Safe Sender List Using an Edge Transport
Server
Introduction

This exercise demonstrates how a Safe Sender list created in Office Outlook 2007 is propagated to the
Edge Transport server. You will also verify that the Edge Transport server acts on that list.

Scenario

In his job role, Peter Houston regularly communicates with Contoso, Ltd. After Northwind Traders’
corporate policy changed the Spam Confidence Level (SCL) rating level to help control spam, Peter
noticed that a number of mail items from Contoso have not been arriving in his mailbox. He suspects
that this is because they are being blocked due to the message content having a high SCL. As the
Exchange administrator at Northwind Traders, you suggest to Peter that he should add the domain
contoso.com to his Safe Senders list in Office Outlook 2007

Propagate an Outlook Safe Senders list using an Edge Transport server

Summary

Log on to Office

Outlook 2007 as Peter and
add contoso.com to the
Safe Senders list.

Manually propagate the
Safe Senders list to the
Edge Transport server to
save time.

Send a message to both
Spencer and Peter that

contains content with a
very high SCL.

Observe that the mail item
does not arrive at
Spencer’s mailbox but
that it does arrive in
Peter’s.

Detailed Steps

1.

© N o o

10.

11.

12.

13.

14.

On CLIENTO1, click Start and then click Microsoft
Office Outlook.

On the Office Outlook 2007 Startup page, click Next.

On the E-mail Accounts page, verify that Yes is selected
and then click Next.

On the Auto Account Setup page, notice how Peter’s
information is automatically entered, and then click Next.

On the Configuring page, click Finish.
At the User Name prompt, click OK.
On the Privacy Options page, click OK.

At the Microsoft Office Outlook prompt, select the Do not
show this message again check box and then click OK.

In Outlook, click Tools, click Options, and then on the
Preferences tab, click Junk E-mail.

In Junk E-mail Options, click the Safe Senders tab and
then click Add.

In the Add address or domain field, type contoso.com
and then click OK twice to return to Outlook. Leave
Outlook running.

Switch to SMBEXO0L1 and then switch to the Exchange
Management Shell.

At the PS prompt, type the following and then press
ENTER:

Update-safelist -id Peter

At the PS prompt, type the following and then press
ENTER:



15.

17.
18.

19.

20.

21.

22.

23.

Start-EdgeSynchronization

Switch to IMAILO1 and then switch to Outlook Express
running as Steve in the Contoso.com domain.

16. In Outlook Express, click Create Mail, and then
in the To box in the new message, type the following:

spencer@nwtraders.com;
peter@nwtraders.com
In the Subject line, type Free Mortgage
In the message body, type the following:
http://www.contoso.com
Make $$$$$
Click Send.

Note: This message will be identified as having a high
SCL by the Edge Transport server and therefore will not
be delivered to Spencer.

Confirm that the message has not arrived. Switch to
SMBEXQ01, and then switch to Outlook Web Access
running as Spencer.

Click Send/Receive several times to ensure that the
message has not been delivered.

Switch to CLIENTO1 and then in Outlook, click
Send/Receive and notice that the message has been
received.

Note: The message has been delivered to Peter because
his Safe Senders list is now acted on by the Edge
Transport server.

Close Outlook.



Lab: Implementing Antivirus Defenses on Exchange Server 2007 with
Microsoft Forefront Security

Lab: Implementing Antivirus Defenses on Exchange Server
2007 with Microsoft Forefront Security

¢ Exercise 1:Implementing Edge Server

¢ Exercise 2: Installing and Using Microsoft
| Forefront Security on an Edge Transport
~ Server
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Time estimated: 40 minutes
Lab objectives

After completing this lab, you will be able to install and administer Microsoft® Forefront Security on
the Microsoft Exchange Server 2007 Edge Transport server role.

Introduction

In this lab, you will use the SMBEXO01, EDGEOQ1, and IMAILO1 virtual computers.



Exercise 0: Preparing the Environment

Prepare the environment
Summary Detailed Steps

e Prepare the environment. e To prepare for this lab, start the
SMBEXO01, IMAILO01, and
EDGEO1Lvirtual servers.



Exercise 1: Implementing an Edge Transport Server

Introduction

In this exercise, you will use the Exchange Management Console to create an Edge Transport server
subscription as a prerequisite to ForeFront for Exchange Server installation and configuration. If you
have already configured an Edge Transport Server as part of a previous lab, you may use that

configuration and advance to Exercise 2.

Create an Edge Subscription

Summary

1. Addthe EDGEO1
server to the
nwtraders.com zone
in DNS.

2. Create a new Edge
Subscription.

1.

10.

Detailed Steps

Log on to SMBEXO01 as nwtraders\administrator with a
password of P@sswOrd

On SMBEXO01, click Start, click Administrative Tools,
and then click DNS.

Note Because the EDGEO1 server is not a member of the
domain and therefore is not automatically registered in
Domain Name System (DNS), you need to register the
EDGEOL1 server in DNS. You would also need to change
your public mail exchange (MX) record to resolve to your
Edge Transport server.

In DNS, expand SMBEXO01, expand Forward Lookup
Zones, and then click nwtraders.com.

Right-click nwtraders.com, and then click New Host (A).

In the New Host field, type EDGEO1 and then in the IP
Address field, type 10.0.0.55

Clear the Create associated pointer (PTR) record check
box, and then click Add Host.

Click OK to close the dialog box, and then click Done.

Note In the real world, you would also need to change
your public MX record to resolve to your Edge Transport
server. This change has been simulated for this lab.

Close the DNS console.

Switch to EDGEOL. Click Start, point to All Programs,
point to Microsoft Exchange Server 2007, and then click
Exchange Management Shell.

At the Microsoft PowerShell (PS) prompt, type following
command and then press ENTER:

New-EdgeSubscription -file c:\EdgeSubscriptionExport.xml

11.
12.

13.

At the Confirm prompt, type A, and then press ENTER.

Switch to SMBEXO01, click Start, click Run, type
\\edge01\c$, and then click OK.

In the \\edge01\C$ folder, right-click



14.

15.

16.

17.

18.
19.

20.
21.

22,

23.

24.

25.

EdgeSubscriptionExport.xml, and then click Copy.

On SMBEXO01, open Microsoft Windows® Explorer and
navigate to C:\labs\Edge.

Right-click the Edge folder, click Paste, and then close both
Windows Explorer windows.

On SMBEXO01, click Start, point to All Programs, point to
Microsoft Exchange Server 2007, and then click
Exchange Management Console.

In the navigation tree, expand Organization
Configuration, and then click Hub Transport.

In the Action pane, click New Edge Subscription.

On the New Edge Subscription page, click Browse, browse
to the C:\labs\edge folder, click the
EdgeSubscriptionExport.xml file, click Open, and then
click New.

Note On the completion page, notice the warning stating
that the Hub Transport servers need to be able to resolve
the IP Address of EDGEOL.nwtraders.com. You took care
of this earlier when you created the A record for EDGEO1.

On the Completion page, click Finish.

In the Exchange Management Console, notice how the new
Edge Subscription is displayed on the Edge Subscriptions
tab. Click the Send Connectors tab and notice how a Send
connector to the Edge Transport server has been created.

On SMBEXO01, click Start, point to All Programs, point to
Microsoft Exchange Server 2007, and then click
Exchange Management Shell.

At the PS prompt, type Start-EdgeSynchronization, and
then press ENTER.

After the command has completed, switch to the EDGEO1
server and then switch to the Exchange Management Shell.

At the PS prompt, type Get-AcceptedDomain to confirm
that the subscription was successful. You will see the
domain nwtraders.com in the result.



Exercise 2: Installing and Using Microsoft Forefront Security on an Edge

Transport Server

Introduction

In this exercise, you will install Microsoft Forefront Security onto the EDGEOQ1 virtual server. You
will send messages through the Edge Transport server and observe how Microsoft Forefront Security
deals with and reports on these messages. You will then create and send a fake virus and observe how

the virus is cleaned.

Scenario

You are the Exchange administrator at Northwind Traders. The company recently implemented
Exchange Server 2007, and you would like to take advantage of the security benefits provided by
installing Microsoft Forefront Security onto your Exchange Server 2007 Edge Transport server. You
have already installed and configured the Edge Transport server role onto a stand-alone server named

EDGEOL.

Log on to SMBEX01, EDGE01, and IMAIL01

Summary

1. Log onto SMBEXO01 as Administrator.
2. Log onto EDGEOL1 as local Administrator.

3. Log onto IMAILO1 as local Administrator.

Install Forefront Security

Summary

o Install Forefront Security on EDGEOL1.

Detailed Steps

1.
2.

Switch to the SMBEXO01 virtual server.

Log on to the NWTRADERS domain as
Administrator with a password of
P@sswOrd.

Switch to EDGEOL1.

Log on locally as Administrator with a
password of P@sswOrd.

Switch to IMAILO1.

Log on locally as Administrator with a
password of P@sswOrd.

Detailed Steps

1.
2.

Switch to EDGEOL1.

Open Microsoft Windows Explorer and
navigate to the C:\labs\Forefront
Security folder.

Double-click the Forefront_Setup.exe
file.

In the Open File - Security Warning
dialog box, click Run.

Wait for the InstallShield wizard to
prepare the installation.



10.

11

12.

13.

14.

15.

16.

17.

18.

19.

On the Forefront Security for Exchange
Server Setup Welcome screen, click
Next.

In the License Agreement dialog box,
click Yes.

In Customer Information, in the User
and Company Name text box, type
Microsoft, and then click Next.

In Installation Location, confirm that
Local Installation is selected, and then
click Next.

In Installation Type, confirm that Full
Installation is selected, and then click
Next.

In Quarantine Security Settings,
confirm that Secure Mode is selected,
and then click Next.

In the Engines dialog box, leave the
default random selections and then click
Next.

In the Engine Updates Required dialog
box, read the screen and then click Next.

In the Enable Anti-Spam Updates
dialogue, clear the Enable Automatic
Anti-Spam Updates check box.

In the Choose Destination Location
dialog box, click Next.

In the Select Program Folder dialog
box, select Accept the default location
and then click Next.

In the Start Copying Files dialog box,
click Next.

Wait for the files to copy and the
installation to complete.

In the Restart Exchange Transport
Service dialog box, click Next to restart
Exchange services now, and wait for the
services to restart.

This will take a few minutes. If the
services fail to initially restart, click
Retry.

Click Next.

In the Installation Wizard Complete
dialog box, click Finish.

Close the Read Me file.



Use the Forefront Server Security Administrator

Summary

1. Start the Microsoft Forefront Security
Administrator.

2. Send a message with an attachment through
the Edge Transport server and then examine
the statistics in the Microsoft Forefront
Security Administrator.

3. Confirm that the message arrived.

Detailed Steps

1.

10.

11.

12.

13.

On EDGEDOL1, click Start, point to All
Programs, point to Microsoft Forefront
Server Security, point to Exchange
Server, and then click Forefront Server
Security Administrator.

In the Connect to Server dialog box,
confirm that the server name is EDGEO1
and then click OK.

The Forefront Server Security
Administrator will open.

In the License Activation dialog box,
click OK.

In the left pane of the Forefront Server
Security Administrator, in the Settings
area, click Scan Job.

On the right, in the top work panel, select
Transport Scan Job.

Switch to SMBEXOL1.

On SMBEXO01, click Start, point to All
Programs, and then click Internet
Explorer.

In Internet Explorer, in the Address bar,
type
http://SMBEXO01.nwtraders.com/OWA
and then press ENTER.

In the User Name text box, type
nwtraders\spencer and then in the
Password text box, type P@sswOrd and
then click OK.

In Microsoft Office Outlook® Web
Access running as Spencer, click New,
and then in the To text box, type
steve@contoso.com

In the Subject line, type IMPORTANT:
Working together on Project X

In the message body, type We would like
to meet you to discuss how we can
collaborate more effectively. | attach a
picture of our network environment.

Click the Attach Files button.



14.

15.

16.

17.

18.

19.
20.

21.

22.

12.

23.

In the Attach Files dialog box, click
Browse, browse to the file
C:\e2007_security SMBEXO01.jpg and
then click Open.

In the Attach Files dialog box, click
Attach.

Click the Importance: High button (the
red exclamation mark) and then click
Send.

Leave Outlook Web Access open.

Switch to EDGEO1 and then switch to the
Forefront Server Security Administrator.

In the Forefront Server Security
Administrator, click Report.

In Report, click Incidents.

Examine the Statistics pane. Click
Messages to view the number of
messages that were scanned.

In the Statistics pane, click Attachments
to view the number of attachments that
were scanned and the number of
attachments that were removed.

Notice how the attachment you sent was
scanned but not removed.

Switch to IMAILO1 and, if you are not
already logged on, log on as
Administrator with a password of
P@sswOrd.

On IMAILO1, click Start, and then click
Outlook Express.

Outlook Express will now load as a user
named Steve in the Contoso.com
domain.

In Outlook Express, click Send/Receive
to confirm that the message arrived. View
the message.

Leave Outlook Express open.

Observe what happens when an attachment infected with a virus is sent

Summary Detailed Steps

1. Use aprovided text file 1. Switch to EDGEO1.



that appears to be a virus.

Attach the virus to a
message and send the
message through the Edge
Transport server.

Examine the statistics in
the Microsoft Forefront
Security Administrator.

Confirm that the
attachment was removed.

10.
11.

12.
13.

14.

15.

16.
17.

18.

19.

20.
21,

13.

22.

Using Windows Explorer, navigate to the C:\labs\forefront
security folder and double-click the file test virus.txt to
open it in Notepad.

In Notepad, click File, and then click Save As.

In the Save As dialog box, in the File name text box, type
\\smbex01\edge\fakevirus and then click Save.

This will save the file to SMBEXO1 for you to attach to a
mail item.

Close Notepad.

Switch to SMBEXO0L1 and then switch to Outlook Web
Access running as Spencer.

In Outlook Web Access running as Spencer, click New, and
then in the To text box, type steve@contoso.com

In the Subject line, type More information on Project X

In the message body, type | am attaching a file that will
give us something to discuss in the meeting!

Click the Attach Files button.

In the Attach Files dialog box, click Browse, browse to the
file C:\labs\edge\fakevirus.txt, and then click Open.

In the Attach Files dialog box, click Attach.

Click the Importance: High button (the red exclamation
mark) and then click Send.

Leave Outlook Web Access open.

Switch to EDGEQ1 and then switch to Forefront Server
Security Administrator.

In the Forefront Server Security Administrator, click
Report.

In Report, click Incidents.

Examine the Statistics pane. Click Messages to view the
number of messages that were scanned.

In the Statistics pane, click Attachments to view the
number of attachments that were scanned and the number of
attachments that were removed.

Notice that there is now a record for a removed attachment.

In the Forefront Server Security Administrator, click
Report.

In Report, click Quarantine.

In the Quarantine pane, scroll across and read the record for
the attachment virus sent by Spencer.

Switch to IMAILO1 and then switch to Outlook Express.

Outlook Express will now load as a user named Steve in
the Contoso.com domain.

In Outlook Express, click Send/Receive to confirm that the



23.
24.
25.

26.

message arrived. View the message.
Open any attachments and read them.
In the message, click Reply.

In the reply message, type Yes Spencer, we certainly do
have some things to discuss!

Click Send.
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Lab: Configuring the Unified Messaging Server
Lab: Configuring the Unified Messaging Server

¢ Exercise 1: Configuring the Unified
Messaging Environment

¢ Exercise 2: Creating Dialing Instructions

~ ~’ ¢ Exercise 3: Testing Unified Messaging with
the Exchange UM Test Phone

NIRCS .

Time estimated: 60 minutes

Lab objective

After completing this lab, you will be able to configure the Microsoft® Exchange Server 2007 Unified
Messaging environment to receive incoming calls and apply dialing restrictions.

Scenario

You are the Exchange administrator for Northwind Traders. You have decided to install the Exchange
Server 2007 Unified Messaging server role, you are asked to configure the server to receive incoming
calls on behalf of two pilot users, Peter Houston and Holly Holt. You will configure a global dial plan
and a Unified Messaging gateway pointing at the address of your voice over IP (VolIP) gateway, and
then create a Unified Messaging mailbox policy to apply to the configured users.

Introduction
In this lab, you will use the host computer, and the SMBEXO01 and CLIENTOL1 virtual servers.

Prerequisites
This lab does not depend on any previous labs being completed.



Exercise 0: Preparing the Environment

Prepare the environment
Summary Detailed Steps

e Prepare the environment 1. To prepare for this lab, ensure that the SMBEXO01 and
for the lab. CLIENTO1 virtual servers are started.



Exercise 1: Configuring Unified Messaging

Introduction

In this exercise, you will configure the Unified Messaging environment for the NWTraders Exchange
organization. First, you will create a dial plan and a Unified Messaging gateway. You will then create
a non-default hunt group and associate it with the Unified Messaging gateway you created. Finally,
you will set the parameters of the Unified Messaging mailbox policy and associate the SMBEX01
Unified Messaging server with the new dial plan you created.

Use the Exchange Management Console to create a new dial plan

Summary Detailed Steps

e Use the Exchange 1. Click Start, point to All Programs, point to Microsoft
Management Console to Exchange Server 2007, and then click Exchange
create a new dial plan. Management Console.

2. In the Exchange Management Console, in the Navigation
pane, expand Organization Configuration, and then click
Unified Messaging.

3. Inthe Action pane, click New UM Dial Plan.

4. Inthe Dial Plan Name text box, type
NWTraders_Dial_Plan

5. In the Extension box, in the Number of digits text box,
type 4

6. Inthe New UM Dial Plan wizard, click New.
7. On the Completion page, click Finish.

Check security settings on the new dial plan by using Exchange Management Shell

Summary Detailed Steps

o  Check security settings on 1. Click Start, point to All Programs, point to Microsoft
the new dial plan by using Exchange Server 2007, and then click Exchange
the Exchange Management Shell.
Management Shell. Wait for the Exchange Management Shell to initialize.

2. Inthe Exchange Management Shell, type the following
text and then press ENTER:

get-UMDialPlan NWTraders_Dial_Plan | FL

3. Scroll through the output and locate the value of the
VolPSecurity property.

What is the security set on the dial plan?
Leave Exchange Management Shell running.

Answer Key

3. Unsecured



Create an Auto Attendant and assign it a pilot number

Summary

Using the Exchange
Management Console,
create the main Auto-
Attendant.

Using the Exchange
Management Shell, assign
the Auto Attendant a pilot
number.

Detailed Steps

1.

10.

11.

12.

Create a Unified Messaging gateway

Summary

Create a Unified
Messaging gateway.

In the Exchange Management Console, in the Navigation
pane, expand Organization Configuration, and then click
Unified Messaging.

In the Result pane, click the UM Auto Attendants tab.

In the Action pane, click New UM Auto Attendant.

In the Auto Attendant name text box, type
Nwtraders_Global AA

In the Select associated dial plan dialog box, click
Browse, select Nwtraders_Dial_Plan, and then click OK.

Leave the Extension numbers field blank.
Select the Create auto attendant as enabled check box.

Ensure that the Create auto attendant as speech-enabled
check box is not selected.

In the New UM Auto Attendant dialog box, click New
and then click Finish.

Switch to the Exchange Management Shell, type the
following text and then press ENTER:

Set-UMAuUtoAttendant Nwtraders_Global_AA
-PilotldentifierList 4445

In the Exchange Management Shell, type the following
text and then press ENTER:

get-UMAuUtoAttendant Nwtraders_Global AA | FL

Ensure that the Pilot Number (PilotldentifierList) has been
set correctly.

Detailed Steps

1.
2.

Switch to the Exchange Management Console.

In the Exchange Management Console, in the Action pane,
click New UM IP Gateway.

In the UM IP gateway name text box, type
Nwtraders_Gateway

In the Address for the gateway text box, type 10.0.0.100
(the address of the host machine).

In the Dial plan box, click Browse, click
NWTraders_Dial_Plan, and then click OK.

In the New UM IP Gateway box, click New, and then
click Finish.

In the Result pane, click the UM IP Gateway tab and then
expand NWTraders_Gateway.

Is a hunt group object created by default for the new



gateway object?
8. Right-click the DefaultHuntGroup object and then click
Remove.

9. Inthe dialog box, click Yes.
Answer Key

7. Yes

Use Exchange Management Shell to create a new hunt group

Summary Detailed Steps

e Use Exchange 1. Switch to the Exchange Management Shell.
Management Shell to 2. In the Exchange Management Shell, type the following
create a new hunt group. text and then press ENTER:

New-umhuntgroup -name NWTraders_HG -umipgateway
NWTraders_Gateway -umdialplan NWTraders_Dial_Plan -
Pilotidentifier 4444

Leave Exchange Management Shell Running.

3. Switch to the Exchange Management Console and press F5
to refresh the display.

Is the new hunt group associated with the
NWTraders_Gateway object?
Answer Key

3. Yes

Use the Exchange Management Shell to associate the SMBEX01 Unified Messaging server with the
NWTraders_Dial_Plan dial plan

Summary Detailed Steps

e Use the Exchange 1. Switch to the Exchange Management Shell.
Management Shell to 2. In the Exchange Management Shell, type the following
associate the SMBEXO01 text and then press ENTER:

yvﬂglte;]deMessaglng SETVET Set-UMServer -id SMBEX01 -dialplans NWTraders_Dial_Plan

NWTraders_Dial_Plan Leave the Exchange Management Shell Running.
dial plan.

Use the Exchange Management Console to view and modify the Unified Messaging mailbox policy to
allow users to dial extensions

Summary Detailed Steps

e Use the Exchange 1. In Exchange Management Console, in the Result pane,
Management Console to click the UM Mailbox Policies tab.
view and modify the Has a Unified Messaging mailbox policy been created
Unified Messaging automatically? If Yes, what is the name of the new
mailbox policy to allow Unified Messaging mailbox policy?

users to dial extensions. 2. Right-click NWTraders_Dial_Plan Default Policy, and



Answer Key

then in the Action pane, click Properties.

In the NWTraders_Dial_Plan Default Policy Properties
box, click the Message Text tab, and then in the Text sent
when a UM mailbox is enabled box, type the following
text:

Your mailbox has been enabled for Exchange Unified
Messaging features.

Click the Dialing Restrictions tab.
Verify Allow calls to extensions is checked.

Click the PIN Policies tab and notice the default pin
requirements.

In the NWTraders_Dial_Plan Default Policy Properties
box, click OK.

1. NWTraders_Dial_Plan Default Policy

Enable the Peter Houston and Holly Holt user accounts for Unified Messaging

Summary

e Enable the Peter Houston
and Holly Holt user
accounts for Unified
Messaging.

Detailed Steps
1.

In the Exchange Management Console, in the Navigation
pane, expand Recipient Configuration, and then click
Mailbox.

In the Result pane, right-click Peter Houston, and then
click Enable Unified Messaging.
In the Unified Messaging Mailbox Policy box, click
Browse.
In the Select UM Policy box, click
NWTraders_Dial_Plan Default Policy, and then click
OK.
In the Manually entered mailbox extension text box, type
4123
Select the Manually specify PIN option, and then in the
PIN text box, type 425206.
Notice that the PIN complexity must comply with the
Unified Messaging mailbox policy.
In the Enable Unified Messaging box, click Enable.

Repeat steps 1 to 7 for Holly Holt, assigning her the
extension of 4124.



Exercise 2: Create Dialing Restrictions

Introduction

In this exercise, you will create a list of dialing restrictions that you want to apply to Unified
Messaging users. You will then apply the list at both the gateway and Unified Messaging policy
levels.

Create dialing restrictions and use the Exchange Management Console to import dialing restrictions
into the dial plan configuration

Summary Detailed Steps
e Create a comma-separated 1. Switch to the Exchange Management Console.
value (CSV) file with a 2. In the Navigation pane, expand Organization
list of dialing restrictions. Configuration, and then click Unified Messaging.
e Use the Exchange 3. Inthe Result pane, click the UM Dial Plan tab, and then
Management Console to click NWTraders_Dial_Plan.
import dialing restrictions 4. Inthe Action pane, click Properties.
Lrgsffgﬁrilt?éﬁlan 5 In_th_e NWTraders_Dial_Plan Properties box, click the
’ Dialing Rule Groups tab.
6. Inthe In-Country/Region Rules group, click Add.
7. In the Name box type Low-rate
8. In the Number mask box type 91425XXXXXXX
9. In the Dialed number box type 9XXXxxxx

10. In the Comment box type Low rate call and then click
OK.

11. Repeat steps 6-10 using the following tables:

Field Value

Name Local

Number mask 91425*

Dialed number 425*
Comment Local call
Field Value

Name Lab

Number mask 91425333xxXX
Dialed number XXXX
Comment Exchange Lab

12. In the Dial_Plan Properties box, click OK.



Use Exchange Management Shell to view the dial plan configuration and configure allowed in-

country groups on the dial plan

Summary

e Use Exchange
Management Shell to
view the dial plan
configuration and
configure allowed in-
country groups on the dial
plan.

Answer Key

3. Lab, Local, Low-rate
4. None at this point
8. Lab

Detailed Steps

1.
2.

~

Switch to the Exchange Management Shell.

In the Exchange Management Shell, type the following
text and then press ENTER:

Get-UMDialPlan -id Nwtraders_Dial_Plan |FL

Scroll through the command output until you locate the
ConfiguredInCountryOrRegionGroups property.

What in-country groups are configured?

Scroll through the command output until you locate the
AllowedInCountryOrRegionGroups property.

What in-country groups are allowed?

In the Exchange Management Shell, type the following
text and then press ENTER:

Set-UMDialPlan Nwtraders_Dial_Plan
-AllowedInCountryOrRegionGroups Lab

In the Exchange Management Shell, type the following
text and then press ENTER:

Get-UMDialPlan -id Nwtraders_Dial_Plan |FL
Scroll through the command output until you locate the
AllowedInCountryOrRegionGroups property.

What in-country groups are allowed?

Apply the rules you configured on the dial plan to the Unified Messaging mailbox policy object

Summary

o Apply the rules you
configured on the dial
plan to the Unified
Messaging mailbox policy
object.

Detailed Steps

1
2.

Switch to the Exchange Management Console.
In the Result pane, click the UM Mailbox Policies tab.

Select the NWTraders_Dial_Plan Default Policy, and
then in the Action pane, click Properties.

In NWTraders_Dial_Plan Default Policy Properties,
click the Dialing Restrictions tab.

In Select allowed in-country/region rule groups from
dial plan, click Add.

In the Select Allowed In-Country/Region Groups list,
select Lab, and then click OK.

In NWTraders_Dial_Plan Default Policy Properties,
click OK.



Use Exchange Management Shell to view the properties of the mailbox policy

Summary Detailed Steps

e Use Exchange 1. Switch to the Exchange Management Shell.
Management Shell to 2. In Exchange Management Shell, type the following text
view the properties of the and then press ENTER:
mailbox policy. Get-UMMiailboxPolicy “Nwtraders_Dial_Plan Default

Policy” |FL

3. Scroll through the command output until you locate the
AllowedInCountryOrRegionGroups property.

What in-country groups are allowed?

Answer Key

3. Lab



Exercise 3: Testing Unified Messaging with the Exchange UM Test Phone

Introduction

In this exercise, you will test the Unified Messaging functionality you configured on the SMBEX01
server, by using the Exchange UM Test Phone application that is shipped with Exchange Server 2007.

Important: Perform this exercise only if you have a sound card and a microphone and have
configured the Exchange UM Test Phone application.

Use the Exchange UM Test Phone to test the Auto Attendant functionality

Summary Detailed Steps
e Test the Auto Attendant 1. Switch to the host computer.
functionality by using the 2. Open Microsoft Windows® Explorer and navigate to
Exchange UM Test C:\SIP_Emulator and double-click
Phone. ExchangeUMTestPhone.exe.
3. In Exchange UM Test Phone, click Tools and then click
Setup.
4. Ensure that the Server IP box is set to 10.0.0.10
5. Inthe Pilot Identifier text box, type 4444
6. Clear the Caller ID box.
7. Verify that the Diversion check box is not selected and then
click OK.
8. Inthe Exchange UM Test Phone, click Make Call.
Wait for the call to be connected.
9. Listen to the default Auto Attendant greeting and then press
#
10. Spell Holt using the keypad.
11. Press 1 to confirm you want Holly Holt.
12. Leave a brief voice mail for Holly.
13. In the Exchange UM Test Phone, click Hang Up.

Setup Peter Houston’s Voice Mail box

Summary Detailed Steps
e  Setup Peter Houston’s 1. In Exchange UM Test Phone, click Tools, and then click
voice mail box. Setup.
2. Inthe Caller ID text box, type 4123 (Peter Houston’s
extension).
3. Verify the Diversion check box is unchecked and click
OK.
4. In Exchange UM Test Phone, click the Make Call
button.
5. Watch the call state in the Call Log box and listen to the
greeting.
6. Press 425206# when prompted for your PIN.



7. Follow the instructions for setting up Peter’s name and
greeting.
8. When finished, click the Hang Up button.

Place a call to Peter Houston as Holly Holt

Summary Detailed Steps
e Place acall to Peter 1. In Exchange UM Test Phone, click Tools, and then click
Houston as Holly Holt. Setup.
2. Inthe Caller ID text box, type 4124 (Holly Holt’s
extension).

3. Select the Diversion check box. In the Number box, type
4123 (Peter Houston’s extension), and then click OK.

4. In Exchange UM Test Phone, click the Make Call
button.

Watch the call state in the Call Log box. When
connected, listen to the greeting you just sent.

Leave a message for Peter.
5. Click the Hang Up button.

Place a call to Holly Holt as Peter Houston using the full phone number

Summary Detailed Steps
e Place a call to Holly Holt 1. In Exchange UM Test Phone, click Tools, and then click
as Peter Houston. Setup.
2. Inthe Caller ID text box, type 4123 (Peter Houston’s
extension).

3. Select the Diversion check box, and in the Number box,
type 94253334124 (Holly Holt’s extension), and then click
OK.

4. In Exchange UM Test Phone, click the Make Call
button.

5. Watch the call state in the Call Log box and listen to the
default greeting.

6. Leave a message for Holly.
7. Click the Hang Up button.

Listen to Peter’s voice mails using Microsoft Office Outlook Web Access

Summary Detailed Steps
e Listen to Peter’s voice 1. Switch to the host computer, click Start, and then click
mails using Microsoft Internet Explorer.
Office Outlook Web 2. In Internet Explorer, in the Address box, type
Access http://smbex01.nwtraders.com/owa and then press
ENTER.
3. Log on to Outlook Web Access as peter with a password
of P@ssword

4. Open the Inbox item with the subject Voice Mail from



Holly Holt.
5. Click the Play button to listen to the voice mail.

6. Close the voice mail from Holly, and then close Outlook
Web Access.

View Peter’s voice mails using Microsoft Office Outlook 2007 (Optional)

Summary Detailed Steps

e View Peter’s voice mails 1. Switch to the CLIENTOL virtual server.
using Microsoft Office 2. If not already logged in, press the RIGHT-ALT and
Outlook 2007 DELETE keys and log on as nwtraders\peter with a

password of P@ssword.

3. Click Start, point to All Programs, point to Microsoft
Office, and then click Microsoft Office Outlook 2007.

4. Wait for Outlook to open and to update the folders.

5. Open the Inbox item with the subject VVoice Mail from
Holly Holt.

NOTE: You will not be able to play this message due to the
hardware limitations of virtual servers.

6. Close Outlook and log off from CLIENTOL.

Additional Unified Messaging tasks (as time permits).
Summary Detailed Steps

e Optional tasks to perform 1. Switch to the Exchange UM Test Phone.
exploring the options and 2. Click Tools, and then click Setup.
capabilities of Unified 3. Clear the Diversion check box, and then click OK.
4

Messaging.

ging In Exchange UM Test Phone, click the Make Call
button.
Listen to the greeting and type 425206#

Perform the following tasks as instructed by the Auto
Attendant:
a. Listen to your e-mail using Unified Messaging.

o o

b. Listen to your calendar using Unified Messaging.

c. Reply to an e-mail message using Unified
Messaging

d. Send a calendar request using Unified Messaging.



Lab: Transitioning from Exchange Server 2003 to Exchange Server
2007

Time estimated: 60 minutes
Lab objectives
After completing this lab, you will be able to:

o Install Microsofte Exchange Server 2007 in an existing Exchange Server 2003 single-forest
environment.

Note This lab focuses on the concepts in this module and as a result may not comply with Microsoft
security recommendations.




Exercise 0: Preparing the Lab Environment

Prepare the environment
Summary Detailed Steps

e To prepare for this lab, 1. Start the EXBEO1 and EXO7 virtual servers.

start the EXBEO1 and
EXO07 virtual servers.



Installing Exchange Server 2007 into an Existing Exchange Server 2003
Environment

Introduction

In this exercise, you will use the Exchange Server 2007 installation wizard to prepare the
Microsoft Active Directorye directory service for the Exchange Server 2007 installation.

Scenario
You are the Exchange administrator at Northwind Traders. You currently have Exchange Server 2003

in your environment and you are preparing and installing Exchange Server 2007.
Prepare for a new Exchange Server 2007 installation
Summary Detailed Steps

e Logonto EXBEOL e OnEXBEO01, log on to the NWTRADERS domain as
Administrator with a password of P@sswOrd.

Note EXBEO1 has the .NET Framework 2.0 installed,
ADMap and ExBPA have been run to verify the environment,
and Exchange Server 2003 is running in native mode. Ex07,
the server that Exchange Server 2007 will be installed on, is
joined to the Exchange 2003 Server domain NWTRADERS.

Install Exchange Server 2007

Summary Detailed Steps

e Install Exchange Server 1. On EXO07, click Start, click Windows Explorer, expand My
2007. Computer, click EX2007_RTM, and then double-click
Setup.exe

Notice that steps 1-3 have already been installed.
Click Step 4: Install Microsoft Exchange.
On the Introduction page, click Next.

ok~ DN

Select | accept the terms in the license agreement, and then
click Next.

On the Error Reporting page, click Next.

o

7. Verify that Typical Exchange Installation is selected, and then
click Next.

8. In the Mail Flow window, click Browse, select EXBEOQ1, click
OK, and then click Next.

9. Click Next.
10. In the Results window, review the warnings and then click Install.

11. Click Finish and then click Close. This will start the Exchange
Management Console.

Look at Holly’s mailbox on the Exchange 2003 server (EXBE01)
Summary Detailed Steps



e Look at Holly’s mailbox 1. Click Start, click All Programs, and then click Internet
on the Exchange 2003 Explorer.
server (EXBEOL). 2. In Internet Explorer, type http://exbe01/exchange/holly
Log on as nwtraders\holly with a password of P@sswOrd.

4. Notice the mail messages in her mailbox.

Mount the Exchange Server 2007 mailbox database

Summary Detailed Steps

e Mount the Exchange 1. Click Start, point to All Programs, point to Exchange
Server 2007 mailbox Server 2007, and then click Exchange Management
database. Console.

In the navigation pane, expand Server Configuration.

In the work pane, expand First Storage Group, and then
select Mailbox Database.

4. In the action pane, click Mount Database. This will mount
the mailbox database and allow you to move users from
Exchange Server 2003 to Exchange Server 2007.



Exercise 2: Moving a User from Exchange Server 2003 to Exchange Server
2007

Introduction
In this exercise, you will move a user from Exchange Server 2003 to Exchange Server 2007.

Scenario

You are the Exchange administrator at Northwind Traders. You currently have Exchange Server 2003
in your environment and you are in the process of moving users from Exchange Server 2003 to
Exchange Server 2007.

Move a user from Exchange Server 2003 to Exchange Server 2007

Summary Detailed Steps
e Move a user from 1. Inthe Exchange Management Console, expand Recipient
Exchange Server 2003 to Configuration, and then select Mailbox.
Exchange Server 2007. 2. Inthe work pane right click Holly Holt, and then click Move
Mailbox.

3. Inthe Move Mailbox — Introduction window, verify that
EXO07 is the selected server, and then click Next.

In the Move Mailbox — Move Options window, click Next.
In the Move Mailbox — Schedule window, click Next.

In the Move Mailbox — Move Mailbox window, click
Move.

7. In the Move Mailbox — Completion window, click Finish

Look at Holly Holt’s mail on Exchange Server 2007 (EX07)
Summary Detailed Steps
Look at Holly Holt’s mail 1. Click Start, click All Programs and then click Internet

on Exchange Server 2007 Explorer.
(EXQ7). 2. In Internet Explorer, in the Address bar, type
https://fex07/owa and then press ENTER.

In the security alert window, click Yes.

4. If an Internet Explorer content window opens, click Add,
click Add, and then click Close.

5. Log on to Outlook Web Access with a user name of
nwtraders\holly and a password of P@sswOrd

6. In Outlook Web Access, verify the language and time zone
and click OK.

7. Notice the messages from Holly’s Exchange Server 2003
mailbox have been moved.



Send a message from Holly Holt to James Fine

Summary

Send a message from
Holly Holt to James Fine.

Detailed Steps

1.
2.

In Outlook Web Access, click New.

In the To field, type James Fine, and then press CTRL+K to
resolve the address.

In the Subject field, type Verification Message from EX07.

In the message body, type This is a message to verify
communication between Exchange Server 2003 and
Exchange Server 2007.

Click Options.

Select the Request a delivery receipt for this message
check box.

Select the Request a read receipt for this message check
box, and then click OK

Click Send. You will receive a delivery confirmation.

Look at James Fine’s mail on Exchange Server 2003 (EXBE01)

Summary

Send a test e-mail
message to verify mail
flow.

Detailed Steps

1.

Click Start, click All Programs, and then click Internet
Explorer.

In Internet Explorer, in the Address bar, type
http://exbe01/exchange/james and then press ENTER.

Log on to Outlook Web Access with a user name of
nwtraders\james and a password of P@sswOrd

Open the message from Holly Holt with the subject line
Verification Message from EXO07.

At the top of the message window, click Click here to send
a receipt.

Switch to Holly’s Outlook Web Access instance and notice
the receipt has been received.



Lab: Using Exchange Server 2007 Local Continuous Replication

Lab : Using Exchange Server 2007 Local Continuous
Replication

« Exercise 1: Preparing the Forest Root and
the Domain for the Live Communications
Server Installation

| « Exercise 2: Installing Live Communications
- Server Using the Deployment Tool

N « Exercise 3: Configuring Users for Live
P{/ Communications Server

Communicator

\J « Exercise 5: Adding Contacts and Sending
‘ Instant Messages

¢ « Exercise 4: Installing and Configuring Office
]

| g

Time estimated: 40 minutes
Introduction

In this lab, you will update Active Directory to prepare for the Live Communications Server
installation. You will then install Live Communications Server 2005 on SMBEXO0L1. You will also
enable users for Live Communications, and install and configure Microsoft Office Communicator to
conduct an instant message conversation.

Lab objectives
After completing this lab, you will be able to:

e Prepare Active Directory directory service for Microsoft Office Live Communications Server
2005 by using the Live Communications Server Deployment Tool.

o Install Live Communications Server 2005 Standard Edition by using the Live
Communications Server Deployment Tool.

e Configure users for Live Communications Server.

¢ Install and configure Microsoft Windows Messenger 5.1 to use a Transmission Control
Protocol (TCP) connection.

e Add contacts and send instant messages.

Note Because this lab focuses on concepts, it may not comply with Microsoft security
recommendations.



Exercise 0: Preparing the Environment

Prepare the environment
Summary Detailed Steps

e Prepare the environment. 1. To prepare for this lab, start the SMBEXO01 and
CLIENTO1 virtual servers.



Exercise 1: Preparing the Forest Root and the Domain for the Live
Communications Server Installation

Introduction

In this exercise, you will install the Live Communications Server schema extensions to Active
Directory, and run Forest Prep and Domain Prep. You need to perform this task only once during
installation. You should perform this task on the forest root domain controller, which is the schema
master. To perform this task, you must have schema administrator privileges.

Prepare the Enterprise Schema, Forest, and Domain
Detailed Steps

Summary

e Prepare the Enterprise
schema, forest, and
domain.

1.

On SMBEXO01, if you have not logged on, log on as
nwtraders\Administrator with a password of P@sswOrd

Click Start, and then click Run.

In the Open box, type d:\Setup\I386\Setup.exe and then
click OK.

Setup starts and launches the Deployment Tool.

Click Standard Edition Server.

Click Prep Schema, and then, on the Welcome page, click
Next.

6. Verify that the Default: Schema files are located in the
same directory as Setup check box is selected, and then
click Next.

7. On the Ready to Prepare Active Directory Schema page,
click Next.

On the completion page, click View Log.
Under the Action column, click the plus sign (+) to expand
Schema Prep.

10. Look for <Success> in the Execution Result column at the
end of each task to verify that Prep Schema completed
successfully.

11. Close the Log window.

12. Click Finish.

Note
The Deployment Tool places a checkmark next to items as they are
completed.

13. Click Prep Forest, and then, on the Welcome page, click

14.

15.
16.

Next.

On the Ready to Run Forest Preparation page, read the
warning message, and then click Next.

On the completion page, click View Log.
Under the Action column, expand Forest Prep.



17.

Look for <Success> in the Execution Result column at the
end of each task to verify that Prep Forest completed
successfully.

Note

Some items in the Action Information column are listed as ‘Not

Ready’.

These items are listed as ‘Ready’ after Domain Prep is

completed in the next exercise

18.
19.
20.

21.

22.
23.
24,

25.
26.

Close the Log window.
Click Finish.

Click Prep Domain, and then, on the Welcome page, click
Next.

On the Ready to Run Domain Preparation page, read the
warning message, and then click Next.

On the completion page, click View Log.
Under the Action column, expand Domain Prep.

Look for <Success> in the Execution Result column at the
end of each task to verify that Prep Domain completed
successfully.

Close the Log window.
Click Finish.



Exercise 2: Installing Live Communications Server Using the Deployment Tool

Introduction

In this exercise, you will use the Live Communications Server Deployment Tool to install the Live
Communications Server on SMBEXO01 and then verify that the installation was successful.

Install the Live Communications Server 2005 using the Live Communications Server Deployment

Tool
Summary

e Install the Live
Communications Server
2005 using the Live
Communications Server
Deployment Tool.

Detailed Steps

1.

On SMBEXO01, on the Deployment Tool page, click Install
Files for Standard Edition Server.

Note

Microsoft SQL Server Desktop Edition is automatically installed.

© © N o>

11.

On the Welcome page click Next.

On the License Agreement page, click I accept the terms in
the license agreement, and then click Next.

On the Customer Information page, type your information,
and then click Next.

On the Choose Destination Locations page, review the
folder destination information, and then click Next.

On the Ready to Install the Program page, click Install.
On the completion page, click Finish.
In the Server Activation dialog box, click Yes.

In the Welcome to the Activate Standard Edition Server
Wizard page, click Next.

. On the Select Account page, verify that Create a New

Account is selected.

Ensure that LCService is listed for the Account Name, and
then, in the Password and the Confirm Password fields,
type P@sswOrd and then click Next.

Note

If you specify a new account, the wizard automatically creates and
configures this account.

12.

13.

14.

15.

On the Enable IM Archiving page, verify that the check box
is cleared, and then click Next.

On the Start Service Option page, verify that the Start the
service after activation check box is selected, and then
click Next.

On the Ready to Activate page, review your selections, and
then click Next.

On the Wizard Completed page, click View Log.



16. Under the Action column, expand Activate.

17. Look for <Success> in the Execution Result column at the

end of each task to verify that the server activated
successfully.

18. Close the Log window.

19. Click Finish and then close the Deployment Tool page.
20. Click Exit to close the Standard Edition Deployment Tool

page.

Configure Live Communications Server

Summary

Configure Live
Communications
Server.

Detailed Steps

1.

10.

On SMBEXO01, click Start, right-click My Computer and
then click Manage.

Expand Services and Applications.

Right-click Microsoft Live Communications Server 2005
and then click Properties.

In the Connections box, select the only entry, and then click
Edit.

In the edit connection window, verify that All available IP
Addresses is selected.

In the transport type drop down, select TLS.

Verify that Authenticate remote server is selected and that
the Listen to this port is set to 5061.

Click Select Certificate. In the Select Certificate window,
click the certificate that is issued to
SMBEXO01.nwtraders.com and issued by nwtraders.

Click OK twice.

In the Computer Management window, right-click Microsoft
Communications Server 2005, and click Start if it is
available.

11. Close Computer Management.

Configure DNS for Live Communications Server

Summary

Configure DNS for Live
Communications Server.

Detailed Steps

1.

Click Start, click All Programs, click Administrative
Tools, and then click DNS.

Expand SMBEO1 and then expand Forward Lookup Zone.

Right click nwtraders.com, and then click New Other
Records.

In the Select Service Record window, scroll down, select
the SRV record, and then click Create Record.

In the Service box type _sipinteraltls



In the Port box type _tcp
In the Port number box type 5061

In the Host offering this service box type
smbex01.nwtraders.com

Click Done, and then close DNS.



Exercise 3: Configuring Users for Live Communications Server
Introduction

In this exercise, you will enable users for Live Communications Server and then specify users’
Session Initiation Protocol (SIP) Uniform Resource Identifiers (URIS).

Configure user accounts for Live Communications Server

Summary Detailed Steps

e Configure user accounts 1. On EXBEO]1, click Start, point to Programs, point to
for Live Communications Administrative Tools, and then click Active Directory
Server. Users and Computers.

2. Inthe left pane, expand nwtraders.msft, and then click
NWTraders Users.

3. Inthe right pane, right-click Frank Miller, and then click
Properties.

4. On the Live Communications tab, select the Enable Live
Communications for this user check box.

5. Inthe SIP URI field, verify that the address is
sip:frank@nwtraders.com.

6. Inthe Server or pool drop-down list box, select
SMBEXO01.nwtraders.msft, and then click OK.

Right-click Susan Burk, and then click Properties.

8. On the Live Communications tab, select the Enable Live
Communications for this user check box.

9. Inthe SIP URI field, verify that the address is
sip:susann@nwtraders.com.

10. In the Server or pool drop-down list box, select the
EXBEOQ1.nwtraders.msft check box, and then click OK.

11. Close Active Directory Users and Computers.



Exercise 4: Installing and Configuring Office Communicator

Introduction

In this exercise, you will install Office Communicator on the SMBEXO01 and CLIENTO1 virtual

computers.

Install Office Communicator

Summary Detailed Steps
e Install Office 1. On SMBEXO01, click Start, and then click Run.
Communicator. 2. In the Open box, type \\client01\c$\office communicator

2005\communicator.msi and then click OK.

3. On the Microsoft Office Communicator Welcome page,
click Next.

4. On the License Agreement page, click | accept the terms in
the license agreement, and then click Next.
On the product identification page, click Next.
On the Configure Microsoft Communicator 2005 page, click
Next.
On the Setup Wizard Completed page, click Finish.
Switch to CLIENTO1, and then log on as nwtraders\kevinc
with a password of MSEvent.123

9. Click Start, and then click Run.

10. In the Open box, type c:\office communicator
2005\communicator.msi and then click OK.

11. On the Microsoft Office Communicator Welcome page,
click Next.

12. On the License Agreement page, click I accept the terms in
the license agreement, and then click Next.

13. On the product identification page, click Next.

14. On the Configure Microsoft Communicator 2005 page, click
Next.

15. On the Setup Wizard Completed page, click Finish.

Configure Communicator

Summary Detailed Steps
e Configure Communicator. 1. Switch to SMBEXO01.
2. To open Office Communicator 2005, click Start, point to

All Programs, and then click Microsoft Office
Communicator 2005.

Click Actions, and then click Options.

Click the Accounts tab, and then select the My contacts
include users of a SIP Communications Service check
box.

Click the Accounts tab and in the Sign-in name field, type
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10.

11.
12.
13.
14.
15.
16.

17.
18.
19.

frank@nwtraders.com

Click Advanced, select Configure Settings, and in the
Server name or IP address field, type
SMBEXO01.nwtraders.com. Select TCP, and then click OK
twice.

Click the Sign In button.

In the Username field, type frank@nwtraders.com and
then in the Password field, type P@sswOrd and then click
OK.

Switch to CLIENTO1.

To open Office Communicator, click Start, point to All
Programs, and then click Microsoft Office
Communicator 2005.

Click Actions, and then click Options.

Click the Accounts tab.

In the sign-in name box type susanb@nwtraders.com.
Click the Advanced button.

In the Advanced settings window, click Configure settings.

In the Server name or IP address type
smbex01.nwtraders.com

For Connect using, click TLS, click OK.
Click Sign in.

In the Sign-in account window, for user name type
susanb@nwtraders.com and for password type P@sswOrd.
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Exercise 5: Adding Contacts and Sending Instant Messages

Introduction

In this exercise, you will add a contact and conduct an instant message conversation.

Add a contact
Summary

e Add a contact.

Send an Instant Message
Summary

e Send an instant message.

Detailed Steps

1.

On CLIENTO1, in the Office Communicator, click Contact,
and then click Add a Contact.

Click Search for a contact, and then click Next.
In the First Name field, type Frank and then click Next.

In the Search Results dialog box, click Frank Miller, click
Next, and then click Finish.

Switch to SMBEXO1.

In the Office Communicator dialog box, click Allow this
person to see when you are online and contact you, and
then click OK.

Detailed Steps

1.
2.

Switch to CLIENTO1.

In Office Communicator, right-click Frank Miller, and then
click Send an Instant Message.

Type a message, and then click Send.
Switch to SMBEXO01.

In the Conversation window, type a message, and then click
Send.

After you have finished your conversation, close any open
windows, and then log off SMBEXO01.

Switch to CLIENTO1.
Close any open windows, and then log off CLIENTO1.
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Lab: Using Microsoft Operations Manager in an Exchange Server
2007 Environment

Lab : Using Microsoft Operations Manager in an
Exchange Server 2007 Environment

« Exercise 1: Configuring MOM 2005 for
Exchange Server 2007 Operations Tasks

« Exercise 2: Using the MOM 2005 Operator

_ = Console

"« Exercise 3: Configuring Alert Notifications
-~ Using MOM 2005

OS>
L .

Time estimated: 40 minutes

Senario

You are the Operations and Infrastructure Manager for Messaging at Northwind Traders. The
company recently used a consulting services provider to deploy several Exchange Server 2007
servers. You want to consolidate and optimize monitoring tasks by deploying Microsoft Operations
Manager 2005. You deploy a MOM 2005 server and use the Exchange Management pack for MOM to
manage your Exchange Server 2007 servers.

Lab objectives

After completing this lab, you will be able to:

¢ Import Microsofte Exchange Server 2007 Management Pack for Microsoft Operations
Manager (MOM) 2005.

¢ Install MOM agents on multiple Exchange Server 2007 servers.

e Use the MOM 2005 Operator Console to view the state of Exchange Server 2007
environment.

e Use the MOM 2005 Operator Console to locate and classify an alert.
e Configure MOM 2005 to send e-mail notifications in response to certain alerts.



Note Because this lab focuses on concepts, it may not comply with Microsoft security
recommendations.



Exercise 0: Preparing the Environment

Prepare the environment
Summary Detailed Steps

e Prepare the environment. e To prepare for this lab, ensure that the SMBEX01, MOMO1,
and EXEBO3 virtual servers are started.



Exercise 1: Preparing the Forest Root and the Domain for the Live
Communications Server Installation

Introduction

In this exercise, you will import the Microsoft Exchange Server 2007 Management Pack for Microsoft
Operations Manager 2005. You will then use the MOM Administrator Console to install management
agents on all Exchange Server 2007 servers in the organization.

Scenario

Northwind Traders has a large Exchange Server 2007 deployment. After evaluating the options for
operating the environment, you have decided to implement Microsoft Operations Manager 2005 for
management and monitoring purposes.

Prepare the Enterprise Schema, Forest, and Domain

Summary Detailed Steps

e Install the Live 1. Switch to MOMOL. Log in as user Administrator, with
Communications Server a password of P@sswOrd.
2005 using the Live 2. Using Microsoft Windows® Explorer, navigate to the
Communications Server folder C:\Labs.
Deployment Tool. 3. In C:\Labs, double-click the file

Exchange2007ManagementPackForMOM2005.msi.

4. Inthe Open File — Security Warning dialog box, click
Run.

5. Inthe License Agreement dialog box, select | accept the
terms in the license agreement, and then click Next.

6. Inthe Select Extraction Folder dialog box, accept the
default folder, and then click Extract.

7. Inthe Extraction Complete dialog box, click Close.

8. Click Start, point to All Programs, point to Microsoft
Operations Manager 2005, and then click
Administrator Console.

9. Inthe MOM 2005 Administrator Console, locate the
Console Root, and then expand Microsoft Operations
Manager.

10. Right-click Management Packs, and then select
Import/Export Management Pack.

11. In the Management Pack Import/Export Wizard, on the
Welcome page, click Next.

12. On the Import or Export Management Packs page, verify
that Import Management Packs and/or reports is
selected, and then click Next.

13. On the Select a Folder and Choose Import Type page,
click Browse, and navigate to the folder C:\Program
Files\Microsoft Operations Manager
2005\Management Packs\Microsoft Exchange 2007
Management Pack. Under Type of Import, select
Import Management Packs and Reports, and then
click Next.

14. On the Select Management Packs page, select the



Summary

Use the MOM 2005
Administrator Console to
install agents on multiple
Exchange Server 2007
computers.

15.

16.

17.

Exchange2007ManagementPack.akm file, verify that
the Import Option to Update existing Management
Pack is selected, and then click Next. Wait for the
Management Pack to be imported.

On the Select Reports page, select
Exchange2007Reports.xml, and then click Next.

In the Secure Socket Layer Configuration dialog box,
click Continue, and then click Finish.

Observe the Import Status screen as the Management
Pack and Reports are imported.

When the status shows as complete for all items, click
Close.

Detailed Steps

1.

N o gk

10.

11.

12.

13.

14.

15.

In the Microsoft Operations Manager 2005 Administrator
Console, click Microsoft Operations Manager
(MOMO1) and then click Install Agents.

In the Welcome to the Install/Uninstall Agents Wizard
dialog box, click Next.

In the Method for Discovering Computers and
Installing Agents dialog box, select Browse for or type
in specific computer name and then click Next.

In the Computer Names dialog box, click Browse.

In Select Computers, click Advanced.

In Select Computers, click Find Now.

In Search Results, select EXEB03 and SMBEXO01 (use
CTRL key to make multiple selections), and then click
OK.

Confirm that both EXEBO03 and SMBEXO01 have been
added, and then click OK.

In the Computer Names dialog box, click Next.

In the Agent Installation Permissions dialog box,
confirm that the Management Server Action Account
option is selected, and then click Next.

In the Agent Action Account dialog box, confirm that
Local System is selected, and then click Next.

In the Agent Installation Directory dialog box, accept the
default folder and then click Next.

Ensure that Show Task Progress is selected, and then
click Finish.

In the Microsoft Operations Manager Task Progress
dialog box, click Details.

Watch the status change from Scheduled to Running.
Wait for the Status to change to Succeeded for both
SMBEXO01 and EXEBO3 (approx three minutes).

Click Close.



Check for a successful agent
installation on SMBEXOL.

16. In the MOM 2005 Administrator Console, expand
Administration, and then expand Computers.

17. Under Computers, select Agent Managed Computers,
and confirm that both SMBEXO01 and EXEBO03 are
displayed.

1. Switch to SMBEXOL1. Log in as user Administrator, with
a password of P@sswOrd.
2. Click Start, right-click My Computer, and then click
Manage.
3. Expand the Services and Applications node, and then
click Services.
You will see the MOM service listed. This is the service
running the agent. The Startup Type will be Automatic,
and the Log On As account will be Local System
Account.

4. Close the Computer Management console.



Exercise 2: Using MOM 2005 Operator Console
Introduction

In this exercise, you will use the MOM Operator Console to view the state of the Microsoft Exchange
environment. You will also use the MOM Operator Console to locate and classify an
Exchange Server 2007 alert.

Scenario

Now that you have deployed MOM 2005 and installed agents on all Exchange Server 2007 servers,
you want to use the MOM 2005 operator console to monitor the state of the servers and view any
generated alerts.

Install the Live Communications Server 2005 using the Live Communications Server Deployment
Tool

Summary Detailed Steps
e View the Exchange 1. Switch to MOMO1, and then switch to the MOM 2005
servers using Computers Administrator Console.
and Groups Views. 2. Click the Microsoft Operations Manager (MOMO01)
node.

3. In the right pane, click Start Operator Console.
Wait for the Operator Console to open.

4. In the Operator Console, in the left pane, click
Computers and Groups.

The view in the navigation pane will change to the
Computer and Groups Views.

5. In Computers and Groups Views, expand Microsoft
Exchange Server and then expand Exchange 2007.

6. Under Exchange 2007, expand Mailbox and click
Computers.

Notice how many Alerts in the right pane relate to the
SMBEXO01 server. This is the server with the Mailbox
server role installed.

7. Double-click any Critical Errors in the right pane to
obtain more information about the error.

8. Inthe Computer Details — EXEBO3 pane (at the bottom of
the screen), click the Computer Groups tab.

Notice how the EXEBO3 server has been automatically
added to the correct computer groups.

Leave the Operator Console running.
Leave the MOM Administrator Console running.

e Use the MOM 2005 1. Inthe Microsoft Operations Manager 2005 Operator
Operator Console Console, expand Microsoft Exchange Server and then
expand Exchange 2007.
2. Under Exchange 2007, click Alerts.

3. Scroll across the Alerts list to locate the last alert named



Create a new Alert

View for all Level 2:

Assigned Resolution
States

Outlook Web Access connectivity (Internal) transaction
failure.

Right-click the alert, click Alert Resolution State, and

then click Level 2: Assigned to subject matter expert.

In the MOM Operator Console, in the left pane, click

Alerts.

In Alert Views, right-click All:Alert Views, point to New,

. and then click Alerts View.

In the Which type of alert view do you want to create
box, scroll down and select Alerts that satisfy specified
criteria, and then click Next.

In the Which alerts do you want to view box, scroll down

and select the check box next to with specified resolution

state.

In the View description box, click the underlined word
specified.

In the Resolution State dialog box, select the check box
next to Level 2: Assigned to subject matter expert and
then click OK.

In the Alerts View dialog box, click Next.
In the View name text box, type Assigned to SMEs and

" then click Finish.

Notice how a new Alert View appears in the alert views list, and a
pane titled Assigned to SMEs shows the alert whose status you
changed status of earlier..



Exercise 3: Configuring Alert Notifications Using MOM 2005

Introduction

In this exercise, you will configure a group of operators to receive Exchange Server 2007-related
alerts via e-mail. You will then add Peter Houston as a member of the group and confirm that the
member receives the alert in an e-mail message.

Scenario

You are pleased with the new MOM 2005 deployment and its time-saving features. You now want to
configure MOM 2005 to send e-mail notifications when certain events occur.

Summary

e Configure a
Microsoft Exchange
Server 2007
connector to accept
mail from MOMOL.

e Configure the
Exchange Mailbox
Server
Administrators to
receive alerts

1.

2.

Detailed Steps

Switch to SMBEXO01 and log in as user Administrator,
with a password of P@sswOrd. Open the Exchange
Management Shell: click Start, and then click Exchange
Management Shell.

At the PS prompt, type the following and then press
ENTER:

New-ReceiveConnector -name "MOM SMTP
Receive' -AuthMechanism:External Authoritative
-Bindings:*'10.0.0.10:25"
-PermissionGroups:ExchangeServers
-RemotelPRanges:"'10.0.0.50""

Wait for the command to complete.

10.

11.

12.

On MOMO01, switch to the MOM 2005 Administrator
Console.

Expand the Microsoft Operations Manager (MOMO01)
node.

Expand the Administration node and then click Global
Settings.

In the right pane, double-click Email Server.

On the Email Server tab, in the Server name box, type
SMBEXO01.nwtraders.com

On the Email Server tab, in the Return Address box,
type administrator@nwtraders.com and then click OK.

In the left pane, expand Management Packs, expand
Notification, and then click Notification Groups.

In the right pane, double-click Exchange Mailbox Server
Administrators.

In the Notification Group Properties dialog box, click
New Operator.

In the Operator Properties - General dialog box, type
Peter Houston in the Name field and then click Next.

In the Operator Properties - Email dialog box, select the
Email this operator check box.

In the Email Address field, type peter@nwtraders.com
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e Generate an alert by
stopping the Mailbox
Assistant Service e.

e Review e-mail alerts.

e Restart the Mailbox
Assistant service

13.

14.

15.

and then click Next.

Ensure that the Page this operator check box is cleared,
and then click Next.

Ensure that the Notify this operator by external
command check box is cleared, and then click Finish.

In the Available Operators box, select Peter Houston,
and then click the left arrow (<) to move Peter Houston
into the Group Operators box. Click OK.

Switch to EXEBO3.

Click Start, click Run, type net stop
msexchangemailboxassistants and then click OK.

Wait for the Unified Messaging service to stop..

1.

Switch to SMBEXO01 and start Microsoft Internet
Explorer.

Open the Peter Houston mailbox by going to
https://smbex01.nwtraders.com/owa

When prompted to trust the certificate, click Yes.

If prompted to set the language and time zone, confirm
that both are correct, and then click Continue.

Type a user name of nwtraders\peter and a password of
P@sswOrd

Check for new messages from
administrator@nwtraders.com. If Peter Houston does
not have any messages from MOM, wait a few minutes,
and then press Send/Receive.

Switch to SMBEXO01 and start Microsoft Internet
Explorer.

Open the Peter Houston mailbox by going to
https://smbex01.nwtraders.com/owa

When prompted to trust the certificate, click Yes.

If prompted to set the language and time zone, confirm
that both are correct, and then click Continue.

Type a user name of nwtraders\peter and a password of
P@sswOrd

Check for new messages from
administrator@nwtraders.com. If Peter Houston does
not have any messages from MOM, wait a few minutes,
and then press Send/Receive.



Lab 1: Deploying and Configuring
Microsoft Office Communications
Server 2007

Objectives

Prerequisites

Scenario

Estimated time to
complete this lab: 60
minutes

After completing this lab, you will be able to:

= Prepare the Microsofte Active Directorye domain services for Microsoft
Office Communications Server 2007.

m Install, configure, and validate Office Communications Server 2007.

Note This lab focuses on the concepts in this module. As a result, it may not
comply with Microsoft security recommendations.

There are no prerequisites for this lab.

You are the administrator for Litware Inc., a small but growing retailer of
outdoor clothing. You plan to implement Office Communications Server 2007
to take advantage of its improved security features, its enhanced end-user
experience, and its powerful and easier-to-use administration tools.

Before you deploy Office Communications Server 2007, you must first prepare
the Active Directory. The instructions in this guide are specific to a deployment
of a Standard Edition Server in a single forest with a single domain
(Litwarelnc.com).

Tip For more information about Office Communications Server 2007,
please review the Office Communications Server 2007 Documentation
available for download at Microsoft.com
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Exercise 0

Lab Environment and Setup

£ Lab Environment Information

In these labs you will be using Microsoft Virtual PC 2007. The following is
important information and tips that will help you during these labs.

Virtual PC Server Information

1.

When a procedure in the lab refers to the host computer, this means that
you perform these steps on the physical computer that hosts the other
virtual computers.

You can have multiple instances of Virtual PC running. This enables you to
have all of the virtual machines running at the same time and in different
windows.

In a Virtual PC, to simulate pressing CTRL-ALT-DELETE in order to log
on or open Task Manager, press the DELETE key and the ALT key to the
right of the spacebar.

IZ On the host computer, start and log on to the DC1 Virtual PC.

1.

On the host computer, click Start>All Programs—>Microsoft Virtual
PC.

In the Virtual PC Console, turn on the DCL1 virtual PC by clicking DC1 and
then clicking the Start button.

A new DC1 virtual PC console opens. At the logon screen, press and hold
the right ALT key and then press DELETE.

Log on to the Litwarelnc domain as Administrator with a password of
pass@wordl.

Important Click OK to any prompts regarding any services that fail to start,
and then review Services to verify that all have started successfully.

IZ On the host computer, start and log on to the OCS-Std Virtual PC

1.

On the host computer, in the Virtual PC Console, turn on the OCS-Std
virtual PC by clicking OCS-Std and then clicking the Start button.

A new OCS-Std Virtual PC console opens. At the logon screen, press and
hold the right ALT key, and then press DELETE.

Log on to the Litwarelnc domain as Administrator with a password of
pass@word1.

Important Click OK to any prompts regarding any services that fail to start,
and then review Services to verify that all have started successfully.
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Introduction

Exercise 1
Preparing the Active Directory Forest, and Domain

Before installing Office Communications Server 2007 (OCS 2007), the Active
Directory directory service needs to be prepared. In this exercise, you will
prepare the forest and domain from the Office Communications Server 2007
server. This will add the necessary schema changes to Litwarelnc.com.

Tip For more information about preparing active directory, please review
the Office Communications Server 2007 Active Directory Guide included
with the OCS 2007 documentation available for download at Microsoft.com

IZ On OCS-Std, prepare the Active Directory forest

1. On the OCS-Std virtual PC, click Start=> All Programs—> Accessories>
Windows Explorer.

Navigate to C:\OCS 2007\Setup\I1386 and then double-click Setup.exe.
On the Deployment Wizard page, click Deploy Standard Edition Server.

On the Deploy Standard Edition Server page, next to Step 1, click Prepare
Active Directory.

5. On the Prepare Active Directory for Office Communications Server page,
next to Step 1: Prep Schema, click Run.

On the Welcome page, click Next.

On the Directory Location of Schema Files page, verify Default is selected
and click Next.

On the Ready to Prepare Schema page, click Next.
On the Completion page, click Finish.

£ On OCS-Std, prepare the Active Directory forest

1. On OCS-Std, on the Prepare Active Directory for Office Communications
Server page, next to Step 3: Prep Forest, click Run.

On the Welcome page, click Next.
On the Select Location to Store Global Settings page, click Next.

On the Location of Universal Groups page, verify that Litwarelnc.com is
selected in the Domain drop-down list, and then click Next.

5. On the SIP domain used for default routing page, verify that
Litwarelnc.com is selected in the Select SIP domain drop-down list, and
then click Next.

6. On the Ready to Prepare Forest page, click Next.
7. On the Completion page, click Finish.

£ On OCS-Std, prepare the Active Directory domain
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1. On OCS-Std, on the Prepare Active Directory for Office Communications
Server page, next to Step 5: Prep Current Domain, click Run.

On the Welcome page, click Next.

On the Domain Preparation Information page, click Next.
On the Ready to Prepare Domain page, click Next.

On the Completion page, click Finish.

o oA WD

On the Prepare Active Directory for Office Communications Server page,
click Back.

Notice that Step 1: Prepare Active Directory now says Complete.
Leave the Deployment Wizard running.
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Exercise 2

Installing Office Communications Server 2007

Introduction

In this exercise, you will install Office Communications Server 2007 and then
perform the necessary configurations changes, as well as assign certificates.
Certificates are a key built-in component to OCS 2007. You will then start the
services and validate the installation. Finally, you will force a synchronization
of the Address Book Server database, configure Internet Information Services
(11S) and create the necessary Domain Name System (DNS) records.

Tip For more information about planning and deploying Office
Communications Server 2007, please review the Office Communications
Server 2007 Planning Guide and the Standard and Enterprise Edition
Deployment Guides included with the OCS 2007 documentation available
for download at Microsoft.com

£ On OCS-Std, install Office Communications Server 2007

1.

On the OCS-Std virtual PC, on the Deploy Standard Edition Server page,
next to Step 2: Deploy Server, click Run.

Note 1IS needs to be installed before you can perform step 2. This
prerequisite has already been installed.

On the welcome page, click Next.

On the License Agreement page, click I accept the terms in the license
agreement, and then click Next.

4. On the Location for Server files page, accept the default and click Next.

5. On the Main Service Account for Standard Edition Server page, type

9.

pass@wordl in the Password and Confirm Password text fields, and then
click Next.

On the Component Service Account for this Standard Edition Server page,
type pass@word1 in the Password and Confirm Password text fields, and
then click Next.

On the Web Farm FQDNs page, leave the External web farm FQDN
(optional) field blank and then click Next.

On the Location for Database Files page, accept the default location and
click Next.

On the Ready to Deploy Server page, click Next.

10. On the Completion page, click Finish.

£ On OCS-Std, configure Office Communications Server 2007

1.

2.

On OCS-Std, on the Deploy Standard Edition server page, next to Step 3:
Configure Server, click Run.

On the welcome page, click Next.
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3. On the Server or Pool to Configure page, verify that OCS-
Std.Litwarelnc.com is selected, and then click Next.

4. On the SIP domains page, verify that Litwarelnc.com has already been
added to the list, and then click Next.

5. On the Client Logon Settings page, verify that both Some or all clients will
use DNS SRV records for automatic logon and Use this server or pool
to authenticate and redirect automatic client logon requests are
selected, and then click Next.

6. On the SIP Domains for Automatic Logon page, click the Litwarelnc.com
check box, and then click Next.

7. On the External User Access Configuration page, confirm Do not
configure for external user access now is selected, and then click Next.

On the Ready to Configure Server or Pool page, click Next.

w

On the completion page, click Finish.

£ On OCS-Std, configure certificates

1. On OCS-Std, on the Deploy Standard Edition server page, next to Step 4:
Configure Certificate, click Run.

2. On the Welcome page, click Next.

3. Onthe Available Certificate Tasks page, verify that Create a new
certificate is selected, and then click Next.

4. On the Delayed or Immediate Request page, verify that Send the request
immediately to an online certification authority is selected, and then
click Next.

5. On the Name and Security Settings page, in the Name box, verify that
OCS-Std is entered as the name for the new certificate.

Clear the Mark cert as exportable check box, and then click Next.

On the Organization Information page, in the Organization text box, type
Litware Inc and then in the Organizational unit text box, type IT and
then click Next.

8. On the Your Server’s Subject Name page, in the Subject name text box,
verify that OCS-Std.Litwarelnc.com is selected.

9. Verify that sip.Litwarelnc.com is selected as the Subject Alternate
Name, and then click Next.

10. On the Geographical Information page, in the State/Province text box,
type Washington

11. In the City/Locality text box, type Redmond and then click Next.

12. On the Choose a Certification Authority page, in the Certification
Authorities box, verify that DC1.litwarelnc.com\LitwarelncCA is
selected and then click Next.

13. On the Request Summary page, verify the settings and then click Next.
14. On the completion page, click Assign.

15. In the Communications Certificate Wizard prompt, click OK.

16. On the completion page, click Finish.

17. Leave the Deploy Standard Edition Server page open.
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IZ On OCS-Std, configure 11S to use the new certificate

1. On OCS-Std, click Start=> Administrative Tools=> Internet Information
Services (11S) Manager.

2. In Internet Information Services (11S) Manager, expand OCS-Std, expand
Web Sites, right-click Default Web Site, and then click Properties.

3. In Default Web Site Properties, on the Directory Security tab, click
Server Certificate.

On the welcome page, click Next.

On the Server Certificate page, click Assign an existing certificate and
then click Next.

6. On the Available Certificates page, scroll to the right to view the Friendly
Name of the certificates in the list, click the OCS-Std certificate, and then
click Next.

7. Onthe SSL Port page, click Next.

8. On the Certificate Summary page, click Next.

9. On the Completion page, click Finish.

10. In Default Web Site Properties, click OK.

11. Close Internet Information Services (11S) Manager.

£ On OCS-Std, start services

1. On OCS-Std, switch back to the Deploy Standard Edition server page, next
to Step 7: Start Services, click Run.

On the Welcome page, click Next.

On the Start Office Communications Server 2007 Services page, click
Next.

4. On the completion page, click Finish.

£ On OCS-Std, synchronize the Address Book Server

1. On OCS-Std, click Start> All Programs—> Accessories> Command
Prompt.

At the command prompt, type cd \ and then press ENTER

At the command prompt, type cd “c:\Program Files\Microsoft Office
Communications Server 2007\Server\Core” and then press ENTER.

4. At the command prompt, type abserver.exe —syncnow and press ENTER.

This will force a synchronization of the Address Book Server database
immediately for the purposes of this lab. You would not normally have to run
this command in your environment.

5. When the command has completed, close the command window.

£ On OCS-Std, validate server functionality

1. On OCS-Std, switch to the Deployment Wizard and next to Step 8: click
Validate Server Functionality.
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10.
11.

12.

13.

14.

15.

16.

K
1.
2.

On the Validate Pool or Server Functionality page, next to Step 1: Validate
Front End Server Configuration, click Run.

On the Welcome page, click Next.

On the Validation steps page, select the VValidate Local Server
Configuration and Validate Connectivity check boxes.

Clear the Validate SIP Logon (1-Party) and IM (2-Party) and Validate
IM Conference (2-Party) check boxes, and then click Next. We have
unchecked these boxes because we haven’t enabled any users for OCS yet
and have not configured Conferencing, which will be done in later labs.

On the completion page, notice that the wizard completed with warnings
and that the View the log when you click ‘Finish’ check box is already
selected. Click Finish.

Switch to the Deployment Log that has opened and in the upper-right
corner of the Deployment Log, click Expand All.

In the Action Information column, notice that Check Global Federation
Settings results in a warning that Federation is disabled and that Check
Global Phone Usages results in another warning that one or more phone
usages are not assigned to any route or VVolP policy. These warnings are
expected because neither of these items has been configured.

In the Execution Result column, verify that the remaining tasks’ results are
Success. Close the Deployment Log window.

Switch back to the Validate Pool or Server Functionality wizard.

Next to Step 2: Validate Web Components Server Functionality, click
Run.

On the Welcome page, click Next.

On the Validation steps page, verify that the Validate Local Server
Configuration and Validate Connectivity check boxes are checked and
then click Next.

On the completion page, notice that the wizard completed successfully.
Click Finish.

Repeat steps 10-14 for validating the Web Conferencing Server
Functionality and the Audio/Video Conferencing Server Functionality.

When you are finished with these wizards, click Exit to close the
Deployment Wizard.

On DC1, configure DNS for Office Communications Server 2007
Switch to DC1 and then click Start=> Administrative Tools=> DNS.

Expand DC1, expand Forward Lookup Zones, and then click
Litwarelnc.com.

3. Right-click Litwarelnc.com and then click Other New Records.

4. In Select a resource record type, click Service Location (SRV) and then

click Create Record.

In the Service text field, type _sipinternaltls (be sure to include the
underscore character at the beginning).

In the Protocol text field, verify that _tcp is already entered.
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In the Port Number text field, type 5061

. In the Host offering this service text field, type OCS-Std.Litwarelnc.com
and then click OK.

9. Click Done.
10. Close the DNS console.



Lab 2: Enabling Users and Installing
Office Communicator 2007

Objectives After completing this lab, you will be able to:

Enable and configure users for Office Communications Server 2007.
Install Microsofte Office Communicator 2007.
Configure Office Communicator 2007.

Describe the Presence Grouping Feature of Office Communications Server
2007.

Use Office Communicator 2007.

Note This lab focuses on the concepts in this module. As a result, it may not
comply with Microsoft security recommendations.

Prerequisites Before working on this lab, you must have completed the previous lab. If you
have not completed the previous labs, this lab will fail.

Scenario Now that you have installed Office Communications Server 2007 in your
environment, you want to deploy Office Communicator 2007 to your clients.
You will now install Office Communicator 2007, configure the clients, add
contacts, and test connectivity.

Estimated time to
complete this lab: 60
minutes
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Exercise 0
Lab Setup

To complete this lab, you will need to use the DC1 and OCS-Std Virtual PCs
from the previous lab.
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Exercise 1

Enabling and Configuring Users for Office Communications Server

2007

Introduction

In this exercise we will enable users for Office Communications Server 2007.
We will demonstrate using Active Directory Users and Computers and then use
the Office Communications server Administrative Tools console.

£ On OCS-Std, enable users for Office Communications Server 2007

using Microsoft Active Directorye Users and Computers

1. On OCS-Std, click Start, and then click Run.
. To open Active Directory Users and Computers, in the Run dialog box,

type dsa.msc and then click OK.

Tip Inyour environment, if you have installed OCS on a 64-bit server,
OCS will run in WOW32 emulation. To use Active Directory Users and
Computers (ADUC) on a 64-bit server on which you have installed OCS
2007 or the OCS 2007 Administrative Tools, you will need to open ADUC
by typing mmc -32 dsa.msc from a run command.

. In Active Directory Users and Computers, in the left pane, expand

Litwarelnc.com, expand OUs, expand Users, right-click Information
Technology, and then click Enable users for Communications Server.

Tip You can only enable and configure users for communications using
Active Directory Users and Computers from your OCS installation or from
a computer that has the OCS Administrative Tools installed.

4. On the welcome page, click Next.
5. On the Select a Pool page, verify that OCS-Std.Litwarelnc.com is selected

in the drop-down list, and then click Next.
This associates these users with our OCS-Std OCS pool.

. On the Specify Sign-in Name page, verify that Use user’s email address is

selected, and then click Next.

7. On the Enable Operation Status page, click Finish.
. Close Active Directory Users and Computers.

Tip For more information about OCS Administration, please review the
Office Communications Server 2007 Administration Guide included with
the OCS 2007 documentation available for download at Microsoft.com

£ On OCS-Std, configure users using Office Communications Server 2007

Administrative Tool

1. On OCS-Std, click Start=> Administrative Tools=> Office

Communications Server 2007.
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2. In the Administrative Tools console, expand Forest — Litwarelnc.com,
expand Standard Edition Servers, expand OCS-Std, and then click Users.

Notice that all of the users from the Information Technology OU that you
enabled in the previous procedure show up here. Users will not show up
here until they have been enabled using Active Directory Users and
Computers.

3. Right-click Users and then click Configure users.
4. On the welcome page, click Next.

5. On the Configure Users Settings page, select the Federation, Public IM
Connectivity, Remote User Access, and Enhanced Presence check boxes,
and then click Next four times as we are only enabling IM at this time. We
will configure Meeting and Voice policies in later labs.

6. On the Configure Operations Status page, click Finish.
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Exercise 2

Installing and Starting Office Communicator 2007

Introduction

You will now install Office Communicator 2007 on the host computer. Then
you will start Communicator for Vivian Atlas.

£ On the host computer, install Office Communicator 2007

1. On the host computer, click Start-> All Programs—-> Accessories—>
Windows Explorer and navigate to \\ocs-std.Litwarelnc.com\c$\OCS
2007.

2. At the Connect to ocs-std login window, type Litwarelnc\administrator
for the user name and pass@word1 for the password, and then click OK.

3. Double-click Communicator.msi.

4. If you get an Open File-Security Warning, click Run.

5. On the Welcome page, click Next.

6. On the End-User License Agreement page, review the license agreement,
select | accept the terms in the License Agreement, and then click Next.

7. On the Configure Microsoft Office Communicator 2007 page, click Next.

8. On the Completion page, click Finish.
9. Close Windows Explorer.

IZ On the host computer, start Microsoft Office Outlooke 2007 and
Communicator 2007

1. On the host computer, click Start> All Programs—> Microsoft Office>
Microsoft Office Outlook 2007.

Please verify that you have configured an Outlook profile for Vivian Atlas
on the host computer and installed the LitwarelncCA certificate as a trusted
root certification authority, as instructed in the Setup Guide.

2. At the Connect to DC1.Litwarelnc.com sign-in page, verify
va@litwareinc.com shows in the Username field, type pass@word1l in
the Password field, and then click OK.

Minimize Outlook and leave it running.
Click Start> All Programs—> Microsoft Office Communicator 2007.
Double-click the Communicator icon in the system tray.

© g &~ w

In the Sign-in address text box, type va@Litwarelnc.com and then click
Sign In.

7. On the Welcome to Microsoft Office Communicator 2007 sign-in page,
leave va@L.itwarelnc.com in the Sign-in address field, in the User Name
field type va@L.itwarelnc.com and in the Password field type
pass@word1l, and then click Sign In.

8. Close the Internet Explorer window that opens.
Leave Microsoft Office Communicator 2007 running.


mailto:va@litwareinc.com
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Exercise 3

Using Office Communicator 2007

Introduction

In this exercise, you will add Kevin Cook as a contact and start Office
Communicator 2007 on DC1. You will then have a short messaging session and
examine Kevin Cook’s contact card. Then you will change the level of access
and re-examine Kevin’s contact card. You will then start an audio call between
Vivian Atlas and Kevin Cook, and then elevate it to a video call.

£ On the host computer, add contacts in Office Communicator 2007

1. On the host computer, in Office Communicator 2007, type Kevin Cook in
the Type a name box. Notice that Kevin Cook’s name is resolved from the
Address Book and shows as offline.

Tip If Kevin Cook’s name is not resolved, exit completely out of
Communicator. Re-synchronize the Address Book Server using the
abserver.exe-syncnow procedure from Lab 1, Exercise 2, page 7. Perform a
search on the host computer for GalContacts.DB and delete the entry found
in your local profile. Wait five minutes, restart Communicator, and try this
again.

2. Click on his name in the search results and drag and drop his name down to
All Contacts. You can also right-click his name and then click Add to
Contact List.

£ On DC1, start Office Outlook 2007 and Communicator 2007 and send
an Instant Message

1. Switch to the DC1 virtual PC, and then click Start> Log Off.
2. Atthe Log Off Windows prompt, click Log Off.

3. Atthe log in screen, press and hold the right ALT key, and then press
DELETE.

4. Log on to the Litwarelnc domain as kc with a password of pass@word1

5. Click Start=> All Programs—> Microsoft Office> Microsoft Office
Outlook 2007.

Kevin’s profile is already configured on this virtual computer.

6. If you get a Connect to DC1.Litwarelnc.com login prompt, type
pass@word1 as the password and click OK.

7. Minimize Outlook and leave it running.
8. Click Start-> All Programs-> Microsoft Office Communicator 2007.
Notice the Communicator icon on the system tray signing in.

Wait as Office Communicator 2007 signs in as Kevin is automatically
signed in using his domain credentials.

9. Close the Internet Explorer window that opens.
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10. On the Communicator dialog box, click OK to add Vivian Atlas as a
contact.

11.0n DC1, double-click the Communicator icon on the system tray to expand
Office Communicator 2007.

12. If you get a Commiunicator-Services Sign In page, in the User Name field
type kc@Litwarelnc.com, in the Password field type pass@word1l and
then click OK.

13. In Office Communicator 2007, right-click Vivian Atlas, and then click
Send an Instant Message.

14. In the Vivian Atlas - Conversation window, type Sorry | missed our
meeting this morning and then press ENTER.

IZ On the host computer, reply to the message

1. On the host computer, on the Taskbar, click the Kevin Cook prompt to start
an instant messaging session with Kevin, and then read the message.

2. In Office Communicator 2007, type That is OK, let’s configure
conferencing instead and then press ENTER.

IZ On DC1, participate in the messaging session
1. On DCl1, in Office Communicator 2007, type Sounds good
2. Close the Vivian Atlas — Conversation window.

Leave Office Communicator 2007 running.

IZ On the host computer, close the conversation
1. On the host computer, close the Kevin Cook— Conversation window.

2. On the Microsoft Office Communicator 2007 dialog box, click Yes to close
the window without saving the conversation if prompted.

Leave Office Communicator 2007 running.

K onDC1, configure Kevin Cook’s telephone information

Note Office Communicator enables the user to publish personal
information such as phone numbers, so that other people can easily view
this information from within Communicator, depending on the level of rich-
presence access.

1. In Office Communicator 2007 on DC1, click the drop-down arrowl? in the
upper left corner, click Tools, and then click Options.

2. In Options, click the Phones tab.
3. Next to the work phone number, select Publish this phone number.

4. On the Microsoft Office Communicator 2007 prompt regarding publishing
your phone numbers, check the Don’t show this message again check box,
and then click OK.
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Click Mobile Phone.

In the Edit Phone Number dialog box, type +12535550258 and then click
OK.

Next to the mobile phone number, select Publish this phone number.

8. Click Home Phone.
9. Inthe Edit Phone Number dialog box, type +12065551236 and then click

OK.

10. Next to the home phone number, select Publish this phone number.
11. In Options, click OK.

£ On the host computer, examine Kevin Cook’s contact card

1.

On the host computer, in Office Communicator 2007, under All Contacts,
click the green circle next to Kevin Cook to display his contact card.

Notice that Communicator has pulled calendar availability from Kevin’s
Calendar, as well as his title and office number, as defined in Active
Directory.

In the contact card that opens for Kevin, click the drop-down arrow next to
the phone “® ™ button.

Notice that you cannot see any of Kevin’s phone numbers, that you are able
to make a call only using Communicator. This is because the default level of
access is set to Company.

Close Kevin Cook’s contact card by clicking the X in the upper-right corner
of the contact card.

Leave Microsoft Office Communicator 2007 running.

IZ On DC1, change the Level of Access for Vivian Atlas

1.

On DC1, in Office Communicator 2007, under All Contacts, right-click
Vivian Atlas, and then click Change Level of Access.

Review the different access levels, and then click Personal.
Leave Office Communicator 2007 running.

£ On the host computer, reexamine Kevin Cook’s contact card

1.

On the host computer, in Office Communicator 2007, under All Contacts,
click the green circle next to Kevin Cook to display his contact card.

In the contact card that opens for Kevin, click the drop-down arrow next to
the phone ® “button.
Notice that you can now see Kevin’s Mobile and Home phone numbers.

Note Changing the Level of Access is an easy and convenient way to share
different levels of information with different people.

Close Kevin’s contact card by clicking the X in the upper right corner of the
contact card.



Lab 2: Enabling Users and Installing Office Communicator 2007 9

Leave Office Communicator 2007 running.

IZ On the host computer, start an audio call

e On the host computer, in Communicator, click the call button @ 7 next to
Kevin Cook’s name.

IZ on DC1, join the audio call
1. On DC1, click the Answer call prompt to accept the call from Vivian Atlas.

2. Inthe Vivian Atlas Conversation window, click the microphone 2. putton
on the toolbar to mute Kevin’s microphone. This will help prevent any

feedback.

£ On DC1, elevate an audio call to a video call

e On DC1, in the Vivian Atlas — Conversation window, click the webcam
icon to elevate the conversation to a video call.

IZ On the host computer, accept the video call

1. On the host computer, in the Kevin Cook — Conversation window, click
Answer incoming video call.

2. Experience the video call feature, and then close the conversation window
to end the call.

3. On the Microsoft Office Communicator 2007 prompt, click OK to end the
call.

4. Leave Communicator running.

£ On DC1, end the current call.
1. On DC1, close the Vivian Atlas — Conversation window.

2. Leave Communicator running.

£ Explore Communicator and Outlook (Optional)
1. On the host computer, here are some other features that you can explore.
e Can you find the Conversation History folder in Outlook?

¢ In Communicator, at the top, click Type a note and type I am in the
office all day today. What does Kevin see on his Communicator when
you hold your mouse over the note icon next to Vivian Atlas’ name?

e Manually change Kevin’s Current Location to Home. After you have
done this, examine his contact card again from Vivian’s Communicator.

e Tag Kevin Cook for Status Change Alerts. Change his status from
Available to Offline and back, and then review the alerts on the host
computer.
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2. When you are finished, exit out of Communicator and close Outlook on the
host computer and on DCL1.



Lab 3: Configuring and Using
Conferencing in Microsoft
Office Communications Server 2007

Objectives After completing this lab, you will be able to:

= Install and configure Microsofte Office Live Meeting 2007 and
Live Meeting 2007 Add-ins.

m Schedule and attend Office Live Meetings.

m Start and attend ad-hoc Office Live Meetings using Office Communicator
2007 and the Meet Now option of the Live Meeting Console.

Note This lab focuses on the concepts in this module. As a result, it may not
comply with Microsoft security recommendations.

Prerequisites Before working on this lab, you must have completed the previous lab. If you
have not completed the previous lab, this lab will fail.

Scenario To further improve employee productivity and to decrease travel costs, Litware
Inc. wants to install Office Live Meeting 2007 and it’s Office Add-ins to
facilitate conferencing using Office Communications Server 2007’s on-premise
conferencing capabilities.

Estimated time to
complete this lab: 60
minutes
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Exercise 0
Lab Setup

=  To complete this lab, you will need to use the DCland OCS-Std Virtual
PCs from the previous labs.
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Exercise 1

Installing and Configuring Live Meeting 2007 and Office Add-Ins

Introduction

In this exercise, you will perform the necessary policy changes in

Office Communications Server 2007 to allow Web conferencing. You will then
install Microsoft Office Live Meeting 2007 and the Microsoft Office Outlooke
Add-in on the host computer and configure the add-in on the host computer and
the DC1 virtual PC.

Important Verify that Microsoft Office Outlook and Communicator are not
running on the host computer and on DC1.

K

On OCS-Std, configure Office Communications Server 2007 Meeting
Policy

On OCS-Std, click Start > Administrative Tools = Office
Communications Server 2007.

In the Microsoft Office Communications Server 2007 console, right-click
Forest — Litwarelnc.com, point to Properties, and then click Global
Properties.

3. Click the Meetings tab.

In the Anonymous participants drop-down list, select Allow users to
invite anonymous participants.

This will permit anonymous participants to join Litware Inc. Live Meetings.

Under Policy Settings, in the Global policy drop-down list, select Policy 1
(High) and then click Apply.

This will enable users for conferencing using Policy 1 settings.
Under Policy Definition, select Policy 1 (High) and then click Edit.

On the Edit Policy page, notice all of the settings that can be configured and
then click Cancel.

Note In your company’s environment, you should evaluate each predefined
policy and select the policy that best matches your requirements, or you
should add a new policy and select the necessary settings.

8. On the Office Communications Server Global Properties page, click OK.

9. Expand Forest — Litwarelnc.com, expand Standard Edition Servers,

10.

11.

expand OCS-Std, and then click OCS-Std.Litwarelnc.com.

Right-click OCS-Std.Litwarelnc.com, point to Stop, point to Front End
Services, and then click Front End Service.

This will force the immediate enforcement of the policies we just
configured.

After the Front End Service has stopped, right-click OCS-
Std.Litwarelnc.com, point to Start, and then click Start all stopped
Services.
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12. Close the console.

IZ On the host computer, install Microsoft Office Live Meeting 2007.

1. On the host computer, click Start=> All Programs—> Accessories>
Windows Explorer and navigate to C:\VPC\Extras\Addins.

2. Double-click LMSetup.exe.
Wait as Microsoft Office Live Meeting 2007 is installed and finishes.

IZ On the host computer, install the Live Meeting 2007 Office Outlook
Add-in

1. On the host computer, in C:\VPC\Extras\Addins, double-click
ConfAddins_Setup.exe.

2. On the Microsoft Conferencing Add-in for Microsoft Office Outlook page,
click Next.

3. On the Installation Complete page, click Close.
Close Windows Explorer.

IZ On the host computer, configure the Outlook add-in
1. On the host computer, click Start and then click Microsoft Office Outlook.

2. At the Microsoft Office Live Meeting prompt, click OK to acknowledge
that the Microsoft Office Live Meeting Add-in for Outlook was
successfully installed, and then restart Outlook.

3. On the Conferencing drop-down menu, click User Accounts.

4. Inthe User Accounts window, verify that va@ Litwarelnc.com is entered
for the Sign-in name, and then click Advanced.

5. In the Advanced Connections Settings window, select the Use the following
user name and password check box.

6. Verify that va@Litwarelnc.com is entered for the user name, type
pass@word1l for the Password, and then click OK.

7. Inthe User Accounts window, click Test Connection.

8. Inthe Microsoft Office Live Meeting dialog box, notice that the login
information was successfully verified, and then click OK.

9. In the User Accounts window, click OK.
10. Leave Outlook running.

£ on DC1, configure the Outlook add-in
1. On DC], click Start and then click E-mail Microsoft Office Outlook.
Please verify you are logged on to DC1 as Kevin Cook.

Note The Live Meeting Console and Add-in have already been installed on
DCL. If the add-in does not show, restart Outlook.

2. On the Conferencing drop-down menu, click User Accounts.
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3. Inthe User Accounts window, verify that kc@Litwarelnc.com is entered
for the Sign-in name, and then click Advanced.

4. Inthe Advanced Connections Settings window, select the Use the following
user name and password check box.

5. Verify that kc@Litwarelnc.com is entered for the user name, type
pass@word1 for the Password, and then click OK.

In the User Accounts window, click Test Connection.
In the Microsoft Office Live Meeting dialog box, click OK.
In the User Accounts window, click OK.

© © N o>

Leave Outlook running.
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Exercise 2
Scheduling and Attending an Office Live Meeting

Introduction You will now schedule an on-premise Live Meeting using Microsoft Office
Outlook 2007 and attend the meeting. You will then use some of the features of
Live Meeting, including showing a Microsoft PowerPointe presentation, using
voice and video and desktop sharing.

IZ From the host computer, schedule a Live Meeting
1. Switch to Office Outlook 2007 on the host computer.

2. In Office Outlook 2007, on the Conferencing toolbar, click Schedule a
Live Meeting.

3. Inthe Untitled-Live Meeting Request window, in the To field, type Kevin
Cook and then press CTRL-K to resolve the address.

4. Inthe Subject field, type Weekly Project Review

5. For the Start time, change the start time to be 5 minutes from the current
time.

6. In the message body, type Review project goals and milestones and then
click Send.

7. At the Conferencing prompt, read the warning and click OK.

8. You will immediately receive a Weekly Project Review reminder, leave it
open.

Leave Office Outlook 2007 running.

IZ On DC1, view the scheduled meeting request
1. Switch to Office Outlook 2007 on DCL1.

2. In Office Outlook 2007, double-click the Weekly Project Review request
sent by Vivian. You may have to click Send/Receive a couple of times.

3. In the Weekly Project Review — Meeting window, click Accept.

4. In the Microsoft Office Outlook dialog box, verify that Send the response
now is selected and then click OK.

In the Weekly Project Review reminder, click Open Item. Leave Office
Outlook 2007 running.

IZ On the host computer, join the Live Meeting

1. On the host computer, in Office Outlook 2007, in the Weekly Project
Review reminder, click Open Item.

2. Intoday’s schedule, locate and double-click the Weekly Project Review
Live Meeting Request.

3. In the message body of the Weekly Project Review request, click Join the
meeting.

Wait for Microsoft Office Live Meeting to open.
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IZ On DC1, join the Live Meeting

1.

On DC1, in Office Outlook 2007, in the Weekly Project Review request,
click the Join the meeting link.

Wait for Microsoft Office Live Meeting to open.

I£ On the host computer, show a PowerPoint presentation in Live Meeting

1.

On the host computer, in the Microsoft Office Live Meeting-Weekly Project
Review window, click Content->Share-> Upload File(View Only)

In the Choose a document to share window, navigate to
C:\VPC\Extras\Docs and click Live Meeting 2007 Client
Presentation.pptx, and then click Open.

Watch as the file is converted for Live Meeting and then displayed.
Minimize the Manage Content window.

¥+

Click the up and down arrows in the bottom-left corner to move

between the slides.
Watch as the slides are displayed on DC1.

6. On the host computer, click the Content drop-down menu, right-click Live

Meeting 2007 Client Presentation.pptx, and then click Remove.
At the Confirm Delete prompt, click OK.

IZ On the host computer, start Voice & Video

1.

In the Live Meeting console on the host computer, on the toolbar, click the

Enable video button D .

Experience the video capabilities of Office Live Meeting. When finished,
click the X in the upper-right corner of the Voice & Video window on the
host computer and on DCL1.

IZ On the host computer, share the desktop using Live Meeting (Optional)

1.

On the host computer, in the Microsoft Office Live Meeting-Weekly Project
Review window, click Content-> Share-> Share Your Desktop—>
Selected Areas.

Drag and drop the Sharing Frame around the host computer’s desktop.

On DC1, in the Microsoft Office Live Meeting-Weekly Project Review
window, notice that you can now view the selected areas of Vivian’s
desktop.

On the host computer, click the End sharing button A at the top of the
screen to return to the Meeting Console.

Click the Content drop-down menu, right-click The Sharing Frame —
Vivian Atlas and then click Remove.

At the Confirm Delete prompt, click OK.

£ Close unneeded windows
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1. Close the Live Meeting console running on both computers.

2. On the host computer, close all windows except the Virtual PC consoles and
Outlook 2007.

3. On DC1, close all windows except Office Outlook 2007.
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Exercise 3

Starting and Attending an On-Premise Live Meeting

Introduction

In this exercise, you will start and attend an on-premise Live Meeting session
by using the Meet Now feature of Office Communicator 2007. You will also
start a Live Meeting by using the Meet Now option of the Microsoft Office
Live Meeting 2007 console.

£ On the host computer, start Communicator

1.

On the host computer, Click Start=> All Programs—> Microsoft Office
Communicator 2007.

Double-click the Communicator icon in the system tray.

In the Sign-in address text box, type va@Litwarelnc.com and then click
Sign In.

On the Welcome to Microsoft Office Communicator 2007 sign-in page,
leave va@L.itwarelnc.com in the Sign-in address field, in the User Name
field type va@Litwarelnc.com and in the Password field type
pass@wordl, and then click Sign In.

If Vivian’s status shows that she is in a meeting, reset it to Available.
Leave Communicator running.

£ On the DC1, start an IM conversation

1.

On DC1, click Start=> All Programs—> Microsoft Office Communicator
2007. Wait for Communicator to log in.

2. If Kevin’s status shows that he is in a meeting, reset it to Available.

3. In Office Communicator 2007, right-click Vivian Atlas and click Send an

Instant Message.

In the Vivian Atlas-Conversation window, type | want to tell you some
good news and then press ENTER.

IZ On the host computer, join the conversation and escalate it to an ad-hoc

Live Meeting

On the host computer, click the Kevin Cook — Conversation prompt to
accept the incoming message.

In the Kevin Cook —Conversation window, type But I need to show you
something and then press ENTER.

Click the drop-down arrow in the upper-right corner of the conversation
window, and then click Share Information Using Live Meeting.

Wait as the Live Meeting console opens.

IZ On DC1, join the Live Meeting
1. On DC1, in the conversation window, click Start (Alt-G) to join the Live

Meeting.
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2.

Wait for Microsoft Office Live Meeting to open and notice that you are
again able to share your desktop, share video and documents, and so on.

Close the Live Meeting window.

IZ On the host computer, start a Meet Now Live Meeting

1.

On the host computer, click Start> All Programs—> Microsoft Office
Live Meeting 2007 - Microsoft Office Live Meeting 2007.

In Microsoft Office Live Meeting, click Meet Now.

3. In the Live Conference, click Attendees> Invite> By E-mail.

In the Live Conference — Message, in the To field, type Kevin and then
press CTRL-K to resolve his address.

Click Send.

£ On DC1, join the Live Meeting

1.
2.
3.

On DClin Office Outlook 2007, in the left column, click Mail.
In the Inbox, double-click the Meet Now request.

In the message body of the Live Conference request, click the Join the
meeting link.

Wait for Microsoft Office Live Meeting to open and notice that you are
again able to share your desktop, share video and documents, and so on.

Close the Live Meeting window, exit completely out of Outlook and
Communicator.

IZ On the host computer, close all windows

On the host computer, close all windows except the Virtual PC consoles,
and exit completely out of Outlook and Communicator.



Lab 4: Using the Management and
Troubleshooting Tools in Office
Communications Server 2007

Objectives After completing this lab, you will be able to:

m Use the built-in administration tools to troubleshoot Microsofte Office
Communications Server 2007.

= Install the Resource Kit tools.

m  Use the Office Communications Server 2007 Logging Tool to review and
analyze logs.

m Use the Validation wizard to validate and verify your environment.

Note This lab focuses on the concepts in this module. As a result, it may not
comply with Microsoft security recommendations.

Prerequisites Before working on this lab, you must have completed the previous labs.. If you
have not completed the previous labs, this lab will fail.

Scenario New tools are available to help Administrators apply best practices and
troubleshoot their Office Communications Server 2007 environment. The built-
in Validation Wizard will review your Office Communications Server 2007
configuration, pinpoint any incorrect settings, and determine any failure points.
Improved error reporting and event logging help administrators resolve
common issues, and the Resource Kit contains powerful tools to allow
administrators to troubleshoot any issues quickly.

Estimated time to
complete this lab: 60
minutes
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Exercise 0
Lab Setup

To complete this lab, you will need to use the DC1 and OCS-Std Virtual PCs
from the previous labs.
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Exercise 1

Troubleshooting Missing or Incorrect DNS SRV Records

Introduction

Missing or incorrect DNS records are one of the most common troubleshooting
issues administrators will encounter managing Office Communications Server

2007. First, you will delete the current DNS record for simulation purposes.

You will then see how the improved error reporting and event logging in Office

Communicator 2007 and Office Communications Server 2007 help
administrators troubleshoot.

£ On DC1, delete the current SRV record

Note This first procedure is done to simulate a missing or incorrect DNS
record only.

1. On DC], click Start=> Administrative Tools=> DNS.

2. Expand DC1, expand Forward Lookup Zones, expand Litwarelnc.com,

and then click _tcp.
3. Right-click the _sipinternaltls SRV record, and click Delete.

This is a key service locator record used by the client and OCS servers.
4. Click Yes on the DNS prompt to confirm deletion.

Leave the DNS console running.

IZ On the host computer, use Office Communicator 2007 and view the
event log

1. On the host computer, if Communicator is running, right-click the Office
Communicator icon on the system tray, and click Exit.

2. Click Start, right-click Command Prompt, and select Run as
administrator.

3. At the command prompt, type ipconfig /flushdns click OK, to remove any

DNS cached information, and then leave the command prompt open.
4. Click Start->All Programs—-> Microsoft Office Communicator 2007.

Notice the Office Communicator error stating that there was a problem
connecting to the server. Click OK.

5. Click Start->Control Panel, double-click Administrative Tools, and then

double-click Event Viewer.
6. In Event Viewer, click Application.

You should see a series of six very recent error messages with Event ID 3.
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Level Date and Time Source EventID Task Cate...
'ﬁ' Error 8/15/2007 2:22:32 PM Communicator 3 Mone
'ﬁ' Error 8/15/2007 2:22:32 PM Communicator 3 Mone
'ﬁ' Error 8/15/2007 2:22:32 PM Communicator 3 Mone
'@' Error 8/15/2007 2:22:32 PM Communicator 3 Mone
'ﬁ' Error 8/15/2007 2:22:32 PM Communicator 3 Mone
ﬁ Error 8/15/2007 2:22:32 PM Communicator 3 MNone
/0 Warning 8/15/2007 2:22:32 PM Communicator 1 Mone

7. Select the first error message in the series and double-click it.

8. Read the description stating that Communicator was unable to resolve the
DNS hostname of the login server sipinternal.Litwarelnc.com.

9. Click OK to close the logged event.
10. Leave the Event Viewer open.

IZ On the host computer, enable File Tracing
1. On the host computer, click Start-> Run.
2. Type regedit and then click OK.

3. Expand
HKEY_CURRENT_USER\Software\Microsoft\T racing\uccp\LiveMeeti
ng

4. Double-click the EnableFileTracing value, change the Value data to 1, and
then click OK.

Leave the Registry Editor running.

IZ On the host computer, try to attend a Live Meeting and view the event
log and tracing log

1. On the host computer, click Start-> Microsoft Office Outlook 2007.
2. Enter pass@wordl for the password and click OK.

3. Click Calendar, and then open the scheduled Weekly Project Review Live
Meeting that you created in the previous lab.

Notice the error stating a connection to the server could not be made, click
OK.

In the meeting request body, click Join the Meeting.

In the Join Error dialog box, click OK.

Switch to the Event Viewer and press F5.

Click the Event ID column header to sort by ID number.

Locate the most recent event with the Event ID 3 and double-click it.

© o N o g b~

Scroll through the events until you reach the event stating that it was unable
to resolve the DNS hostname of the login server
sipinternaltls.Litwarelnc.com.

10. This verifies that the Live Meeting console is not reaching the OCS 2007
server due to the missing SRV record. Close the logged event window.
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11. Click Start->All Programs—> Accessories>Windows Explorer.

12. For Windows XP, navigate to C:\Documents and
Settings\Administrator\Tracing. For Windows Vista, navigate to
C:\Users\<UserName>\Tracing and double-click LiveMeeting-uccp-
0.ucclog .

13. When prompted, select Notepad to open the uccplog.

14. In Notepad, click Edit and then click Find.

15. In the Find What field, type sipinternaltls and then click Find Next.
Notice that it tries but fails to query DNS for the login server.

16. Close the log and Windows Explorer.

£ On DC1, recreate the current SRV record and turn off tracing
1. On DC1, switch to the DNS console.

2. Expand DC1, expand Forward Lookup Zones, and then click
Litwarelnc.com.

3. Right-click Litwarelnc.com, and then click Other New Records.

4. Inthe Select a resource record type window, select Service Location
(SRV), and then click Create Record.

5. In the Service text box, type _sipinternaltls
6. Inthe Port number text box, type 5061

7. In the Host offering this service text box, type OCS-Std.Litwarelnc.com
and then click OK.

8. Click Done, and then close DNS.
9. Switch to the Registry Editor.
10. Change the EnableFileTracing value back to 0

IZ On the host computer, verify connectivity with Office Communicator
2007

On the host computer, switch to the command prompt.

Type ipconfig /flushdns and then press ENTER.

Switch to Office Communicator and click Sign In.

Log on as va@L.itwarelnc.com with the password pass@wordl
Under All Contacts, double-click Kevin Cook.

In the Kevin Cook - conversation window, type Messaging Works Again!
and then press ENTER.

S T S

£ On DC1, verify connectivity with Office Communicator 2007

1. Switch to DC1, notice the instant message coming in from Andy Ruth.
Click the prompt, type That is great! and then press ENTER.

2. Close the conversation window on both computers.
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3. On the host computer, right-click the Office Communicator 2007 icon on
the system tray and click Exit.
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Exercise 2

Troubleshooting Certificates

Introduction

This exercise will show you the different ways Office Communications Server
2007, Office Communicator 2007, and other resource kit tools help you
diagnose another one of the most common troubleshooting issues: untrusted or
missing certificates.

IZ On the host computer only, delete the Litware Trusted Root Certificate

Note This first procedure is done to simulate an untrusted or missing
certificate only. Please verify that you only delete this certificate only on the
host computer.

1. On the host computer, click Start> Run.

2. To open the Microsoft Management Console, type mmc and click OK.
3.

4. On the Add or Remove Snap-ins page, click Certificates and then click

Click File>Add/Remove Snap-in.

Add.

On the Certificates snap-in page, select Computer account and then click
Next.

On the Select Computer page, click Finish and then click OK.

In the Certificates console, expand Certificates (Local Computer), expand
Trusted Root Certification Authorities, and then click Certificates.

8. Right-click the LitwarelncCA certificate and click Delete.

In the Certificates dialog box, click Yes to confirm deletion.

You have now broken the certificate links to the Certificate Authority for
Litware Inc. Communicator and Live Meeting will no longer work from the
host computer because the installed certificate will no longer be trusted.

10. Leave the Certificates console open.

£ On OCS-Std, install the Resource Kit

1.

On OCS-Std, click Start-> All Programs—> Accessories>Windows
Explorer.

2. Navigate to C:\OCS 2007 and double-click OCSResKit.msi.
3. On the Welcome page, click Next.

4. On the License Agreement page, click | accept the terms in the license

agreement, and then click Next.

On the Install location for Microsoft Office Communications Server 2007,
Resource Kit page, click Next.

On the Confirm Installation page, click Next.

7. On the Installation Complete page, click Close.

8. Close Windows Explorer.
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£ On OCSs-Std, turn on the Logging Tool

We will now capture additional logging using the resource kit Logging Tool
to help with troubleshooting.

1. On OCS-Std, click Start-> Administrative Tools—> Office
Communications Server 2007.

2. Expand Forest-Litwarelnc.com, and then expand Standard Edition
Servers.

3. Right-click OCS-Std, click Logging Tool, and then click New Debug
Session.

4. In Office Communications Server 2007 Logging Tool, in the
Components pane on the left, scroll down and select the SIPStack check
box

5. Under Level, select All.

6. In the Flags window, check the All Flags box.

7. Click Start Logging near the bottom of the page.
Leave the Logging Tool running.

IZ On the host computer, use Office Communicator 2007 and view event
log messages

1. On the host computer, click Start->All Programs—>Microsoft Office
Communicator 2007.

2. On the Microsoft Office Communicator 2007 prompt, click OK to the
clearly stated error message explaining that there was a problem verifying
the certificate from the server.

3. Click Start->Administrative Tools>Event Viewer.
4. In Event Viewer, click Application, and then press F5.
5. Open the most recent entry with the Event ID 5.

Read the description of the event stating “Communicator could not
connect securely to server OCS-Std.Litwarelnc.com because the
certificate presented by the server was not trusted due to validation
error...” Read the clear instructions in the Resolution section on how to
resolve this issue.

6. Click OK.
7. Leave the Event Viewer open.

£ On OCS-Std, review the log files captured by the Logging Tool

1. Switch to OCS-Std. On the Office Communications Server 2007 Logging
Tool, click Stop Logging.

2. Click View Log Files.

3. Inthe View Log Files dialog box, check the SIPStack box, and then click
View.

4. Review the log.
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Notice that there was a connection error and that the error Text: line
describes the scenario and then asks a question on how to resolve the issue.

L LI T B B I Y IV T I R R R ST

LogType: Connection

Severitﬁ: arror

Text: The connection was closed before TLS negotiation completed. Did the remote peer accept our certificate?
Local-IP: 10.0.0.20:5061

Pear-IP: 10.0.0.70:49793

Connection-Ib: Ox1FO0

Transport: TLS

$$end_record

TL_wWARNCTF_COMPOMENTY [0]0OFS8. 0CDO: :08,/15,/2007-22:30:02.111., 00003 C70
{{shared),cTimedEntry: tRemoveFromTimer 896, 1dx{171))¢ 01157788 ) not assigned to a timer
TL_INFO(TF_COMPOMENT) [0]OF5S. ODEQ: :08,/15,/2007-22:231:02. 935, 00003db3
(SIPstack,CRecwContext::ProcessCompletion: 974, idx(155)0( 022F66A8 1 Received 37 bytes

5. Close the log file.
In the Logging Tool, click Analyze Log Files.

. In the Analyze Log Files dialog box, check SIPStack, and then click
Analyze.

This will start the Snooper tool, which will help you read the logs.

8. In the Message Preview pane, click the entry with the StartLine title of
CONNECTION: The connection was closed before. Then, in the result
pane, view the record.

9. Inthe Message Preview pane, notice the Text: line that you saw when you
viewed the log files. When the log is analyzed, each log entry is separated.
This makes the log entries easier to read and to act on.

10. Close Snooper.
11. On the Logging Tool, click Exit
Leave the Office Communications Server 2007 console running.

IZ On the host computer, import the Litware Trusted Root Certificate

1. On the host computer, switch to the Certificates console, expand Trusted
Root Certification Authorities, right-click Certificates, click All Tasks
and then click Import.

2. On the Welcome page, click Next.

3. On the File to Import page, in the File Name box, type
C:\VPC\Extras\Config\LitwarelncCA.crt and then click Next.

4. On the Certificate Store page, verify that the Certificate Store is set to
Trusted Root Certification Authorities, and then click Next.

5. On the Completion page, click Finish.
6. On the Certificate Import Wizard prompt, click OK.
7. Close the Certificates console without saving changes to the console.

£ On the host computer, verify connectivity with Office Communicator
2007

1. On the host computer, switch to Office Communicator. If Communicator is
not running, click Start=>All Programs-> Microsoft Office
Communicator 2007 and log on as va@L itwarelnc.com with the
password pass@wordl
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2.
3.

Under All Contacts, double-click Kevin Cook.

In the Kevin Cook conversation window, type Messaging works again! and
then press ENTER.

IZ On DC1, verify connectivity with Office Communicator 2007

1.

Switch to DC1, notice the instant message coming in from Andy Ruth, click
the prompt, type That is great! and then press ENTER.

Close the conversation window on both computers, and then right-click the
Communicator icon on the system tray and click Exit on both computers.
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Exercise 3

Use the Validation Wizard to Verify the Environment

Introduction

This exercise will show you how to use the validation wizard to verify your
configuration. The Validation Wizard is one of the preferred tools, and is
extremely helpful in analyzing multiple scenarios and providing a detailed log
of settings and errors. We will then correct an issue found regarding users being
enabled for services not installed and then rerun the validation to validate our
environment.

IZ On OCS-Std, use the Validation tool to check server configuration
1. On OCS-Std, switch to the Office Communications Server 2007 console.

2. Expand OCS-Std, right-click OCS-Std.Litwarelnc.com, click Validation,
and then click Front End Server.

3. On the Welcome page, click Next.

4. On the Validation steps page, check the Validate Local Server
Configuration, Validate Connectivity, Validate SIP Logon (1-Party)
and IM (2-Party), Check this box to use client auto-logon validation and
Validate IM Conference (2-Party) boxes, and then click Next.

On the User Account page, in the Account field, type gy@L.itwarelnc.com
In the User Name field, type gy@L.itwarelnc.com
In the Password field, type pass@word1 and then click Next.

o N o u

On the Second user account page, in the Account field, type
li@Litwarelnc.com

9. Inthe User Name field, type li@Litwarelnc.com
10. In the Password field, type pass@word1 and then click Next.
11. On the Federation and Public IM Connectivity page, click Next.

12. On the completion page, notice that the wizard finished with failures and
that the View the log when you click ‘Finish’ check box is already
checked.

13. Click Finish.
14. Switch to the Deployment Log that has opened.
15. In the upper-right corner of the Deployment Log, click Expand All.

16. In the Action Information column, notice the warning that federation is
disabled and that there are phone usages that are not assigned to any routes
or policies.

17. Scroll down to the Check Pool Hosted User Setting action, and notice that
this check failed. Read the Error.

It appears some users have unnecessary configuration settings that should be
disabled.

18. In the Execution Result column, verify that the results of the rest of the
tasks are Success. Close the Deployment Log window.
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IZ On OCS-Std, correct the configuration issue

1
2
3.
4

K
1.

. On OCS-Std, switch to the Office Communications Server 2007 console.
. Click Users, right-click Users, and then click Configure users.

On the welcome page, click Next.

. On the Configure Users Settings page, select the Federation, Public IM

Connectivity and Remote User Access check boxes and then, under each
box, check Disable.

Click Next four times, to leave the current Meeting and Voice polices in
place.

On the Configure Operations Status page, click Finish.

On OCS-Std, use the Validation Wizard to verify server configuration

On OCS-Std, in the Office Communications Server 2007 console, right-
click OCS-Std.Litwarelnc.com, click Validation, and then click Front
End Server.

2. On the Welcome page, click Next.

3. On the Validation steps page, check the Validate Local Server

N o o &

o

Configuration, Validate Connectivity, Validate SIP Logon (1-Party)
and IM (2-Party), Check this box to use client auto-logon validation and
Validate IM Conference (2-Party) boxes, and then click Next.

On the User Account page, in the Account field, type gy@L itwarelnc.com
In the User Name field, type gy@Litwarelnc.com
In the Password field, type pass@word1 and then click Next.

On the Second user account page, in the Account field, type
li@Litwarelnc.com

In the User Name field, type li@Litwarelnc.com

9. Inthe Password field, type pass@word1l and then click Next.

10.

11.
12.

13.

On the Federation and Public IM Connectivity page, click Next.

On the completion page, notice that the wizard finished with only warnings
this time, and that the View the log when you click ‘Finish’ check box is
already checked.

Click Finish.

In the Action Information column, notice the same warnings as before, but
no failures!

Close the Deployment Log.



Lab 5: Building Voice Capabilities into
Your Office Communications Server
2007 Deployment

Objectives

Prerequisites

Scenario

Estimated time to
complete this lab: 60
minutes

After completing this lab, you will be able to:

m Install and activate a Mediation Server.

= Configure the Mediation Server.

= Configure certificates for the Mediation Server.
m Configure a Voice over IP (VOIP) gateway.

Note This lab focuses on the concepts in this module. As a result, it may not
comply with Microsoft security recommendations.

Before working on this lab, you must have completed the previous labs. If you
have not completed the previous labs, this lab will fail.

Now that Litware, Inc. has successfully deployed

Microsoft Office Communications Server (OCS) 2007, the company has
decided to deploy and use the Voice features of

Office Communications Server 2007. To integrate

Office Communications Server 2007 with Litware’s Private Branch eXchange
(PBX) system, you must install a Mediation Server and configure it to
communicate with our SIP-PSTN gateway. You will also need to configure
your supported SIP-PSTN gateway (interchangeably known as a VVolP
gateway).

TIP  For more information on configuring Office Communications for voice,
please review the Office Communications Server 2007 Enterprise Voice
Planning and Deployment Guide included with the OCS 2007 documentation
available for download at Microsoft.com
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Exercise 0
Lab Setup

To complete this lab, you will need to use the DC1 and OCS-Std Virtual PCs
from the previous lab.

You will also need to start the OCS-Mediation Virtual PC.

IZ On the host computer, start and log onto the OCS-Mediation Virtual
PC

1. On the host computer, in the Virtual PC Console, turn on the OCS-
Mediation virtual PC by clicking OCS-Mediation and then clicking the
Start button.

2. A new OCS-Mediation virtual PC console opens. At the logon screen, press
and hold the right ALT key and then press DELETE.

3. Log on to the Litwarelnc domain as Administrator with a password of
pass@wordl.

Important Click OK to any prompts regarding any services that fail to start,
and then review Services to verify that all have started successfully.
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Exercise 1

Installing and Activating the Mediation Server

Introduction

In this exercise, you will install and activate the Mediation Server on OCS-
Mediation. This server role is used to bridge communications between Office
Communications Server 2007 and the SIP-PSTN gateway.

£ Install the Mediation server files on OCS-Mediation

1.

ok~ 0

o

8.
9.

On the OCS-Mediation Virtual Server, click Start > All Programs
—>Accessories 2>Windows Explorer.

Navigate to C:\OCS 2007\Setup\I1386 and then double-click Setup.exe.
In the Deployment Wizard, click Deploy Other Server Roles.
On the Deploy Other Server Roles page, click Deploy Mediation Server.

In the Deploy Mediation Server Deployment Wizard, next to Step 1: Install
Files for Mediation Server, click Install.

On the Welcome page, click Next.

On the License Agreement page, click I accept the terms in the licensing
agreement, and then click Next.

On the Install location page, leave the default path and then click Next.
On the Confirm Installation page, click Next.

10. On the Installation Complete page, click Close.

£ Activate the Mediation Server on OCS-Mediation

1.

On OCS-Mediation, in the Deploy Mediation Server Deployment Wizard,
next to Step 2: Activate Mediation Server, click Run.

On the Welcome page of the activation wizard, click Next.

On the Select Service Account page, in the Password text box, type
pass@wordl and then click Next.

4. On the Ready to Activate Mediation Server page, click Next.

5. On the Completion page, click Finish.

Leave the Deployment Wizard running.
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Exercise 2

Configuring the Mediation Server and Certificates

Introduction

The next step is to configure the Office Communications Server 2007
Mediation Server. You will also configure certificates for the Mediation Server,
which includes downloading and installing the LitwareIncCA certification path
and requesting and assigning a certificate on the server, to enable secure
communications between OCS 2007 and the Mediation Server role. The final
step is to start the Mediation Server services.

IZ Configure the Mediation Server on OCS-Mediation

1. Onthe OCS-Mediation Virtual Server, click Start > Administrative Tools
- Office Communications Server 2007.

2. In the Office Communications Server 2007, Administrative Tools console,
expand Forest - Litewarelnc.com, expand Mediation Servers, and then
click OCS-Mediation.Litwarelnc.com.

3. Right-click OCS-Mediation.Litwarelnc.com and then click Properties.
4. Click the General tab.

5. In the Communications Server listening IP address drop-down list, select
10.0.0.26.

This tells the Mediation Server to listen on this interface for OCS
communications.

6. Inthe Gateway listening IP address drop-down list, select 10.1.10.11.

This tells the Mediation Server to use this interface to listen for traffic from
the SIP-PSTN gateway.

7. Inthe Select the A/V Edge Server list, verify that (None) is selected.

Leave the rest of the settings on this tab as their defaults. After you have
configured a Location Profile in the next lab, you will return to this tab and
select it.

8. Click the Next Hop Connections tab.

9. Under Office Communications Server next hop, in the FQDN drop-down
list, select OCS-Std.Litewarelnc.com.

10. Under PSTN Gateway next hop, in the IP address text box, type
10.1.10.10 and then in the Port box, accept the default of 5060 and then
click OK.

11. Click OK to the warning prompts for the A/\V Authentication Service and
default location profile settings.

12. Click OK to the warning prompt regarding restarting the Mediation Server
service.

13. Close the Office Communications Server 2007 console.

IZ Download the Litwarelnc CA certification path to OCS-Mediation

1. On OCS-Mediation, click Start, click Run, type https://DC1/certsrv and
then click OK.
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We will now download the CA Certificate chain so the Mediation Server
can use MTLS communication with OCS 2007.

In Microsoft Internet Explorer, under Select a task, click Download a CA
certificate, certificate chain, or CRL.

Under Download a CA Certificate, Certificate Chain, or CRL, click
Download CA certificate chain.

4. Inthe File Download dialog box, click Save.

5. Save the certnew.p7b file to C:\ and then click Close when the download is

complete.
Close Internet Explorer.

Install the CA certification path for the Mediation Server on OCS-
Mediation

1. Switch to the Deployment Wizard on OCS-Mediation.

On the Deploy Mediation Server page, next to Step 4: Configure
Certificate, click Run to start the Communications Certificate Wizard.

3. On the Welcome page, click Next.

e

On the Available Certificate Tasks page, click Import a certificate chain
from a .p7b file and then click Next.

5. On the Import Certificate Chain page, click Browse.
6.
7
8

Navigate to C:\, click certnew.p7b, and then click Open.

. On the Import Certificate Chain page, click Next.
. Click Finish.

IZ Create the certificate request for the Mediation Server on OCS-

Mediation

On OCS-Mediation, in the Deployment Wizard, on the Deploy Mediation
Server page, next to Step 4: Configure Certificate, click Run to start the
Communications Certificate Wizard again.

On the Welcome page, click Next.

On the Available Certificate Tasks page, click Create a new certificate and
then click Next.

On the Delayed or Immediate Request page, select Send request
immediately to an online certificate authority and then click Next.

On the Name and Security Settings page, in the Name field, verify that
OCS-Mediation is entered and that Mark cert as exportable is selected,
and then click Next.

On the Organization Information page, enter Litware Inc and the
organizational unit of IT, and then click Next.

On the Your Server’s Subject Name page, in the Subject name box, verify
that OCS-Mediation.Litewarelnc.com is selected.

Note The subject name should match the fully qualified domain name
(FQDN) of the Mediation Server.

Click Next.
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9. On the Geographical Information page, type Washington for the
State/Province and Redmond for the City/Locality, and then click Next.

10. On the Choose a Certification Authority page, verify that
DCl1.Litewarelnc.com\LitwarelncCA is selected, and then click Next.

11. On the Request Summary page, click Next.
12. On the Certificate Wizard Completed page, click Assign.

13. In the Communication Certificate Wizard prompt, click OK and then click
Finish.

14. Click Exit to close the Deployment Wizard.

I£ Start the Mediation Server services on OCS-Mediation
1. On OCS-Mediation, click Start 2> Administrative Tools = Services.

2. Verify that Office Communications Server Mediation appears in the list
of services.

3. Right-click Office Communications Server Mediation and then click
Start.

4. Wait until the service is started and then close Services.
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Exercise 3

Configuring the AudioCodes MP-114 VolP Gateway

Introduction

As part of lab setup, you will configure a SIP-PSTN gateway to allow Office
Communicator to place calls to an analog handset. In this exercise, you will
configure the AudioCodes MP-114 SIP-PSTN gateway. Some of the necessary
configurations include defining endpoint phone numbers, defining routing and
manipulation tables, and configuring hunt group settings. Please verify that the
analog handset is plugged into the FXS port 1, and if possible, attach an analog
phone line to the FXO port 3 (optional).

Tip If after performing these configuration changes your configuration does
not work or you are running out of time, there is a working ini file on OCS-
Mediation in C:\OCS 2007 named Solution-MP-114-OCS-L.itwarelnc.ini that
you can load with the same procedures used in the first section.

IZ Confirm the firmware version of the AudioCodes Gateway on OCS-
Mediation

1. On OCS-Mediation, click Start=> All Programs—> Internet Explorer.

2. In Internet Explorer, in the Address field, type http://10.1.10.10 and then
click OK.

3. Inthe Connect to 10.1.10.10 login text box, type Admin for both the User
name and Password (both are case-sensitive).

4. In Internet Explorer, on the MP-114 Administration Web site, in the left
pane, click Status & Diagnostics and then click Device Information on the
toolbar.

5. On the Device Information page, under Versions, verify that the Version
ID is 5.00A.033.001.

} £ 3 AudioCodes ‘

:
g
|
%

(5 Device Information

S e MAC Address 00908#0d8¢50

Protocol Management Senal Number 887888

Advanced Configuration Board Type 57

Status & Diagnostics Dewvice Up Time 0d:4h:24m 525:30th

Software Update Dawco Admanistrative State Unlocked

Maintenance Device Operational State Enabled
Flash Size [bytes] 8388608

+ Log Off RAM Size [bytes) 33554432
CPU Speed [MH2] 40
ersions
Version ID 5.00A 033.001
DSP Type G
| N0 Cabuara \Vassunn mMaes

If your version is correct, proceed to the next section. If you have a different
version, continue with the next step.
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In the left pane, click Software Update and then click Software Upgrade
Wizard.

7. Click Start Software Upgrade.
8. Click Browse, navigate to C:\OCS 2007, select

9.

10.

11.

12.

MP118_SIP_F5.00A.033.001.cmp, and then click Open.
Click Send File to start the software update process.

When the file has been successfully loaded into the device, click Reset.
When the gateway has finished burning the files to flash memory and
rebooted, click End Process.

In the Connect to 10.1.10.10 login text box, type Admin for both the User
name and Password (both are case-sensitive) and then click OK.

Click OK to the Windows Internet Explorer prompt regarding the new
CMP.

Load the configuration file for the AudioCodes Gateway on OCS-
Mediation
On OCS-Mediation, in Internet Explorer, on the MP-114 Administration

Web site, in the left pane, click Advanced Configuration, and then click
Configuration File on the toolbar.

2. Under Send the ini file from your computer to the device, click Browse.
3. Navigate to C:\OCS 2007, click MP-114-OCS.ini, and then click Open.
4. Click Send ini File.

8.

This will send the configuration file to the AudioCodes gateway and restart
it.

In the Microsoft Windows Internet Explorer prompt, click OK.

If a second Internet Explorer progress window pops up, close it.

After about 60 seconds the gateway will reboot. In Internet Explorer, click
Refresh to return to the Administration Web site.

In the Connect to 10.1.10.10 login box, type Admin for both the User name
and Password (both are case-sensitive).

At the new file prompt, click OK.

Note All of the configuration changes made during this exercise are
specifically for the AudioCodes MP-114 VolIP gateway. Similar configuration
changes will need to be made to any VVolP gateway; please refer to your
product’s reference materials to configure your device.

K
1.

Define endpoint phone numbers on OCS-Mediation

On OCS-Mediation, on the MP-114 administration Web site, in the left
pane, click Protocol Management, and then click Endpoint Phone
Numbers on the toolbar.

Important This gateway has been partially configured to conserve time.
Please do not make any changes to any settings unless otherwise instructed.
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2. In the Endpoint Phone Number Table, configure lines 1 and 2 to match
the chart below.

Endpoint Phone Number Table

Channel(s Phone Number Hunt Group 1D Profile 1D
1 12068551236 | [ o
2 1000 | o |
s L | | [ [
s [ ] | | [ [
| Regster | UnRegiter |
~ Submit |

3. Click Submit when finished.

I Define routing tables on OCS-Mediation
1. On OCS-Mediation, click Routing Tables on the toolbar and then click Tel

to IP Routing.
2. In Routing Tables, configure line 1 to match the chart below.
Dest. Phone Prefix Source Phone Prefix Dest. IP Address Profile 1D Status Charge Code
1 42855550 2065551236 10.110.11 0 .
2 - 2065551236 10.110.10 0
S N 1011011 0
4

3. Click Submit when finished.

£ Configure manipulation tables on OCS-Mediation

1. On OCS-Mediation, click Manipulation Tables on the toolbar and then
click IP-> Tel Destination Numbers.

In the Destination Phone Number Manipulation Table for IP -> Tel
Calls, configure lines 1 and 2 to match the chart below.

no

NUmbper N
. of Prefix (Suffix) of Digits
Destination Prefix Source Prefix Source IP Stripped  to Add

to
Digits | eave

*

*
[

Al
()
)

1|+12065551236 |
2|41 [+
3| I

3. Click Submit when finished.

4. Click Manipulation Tables on the toolbar and then click Tel-> IP
Destination Numbers.

5. In the Destination Phone Number Manipulation Table for Tel -> IP
Calls, configure line 1 to match the chart below.

. : Prefix (Suffix) :
Destination Prefix Source Prefix t.r||.3ped to Add ]

Digits to Leave

6. Click Submit when finished.
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7. Click Manipulation Tables on the toolbar and then click Tel-> IP Source
Numbers.

8. Inthe Source Phone Number Manipulation Table for Tel -> IP Calls,
configure line 1 to match the chart below.

Dest. Prefix Source Prefix i : : S Presentation
1 |* | ‘* | |D | |+‘| | | | |NotConﬁgured V|
2 | | ‘ | | | | | | | |NotConﬁgured V|
3| I o o o | [NotConfigured |

9. Click Submit when finished.

IZ Configure hunt group settings on OCS-Mediation
1. OCS-Mediation, click Hunt Group Settings on the toolbar.
2. In the Hunt Group Settings table, configure line 1 to match the chart

below.
Hunt Group 1D Channel Select Mode Registration Mode
1 |'| | |Ascending V| | V|
2| || v | vl
3 || v | vl
. [ 1 [ 1 [ 1
3. Click Submit when finished.
4. Click Routing Tables on the toolbar and then click IP to Trunk Group
Routing.
5. Inthe IP to Tel Routing Mode drop-down list, select Route calls after
manipulation.
IP To Tel Routing Mode | Route calls after manipulation V|
6. Inthe IP to Hunt Group Routing table, configure lines 1 and 2 to match
the chart below.
1 |2085551236 - - | o ] o

| | | |
2 | [ | N R
3| | | | | | I

7. Click Submit when finished.

IZ save configuration settings on OCS-Mediation

1. On OCS-Mediation, on the MP-114 administration Web site, in the left
pane, click Maintenance.

2. On the Maintenance Actions page, under Save Configurations, click
BURN.

3. When the new configuration has been saved to flash memory, close Internet
Explorer.



Lab 6: Configuring the Voice
Capabilities of Microsoft Office
Communications Server 2007

Objectives After completing this lab, you will be able to:

= Define phone number normalization rules for outbound calls.
= Create phone usage records.

= Define a policy.

= Create and configure a location profile.

= Define outbound call routes.

= Configure users for enterprise voice.

= Configure Users for Voice.

Note This lab focuses on the concepts in this module. As a result, it may not
comply with Microsoft security recommendations.

Prerequisites Before working on this lab, you must have completed the previous labs. If you
have not completed the previous labs, this lab will fail.

Scenario Now that you have installed and configured your Microsoft Office
Communications Server (OCS) 2007 Mediation Server, the next step is to
configure the Office Communications Server 2007 servers for voice capability.
This includes defining normalization rules, creating phone usage records,
defining a policy, creating and configuring a location profile, defining outbound
call routes, and configuring users for enterprise voice.

Estimated time to
complete this lab: 60
minutes
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Exercise 0
Lab Setup

To complete this lab, you must have the DC1, OCS-Std and OCS-Mediation
Virtual PCs running from the previous labs.
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Exercise 1

Configuring Outbound Dialing and Routing

Introduction

In this exercise, you will configure outbound dialing and routing. Office
Communications Server 2007 normalizes numbers prior to performing reverse
number lookup. If the normalized number matches the designated primary work
number of a user with an Active Directory identity, the call is forked to the
endpoints associated with that user’s SIP-URI. If the server does not find a
match, which means the target number is probably outside the enterprise, the
Outbound Routing component checks the caller’s phone usage to determine if a
call to that number is authorized, and then either directs the call to the
appropriate media gateway or notifies the caller that the call is not allowed.

Configuring Litware, Inc. for outbound dialing and routing requires developing
a dial plan, which defines how various numbers and patterns of dialed digits are
to be handled by the server. For example, a caller working in Redmond,
Washington, might dial any one of the following numbers:

425-555-1212
555-1212
51212

You need to normalize these phone numbers to the E.164 format by using OCS
normalization rules, to allow proper routing of the call.

Note The purpose of these voice-lab exercises is to familiarize you with Office
Communications Server 2007 concepts such as Policy, Usage, Routes, and so
on. It should be understood that the lab configuration/dial-plan represent a
North American focus, and that your dial-plan will need to be configured to
your local needs.

Tip On OCS-Std, in C:\OCS 2007, there is a file named Normalization
Rules.doc that contains all of the syntax for these normalization rules, which
you can copy and paste to save time. These are a series of regular expressions
used to normalize dialed numbers. Please verify that you do not copy and paste
any spaces or carriage returns at the end of each field, including the description
fields.

£ Create a location profile on OCS-Std and define phone number
normalization rules for outbound calls

1. On OCS-Std, click Start=> Administrative Tools=> Office
Communications Server 2007.

2. Right-click the Forest — Litwarelnc.com node, point to Properties, and
then click Voice Properties.

3. You will now add a location profile for the Litwarelnc Main Office. On the
Location Profiles tab, click Add.

4. Inthe Add Location Profile dialog box, type Redmond.Litwarelnc.com
for the name and Litwarelnc Main Office in Redmond for the description.

You will now add a series of normalization rules for this location profile.
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5. Under Normalization Rules, click Add.

6. Inthe Add Phone Number Normalization Rule dialog box, perform the
following steps:

a.
b.

d.

In the Name text box, type Main Office 5 Digit Extensions

In the Description text box, type Normalizes Main Office 5 digit
extensions to +1425555XXXX

In the Phone pattern text box, type (no spaces)
~5(\d{4}H)$

Note This rule translates four-digit extensions that begin with a 5 to the
E.164 number format.

Dialed number: 51212

Translated number: +14255551212

In the Translation text box, type +1425555%$1 and then click OK.

7. On the Normalization Rules tab, click Add to add a second normalization
rule.

8. Inthe Add Phone Number Normalization Rule dialog box, perform the
following steps:

a.
b.

d.

In the Name text box, type Main Office Local Calls

In the Description text box, type Normalizes local calls (7 digits) from
Main Office to 425 area code

In the Phone pattern text box, type (no spaces)
~(\d{7hH $

Note This rule translates local calls to the E.164 number format.
Dialed number: 555-1212
Translated number: +14255551212

In the Translation text box, type +1425%1 and then click OK.

9. On the Normalization Rules tab, click Add to add a third normalization
rule.

10. In the Add Phone Number Normalization Rule dialog box, perform the
following steps:

a.
b.

d.

In the Name text box, type Main Office National Calls

In the Description text box, type Normalizes Main Office national
calls to 1 + 10 digits

In the Phone pattern text box, type (no spaces)
~(\d{10}h)$

Note This rule translates local calls to the E.164 number format.
Dialed number: 212-555-1212
Translated number: +12125551212

In the Translation text box, type +1$1 and then click OK.

11. On the Normalization Rules tab, click Add to add a fourth normalization
rule.
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12. In the Add Phone Number Normalization Rule dialog box, perform the

following steps:
a. Inthe Name text box, type Main Office International Calls

b. In the Description text box, type Normalizes Main Office
international calls

c. Inthe Phone pattern text box, type (no spaces)
2011 (\d*)$

Note This rule translates international calls to the E.164 number format.
Dialed number: 011-41-78-555-1212
Translated number: +41785551212

d. Inthe Translation text box, type +$1 and then click OK twice.

IZ Create a phone usage record on OCS-Std

Phone usage records provide a quick, simple way to assign call permissions to
users as well as facilitate route prioritization and selection.

1.
2.

On OCS-Std, click the Phone Usages tab and then click Add.

In the Add Phone Usage Record dialog box, in the Name text box, type
LitwarelncUsage

In the Description text box, type No long distance allowed and then click
OK.

4. On the Phone Usages tab, click Add.
5. Inthe Add Phone Usage Record dialog box, in the Name text box, type

LitwarelncExecUsage

In the Description text box, type Long distance allowed and then click
OK.

I Define a policy on OCS-Std
Polices are used to assign different usages to different users.

1.
2.
3.

On OCS-Std, click the Policy tab and then click Add.
In the Policy Name text box, type Main Office Local Calls Only

Verify that Allow simultaneous ringing of phones is selected, and then
click Configure.

In the Configure Phone Usage Records dialog box, in the Available
phone usage records list, select LitwarelncUsage, and then click the
RIGHT ARROW button (>) to select this usage. Click OK twice.

5. On the Policy tab, click Add.
6. Inthe Policy Name text box, type Main Office Local and Long Calls

7. Verify that Allow simultaneous ringing of phones is selected, and then

click Configure.

In the Configure Phone Usage Records dialog box, in the Available
phone usage records list, select LitwarelncExecUsage, and then click the
RIGHT ARROW button (>) to select this usage. Click OK twice.
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9.

In the Global policy drop-down list, select Use per user policy, click
Apply, and then click OK.

IZ configure the location profile on the front end on OCS-Std

You will now define the default location profile for the pool.

1.

On OCS-Std, in the Office Communicator Server 2007 console, expand
Forest - Litwarelnc.com, expand Standard Edition Servers, and then
click OCS-Std.

Right-click OCS-Std, click Properties, and then click Front End
Properties.

On the Voice tab, under Location Profile, select
Redmond.Litwarelnc.com in the Location Profiles drop-down list.

Click OK.

5. At the Active Directory replication warning prompt, click OK.

IZ Configure the location profile for the Mediation Server on OCS-Std

You will now define the default location profile for the Mediation Server.

1.

On OCS-Std, in the Office Communications Server 2007 console, expand
Forest - Litwarelnc.com, expand Mediation Servers, and then click OCS-
Mediation.Litwarelnc.com.

Right-click OCS-Mediation.Litwarelnc.com and then click Properties.

On the General tab, in the Default location profile list, select
Redmond.Litwarelnc.com.

Click OK.

5. Click OK to the warning prompts.

I£ Define an outbound call route on OCS-Std

Routes determine the optimal gateway for calls that OCS 2007 has determined
need to be routed to a PSTN gateway.

1.

On OCS-Std, in the Office Communications Server 2007 console, right-
click Forest - Litwarelnc.com, point to Properties, and then click VVoice
Properties.

Click the Routes tab, and then click Add to add a call route.
In the Add Route dialog box, perform the following steps:
a. Inthe Name text box, type All Calls.

b. Inthe Description text box, type Route all external calls to the main
office gateway.

c. Inthe Target phone number regular expression text box, type . * (a
period followed by an asterisk with no spaces).

4. Under Gateways, click Add.
5. Under Select the Gateway, select OCS-Mediation.Litwarelnc.com:5061

and then click OK.
Under Phone usages, click Configure.
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7. Inthe Configure Phone Usage Records dialog box, in the Available
phone usage records list, select LitwarelncExecUsage and then click the
RIGHT ARROW button (>). Click OK twice.

8. On the Routes tab, click Add to add another call route.
9. Inthe Add Route dialog box, perform the following steps:
a. Inthe Name text box, type Local Calls Only

b. Inthe Description text box, type Allow calls to only the 425 and 206
area codes

c. Inthe Target phone number regular expression text box, type (no
spaces): M((\+1425)|(\+1206))

10. Under Gateways, click Add.

11. Under Select the Gateway, select OCS-Mediation.Litwarelnc.com:5061
and then click OK.

12. Under Phone usages, click Configure.

13. In the Configure Phone Usage Records dialog box, in the Available
phone usage records list, select LitwarelncUsage and then click the
RIGHT ARROW button (>). Click OK three times.

Leave the Office Communications Server 2007 console open.

Note The order of phone usage records is significant. When routing an
outbound call, the server checks the list of phone usage records to see if the
caller is authorized to call numbers matching the target phone number Regular
Expression for this route. If the caller is authorized for the first phone usage, the
call is routed immediately. If not, the server traverses the list until it either finds
a usage for which the caller is authorized or finds no such usage, in which case
the call is denied.

IZ Use Route Helper on OCS-Std to validate your configuration

You will now use the Route Helper tool included with the Resource Kit to
validate your setup and make any necessary adjustments.

1. On OCS-Std, click Start-> All Programs-> Office Communications
Server->» Resource Kit=> Enterprise Voice Route Helper.

2. In Route Helper, notice that the tool has found all of the voice settings you
just configured.

3. Click the Ad-hoc Test tab.

4. On the Manual tab, in the Policy drop-down list, select Main Office Local
Calls Only.

5. In the Dialed Number field, type 51234 and then click Test.

6. Inthe Results area, notice the results showing which Normalization Rule
was applied, what the Normalized number is, and which Usage and route
were applied.

7. Click Add to Test Cases at the bottom of the window.
8. Repeat steps 4-7 using the following Dialed Numbers:
a. 5551234
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b.
C.

4255551234
01144020987654321 (this number should show an Unable to

Route:Response code 403 result)

9. Repeat steps 4-7 using the following Dialed Numbers and the Main Office
Local and Long Calls policy:

a.
b.
c.
d.

51234

5551234
4255551234
01144020987654321

10. Click the Test Cases tab and notice all of the tests you just ran and added.

11. Click Run in the lower-right corner and notice that all of the results are
Pass.

12. Click File and then click Save Test Cases.
13. Type Litwarelnc Tests and then click Save.

Tip You can now start Enterprise VVoice Route Helper at any time, make
whatever changes you need, load these saved test cases, and then run them
against your changes. You can add as many tests as necessary or create
different sets of tests. Once you have configured your routing data with this
tool, you can then upload the changes to OCS.

14. Close Route Helper



Lab 6: Configuring the Voice Capabilities of Microsoft Office Communications Server 2007 9

Exercise 2

Configuring Users for VolP

Introduction

In this exercise, you will configure users for voice capability and then assign
extensions for three users: Vivian Atlas, Hao Chen, and Kevin Cook.

Note Office Communicator 2007 continues to rely on Address Book Server for
the E.164 phone number normalization that it requires for reverse number
lookup. Although the Address Book Server can be used to perform phone
normalization, it is not the recommended method. Normalizing numbers within
the Microsoft Active Directorye directory services is the preferred method.

IZ Configure users for Enterprise Voice capability on OCS-Std

1. On OCS-Std, in the Office Communications Server 2007 console, expand
Forest — Litwarelnc.com and then expand Standard Edition Servers.

2. Expand OCS-Std, click Users, right-click Users, and then click Configure
users.

The Configure Users Wizard launches in which you will now set the Voice
properties for the users.

3. On the Welcome to the Configure Users Wizard page, click Next.

4. On the Configure User Settings bulk configuration page, click Next to leave
the current settings in place.

5. On the Configure User Settings organize meetings page, click Next to leave
the current anonymous participants policy in place.

6. On the Configure User Settings specify meeting policy page, click Next to
leave the current Meeting policy in place.

7. On the Configure Enterprise VVoice Settings page, click Change Enterprise
Voice Settings, click Enable Voice, and then in the Select a Voice policy
for the users drop-down list, select Main Office Local Calls Only and then
click Next.

8. On the Configure Operation Status page, click Finish.

9. Inthe Users window, right click Vivian Atlas and then click Configure
Users.

10. On the Welcome to the Configure Users Wizard page, click Next.

11. On the Configure User Settings bulk configuration page, click Next.

12. On the Configure User Settings organize meetings page, click Next.

13. On the Configure User Settings specify meeting policy page, click Next.

14. On the Configure User Settings enable users for VVoice page, click Change
Enterprice Voice Settings, click Enable Voice, and then in the Select a
Voice policy for the users drop-down list, select Main Office Local and
Long Calls and then click Next.

15. On the Configure Operation Status page, click Finish.
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£ Define user extensions On OCS-Std for Vivian Atlas, Hao Chen, and
Kevin Cook

Note Office Communicator 2007 continues to rely on Address Book Server for
the E.164 phone number normalization that it requires for reverse number
lookup. Although the Address Book Server can be used to perform phone
normalization, it is not the recommended method. For ease of implementation,
Active Directory should contain E.164 format for all telephone number fields.
For purposes of this exercise, you will enter phone numbers into the property of
a user, however this could be automated with tools like ADSI scripts, or other
programs to sync with Active Directory.

1. On OCS-Std, in the Office Communications Server 2007 console, in Users,
right-click Vivian Atlas and then click Properties.

2. On Vivian Atlas’s properties page, next to Additional options, click
Configure.

3. Under Telephony, in the Line URI text box, type tel:+14255550069

Important Including the tel: moniker is required to define the telephone
string.

4. Click OK two times.
5. Right-click Hao Chen and then click Properties.

6. On Hao Chen’s properties page, next to Additional options, click
Configure.

7. Under Telephony, in the Line URI text box, type tel:+14255550227
8. Click OK two times.

9. Right-click Kevin Cook and then click Properties.

10. Click the Communications tab.

11. Next to Additional options, click Configure.

12. Under Telephony, in the Line URI text box, type tel:+14255550258
13. Click OK two times.

14. Close the Office Communication Server 2007 console.
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Exercise 3

Testing the Voice Features of Office Communications Server 2007

Introduction

In this exercise, you will make various intra-office and outbound phone calls
between soft phones and also to and from an analog handset. You will test the
normalization rules by making calls using extensions, 10-digit numbers, and
user names. You will also use the redirect and call-handling features of
Office Communicator 2007.

Tip Learn more about Microsoft strategic gateway partners supporting Office
Communications Server 2007 at
http://www.microsoft.com/uc/pdgtrials/default. mspx

Important Please verify that Communicator is not running on both DC1 and
the host computer. If it is still running, you will need to right-click the
Communicator icon on the system tray and then click Exit before starting this
exercise.

£ start Office Communicator 2007 on DC1

m  On DC1, click Start=>All Programs—>Microsoft Office Communicator
2007 and wait for Communicator to log in as Kevin.

IZ Start Communicator on the host computer and initiate a phone call
between soft phones (Office Communicator 2007)

1. On the host computer, click Start>All Programs->Microsoft Office
Communicator 2007 and then log on as va@Litwarelnc.com with a
password of pass@wordl

2. In Office Communicator, right-click Kevin Cook, click Call, and then click
Communicator Call.

IZ Accept the phone call on DC1
1. On DCl1, notice the call coming in from Vivian Atlas.
2. Inthe Incoming Call prompt, click Answer Call.

3. On the host computer, click the End call “* button.

I Initiate a phone call between soft phones using extensions

1. On the host computer, in Office Communicator, type 50258 and then click
the Call 7% button.

2. Notice that the number is normalized to +1(425)555-0258

IZ Accept the phone call on DC1
1. On DCl1, notice the call coming in from Vivian Atlas.
2. Inthe Incoming Call prompt, click Answer Call..
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Notice that as soon as you accept the phone call, the extension number is
resolved to the user name.

Click the End call = button.

Initiate a phone call between soft phones using telephone numbers

On the host computer, in Office Communicator, type 5550258 and then
click the Call *: button.

Again, notice that the number is normalized to +1(425)555-0258.

Accept the phone call on DC1
On DC1, notice the call coming in from Vivian Atlas.
In the Incoming Call prompt, click Answer Call.

Notice that as soon as you accept the phone call, the phone number is
resolved to the user name.

Click the End call % button.
Try dialing 4255550069 to see how the different normalization rules work.

Initate a phone call between a soft phone and the analog handset

On the host computer, in Office Communicator, type 2065551236 and then
click the Call " button.

Pick up the handset and have a conversation to test the voice capabilities of
Office Communications Server 2007.

Hang up when finished.

Initate a phone call between the analog handset and a soft phone on the
host computer

On the handset, dial 4255550069.

On the host computer, notice the call coming in from the analog handset and
that the number has been resolved to Kevin Cook.

3. Inthe Incoming Call prompt, click Accept Call.

=

2.
3.

K

Hang up when finished.

Initiate a phone call on the host computer

On the host computer, in Office Communicator, type 50258 and then click
the Call button.

Use the Redirect feature of Office Communicator 2007 on DC1
On DC1, notice the call coming in from Vivian Atlas.

Click the Redirect R=d=ct pytton and then click Home +12065551236.
Pick up the handset to answer the redirected call. Hang up when connected.

Configure the Call-Forwarding Settings of Office Communicator 2007
on DC1
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1. On DCl1, in Office Communicator, click the Call-Forwarding &~ button
in the upper-right corner.

Notice the feature options here. You can set your client to automatically
forward to a specific number, or you can ring an additional number.

2. Click Call-Forwarding Settings.

3. Inthe Redirect unanswered calls to drop-down list, select Home
+12065551236.

4. Change Ring for this many seconds before redirecting to 5 and then click
OK.

I Initiate a phone call on the host computer
= On the host computer, in Office Communicator, type 50258 and then click
the Call button.

IZ Observe the Call Forwarding Settings forwarding the call to the
handset

1. On DC1, notice the call coming in from Vivian Atlas.

Do not answer the call, and notice that after 5 seconds the analog handset
will ring.

2. Pick up the handset to answer the redirected call. Hang up when finished.

£ Turn off the Call-Forwarding Settings of Office Communicator 2007 on
DC1

1. On DCl1, in Office Communicator, click the Call-Forwarding - button
in the upper-right corner.

2. Click Call-Forwarding Settings.

3. Inthe Redirect unanswered calls to drop-down list, select None and then
click OK.



Lab 7: Configuring and Using
Microsoft Exchange Server 2007
Unified Messaging

Objectives After completing this lab, you will be able to configure Unified Messaging and
Microsofte Office Communications Server 2007.

Note This lab focuses on the concepts in this module. As a result, it may not
comply with Microsoft security recommendations.

Prerequisites Before working on this lab, you must have completed all previous labs. If you
have not completed the previous labs, this lab will fail.

Scenario Now that you have fully deployed Office Communications Server 2007, you
want to integrate it with Microsofte Exchange Server 2007 to further take
advantage of the voice features of Office Communications Server 2007 and
Exchange Server 2007. You have already installed and configured the Unified
Messaging server role to your existing Exchange Server 2007 environment and
will now make the necessary configuration changes.

Estimated time to
complete this lab:
60 minutes
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Exercise 0
Lab Setup

To complete this lab, you will need to use the DC1, OCS-Std, and OCS-
Mediation Virtual PCs from the previous labs.
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Exercise 1

Configure Unified Messaging and Office Communications Server

2007

Introduction

In this exercise you will use the Exchange Management Shell to configure
Unified Messaging to work with OCS 2007. You will use the exchucutil.ps1
script to automate some of these steps and the use ocsumutil.exe to complete
the integration of Unified Messaging and Office Communications Server 2007.

Tip On DC1, in C:\OCS 2007, there is a file named UM Commands.doc that
contains each of these commands. You can copy and paste the commands into
the Exchange Management Shell to save time.

IZ Use the Exchange Management Shell on DC1 to create a new dial plan
1. OnDCl1, click Start> Log Off.
2. Atthe Log Off Windows prompt, click Log Off.

3. Atthe log in screen, press and hold the right ALT key, and then press
DELETE.

4. Log on to the Litwarelnc domain as administrator with a password of
pass@wordl

5. Click Start=> All Programs—> Microsoft Exchange Server 2007->
Exchange Management Shell.

6. Inthe Exchange Management Shell, at the PS prompt, type the following
cmdlet and then press ENTER:

New-umdialplan —name Litewarelnc —UriType “SipName” —\VoipSecurity
“SipSecured” -NumberOfDigitsInExtension 5

£ Add the dial plan to the Unified Messaging Server on DC1

s  On DCl, at the PS prompt, type the following cmdlet and then press
ENTER:

Set-UMServer —Id DC1 -DialPlans Litwarelnc

£ Enable Unified Messaging on DC1 for Kevin Cook, Vivian Atlas, and
Hao Chen

1. On DCl1, at the PS prompt, type the following text and then press ENTER:

Enable-ummailbox —id kc —ummailboxpolicy “Litwarelnc Default Policy”
—extensions 50258 —SIPResourceldentifier KC@ Litwarelnc.com —pin
425206

2. In the Exchange Management Shell, type the following text and then press
ENTER:

Enable-ummailbox —id va —ummailboxpolicy “Litwarelnc Default Policy”
—extensions 50069 —SIPResourceldentifier VA@ Litwarelnc.com —pin
425206
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3. In the Exchange Management Shell, type the following text and then press
ENTER:

Enable-ummailbox —id hc —ummailboxpolicy “Litwarelnc Default Policy”
—extensions 50227 —SIPResourceldentifier HC@ Litwarelnc.com —pin
425206

Leave the Exchange Management Shell running.

I£ Use exchucutil.ps1 PowerShell scripts on DC1

This script creates the UM IP gateway and a new hunt group, and also sets the
appropriate Microsoft® Active Directory® permissions for OCS.

Tip The exchucutul.ps1 script is included with the Exchange Server 2007
Service Pack 1 (SP1) Resource Kit.

1. On DCl1, in the Exchange Management Shell, at the PS prompt, type cd
»c:\program files\microsoft\exchange server\scripts” and then press
ENTER.

2. Type \exchucutil.ps1 and then press ENTER.
Wait for the script to finish and then review the displayed information.

3. Write down the name listed as the UMIPGateway on the last line returned.
This should be OCS-Std.

4. In the Exchange Management Shell, type the following text and then press
ENTER:

Set-umipgateway —identity OCS-Std —port 5061

5. In the Exchange Management Shell, type the following text and then press
ENTER:

New-umautoattendant —name Litwarelnc_AA —umdialplan Litwarelnc
—PilotldentifierList Litwarelnc_AA

6. Close the Exchange Management Shell.

£ Use OCSUMUTIL to configure Office Communications Server 2007 on
OCS-STD

You will now use the OCSUMUTIL to link OCS to the Unified Messaging
infrastructure that you just created.

1. On OCS-STD, open a command prompt, type cd “c:\Program
Files\Microsoft Office Communications Server 2007\Server\Support”
and then press ENTER.

2. Type ocsumutil /domain:Litwarelnc.com and then press ENTER.

3. Wait for the tool to finish. You can safely ignore any warnings and then
close the command prompt.

I Restart the Unified Messaging service on DC1
1. On DC], click Start and then click Services.

2. Inthe Services console, right-click Microsoft Exchange Unified
Messaging and then click Restart.
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This will force Unified Messaging to read the new configuration to OCS.
3. Close Services.

£ Restart the Office Communications Server Front End service on OCS-
STD

1. On OCS-STD, click Start and then click Services.

2. Inthe Services console, right-click Office Communications Server Front-
End and then click Restart.

This will force OCS to read the new configuration to UM.
3. Close Services.
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Exercise 2

Configure Personal Voice Mail Settings and Test Unified Messaging

Introduction

You will now demonstrate Exchange Server 2007 Unified Messaging and
Office Communications Server 2007 working together. You will first set Vivian
Atlas’s personal settings and then leave him a voice mail. You will then see and
listen to the voice mail in Microsoft Office Outlooke 2007 and from Outlook
Web Access. If time permits, there is a short list of other tasks you can perform
to see more of what Unified Messaging has to offer.

Note You may have to wait a couple of minutes for the integration to
complete.

K
1
2.

Set personal options for Vivian Atlas on the host computer
On the host computer, open Microsoft Office Outlook 2007.

Locate the Welcome to Exchange Unified Messaging message and notice
your extension and temporary PIN.

3. Start Office Communicator as Vivian Atlas.

4. Click the drop-down arrow in the upper-right corner and then click Call

M w b Re

1.

Voice Mail.
Follow the voice prompts to set up a PIN and personal greeting for Vivian.

Click the keypad % button in Office Communicator to navigate the
Unified Messaging voice mail system.

Leave a voice mail message for Vivian Atlas using the handset
On the analog handset, dial 4255550069.
On the host computer, notice the incoming call but do not answer the call.

Listen on the analog phone as you are sent to Vivian Atlas’s voice mail and
are prompted to leave a message.

Leave a message and then hang up.

Listen to Vivian Atlas’s voice mail message using Outlook 2007 on the
host computer

On the host computer, switch to Outlook.

In Vivian’s Inbox, notice the voice mail message.
Open the voice mail message and then click Play.
Close Outlook 2007.

Listen to Vivian Atlas’s voice mail message using Outlook Web Access
on the host computer

On the host computer, click Start->All Programs—> Internet Explorer.
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K
1
2.
3.
4.

In the Address bar of Internet Explorer, type
https://mail.Litwarelnc.com/owa and then press ENTER.

On the Outlook Web Access login page, type Litwarelnc\va for
Domain\user name, type pass@word1 for the Password, and then click
Log On.

On the Accessibility page, click OK.

In Vivian Atlas’s Inbox, notice the new voice mail message.
Open the voice mail message and then click Play.

Close Internet Explorer.

(If time allows) Perform additional Unified Messaging tasks
Listen to your e-mail using Unified Messaging.

Listen to your calendar using Unified Messaging.

Reply to an e-mail message using Unified Messaging

Send a calendar request using Unified Messaging.



Lab 8: Compliance and Archiving in
Office Communications Server 2007

Objectives

Prerequisites

Scenario

Estimated time to

complete this lab:

60 minutes

After completing this lab, you will be able to:

m Install and activate the archiving service.

m Associate the archiving service with the front-end server.
m Configure users for archiving.

= View archived messaging in the database.

Note This lab focuses on the concepts in this module. As a result, it may not
comply with Microsoft security recommendations.

Before working on this lab, you must have completed Lab 1-Deploying and
Configuring Microsofte Office Communications Server 2007 and Lab 2-
Enabling Users and Installing Office Communicator 2007. If you have not
completed these labs, this lab will fail.

For legal and compliance reasons, Litware, Inc. has decided to start archiving
all Instant Messaging (IM) communications. To do this, they will install and
configure an Office Communications Server 2007 Archiving Service to help
with their compliance solution. After you have activated the archiving service,
you must associate the archiving service with each Standard Edition server and
Enterprise Edition pool whose traffic the service will archive.
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Exercise 0
Lab Setup

To complete this lab, you will need to use the DC1 and OCS-STD Virtual PCs
from the previous labs. You will to need shut down the OCS-Mediation server
and then start the OCS-Archiving Virtual PC. If your host computer has
enough memory and resources you may leave Office Communications Server
2007-Mediation running and start Office Communications Server 2007-
Archiving.

£ Shut down the Virtual PC OCS-Mediation

1. On OCS-Mediation, click Start and then click Shut Down.

2. At the Shut Down Windows prompt, select Shut Down in the drop-down
menu and then click OK.

3. Wait as Windows shuts down, and then at the Close prompt, select Save
undo disk changes and then click OK.

I start and log on to the OCS-Archiving Virtual PC

1. On the host computer, in the Virtual PC Console, turn on the OCS-
Archiving virtual PC by clicking OCS-Archiving and then clicking the
Start button.

2. A new OCS-Archiving virtual PC console opens. At the logon screen, press
and hold the right ALT key and then press DELETE.

3. Log on to the Litwarelnc domain as Administrator with a password of
pass@wordl

Important Click OK to any prompts regarding any services that fail to start,
and then review Services to verify that all have started successfully.
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Exercise 1

Installing and Activating the Archiving Service

Introduction

In this exercise, you will install and activate the archiving service on OCS-
Archiving. To help save time, all of the prerequisites have been preinstalled.
These include Microsoft SQL Server™ on OCS-Archiving and Message
Queuing on OCS-STD.

Tip For more information about Archiving and Call Detail Record (CDR)
server, please review the Office Communications Server 2007 Archiving and
CDR Server Deployment Guide included with the OCS 2007 documentation
available for download at Microsoft.com.

I Install the Archiving service on OCS-Archiving

1. On the OCS-Archiving Virtual PC, open Microsoft Windowse Explorer,
navigate to C:\OCS 2007\Setup\1386, and then double-click Setup.exe.

2. On the Deployment Wizard page, click Deploy Other Server Roles.

3. On the Deploy Other Server Roles page, click Deploy Archiving and CDR
Server.

4. On the Archiving Service page, next to Step 1: Install Files for Archiving
and CDR Server, click Install.

5. On the Welcome to the Microsoft Office Communications Server 2007,
Archiving and CDR Server Setup Wizard page, click Next.

6. On the License Agreement page, review the license agreement, click |
accept the terms in the license agreement, and then click Next.

7. On the Install location for Microsoft Office Communications Server 2007,
Archiving and CDR Server page, accept the default location and then click
Next.

8. On the Message queue path for Office Communications Server 2007,
Archiving and CDR Server page, verify that the folder in the Message
gueue path name text box is LCSLog, and then click Next.

9. On the Confirm Installation page, click Next to begin installation.
10. On the Installation Complete page, click Close.

£ Activate the Archiving service on OCS-Archiving

1. On OCS-Archiving, on the Archiving Service page, next to Step 2:
Activate Archiving and CDR Server, click Run.

2. In the Welcome to the Activate Archiving Service Wizard, click Next.

3. On the Select Service Account page, type pass@wordl in the Password
and Confirm Password text fields, and then click Next.

4. On the Select SQL Server Instance and Database page, in the Enter SQL
Server instance used by the Archiving Service text field, type OCS-
Archiving

5. Accept the default Database name of LcsLog and then click Next.
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6. On the Option for Reusing Existing Database page, click Next.

Note If you select the Replace any existing database check box, any
existing database on the SQL Server instance will be deleted, and all of its
data will be lost.

7. On the Location for Database Files page, review the default locations and
then click Next.

Note In a production environment, you would not put your databases on
the system disk as is done here in the lab environment.

Note You must start SQL Server (the MSSQLServer service) before you
start the Archiving service (the RTCLog service).

8. On the Start Service Option page, verify that Start the service after
activation is selected and then click Next.

9. On the Ready to Activate Archiving Service page, click Next to activate the
archiving service.

10. When the wizard has finished, select View the log when you click ‘Finish’
and then click Finish.

11. Switch to the log and review it to verify that all tasks completed
successfully, and then close the log file.

12. On the Archiving and CDR page of the Office Communications Server 2007
Deployment Wizard, click Exit.

Note In a production environment, if you install the Archiving service on
multiple servers in an Enterprise Edition pool, you must activate the
Archiving service on each server. Repeat the procedures in this section on
each server in the pool.
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Exercise 2

Associating the Archiving Service with the Front-End Server

Introduction

In this exercise, you will configure archiving for Litware, Inc. by enabling
archiving on all users and associating the Office Communications Server with
the Archiving service. You will then finish the configuration of archiving by
setting a message queue path, activating content archiving, and restarting the
Front-End services.

Note In a production environment, you must perform the following procedure
on each Office Communications Server whose traffic you want to archive.

K

Associate the Office Communications Server with the Archiving service
on OCS-STD

Switch to the OCS-STD virtual PC and then click Start-> Administrative
Tools=> Office Communications Server 2007.

Right-click Forest - Litwareinc.com, point to Properties, and then click
Global Properties.

3. Click the Archiving tab.

Under Internal communications, select Archive for all users to enable all
users to be archived, and then click OK.

Expand the Forest node, expand Standard Edition Servers, right-click
OCS-Std, click Properties, and then click Front End Properties.

6. Click the Archiving tab.
7. On the Archiving tab, in the Office Communications Server list, click

10.

11.

12.
13.

14.

OCS-STD.Litwarelnc.com, and then click Associate.

In the Associate Queue Path dialog box, in Message queue path name,
type OCS-Archiving and then click OK.

In the warning dialog box, click OK.

In Front End Properties, select Activate content archiving, and then click
OK.

Leave the Office Communications Server 2007, Administration Tools
console running.

Note Call detail records are not supported on Forwarding Proxy servers.
Call detail records that pertain to meetings are not supported on servers that
are in the Director role.

Click Start=> Administrative Tools=> Services.

In the Services list, right-click Office Communications Server Front-
End, and then click Restart.

After the Communications Server service has restarted, close the Services
console.

Note Whenever you change the archiving or CDR settings for a pool, you
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should restart all front-end servers in the pool to ensure that the settings take
effect uniformly. If you put archiving into critical mode on your front-end
servers and you then disable archiving and CDR, you must restart all front-
end servers. Otherwise, one or more front-end servers could stop running.
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Exercise 3

Viewing Archived Messages in the Database

Introduction

In this exercise, you will participate in an Instant Messaging (IM) conversation
and view the archived messages using SQL Server Management Studio.

I Start an archived IM conversation on the host computer

1.

On the host computer, if Office Communicator is not already running, click
Start-> All Programs-> Microsoft Office Communicator 2007. Log in as
va@L.itwarelnc.com with a password of pass@word1

2. Right-click Kevin Cook, and then click Send an Instant Message.

3. Inthe Kevin Cook- Conversation window, type a message and then press

ENTER.

Participate in an archived IM conversation on DC1
On DC1, click Start> Log Off.
At the Log Off Windows prompt, click Log Off.

At the log in screen, press and hold the right ALT key, and then press
DELETE.

4. Log on to the Litwarelnc domain as kc with a password of pass@word1
5. Click Start=> All Programs—> Microsoft Office Communicator 2007.

Log in as KC@L.itwarelnc.com with a password of pass@wordl

Have a short IM conversation between Kevin Cook and Vivian Atlas, and
then close the conversation windows.

I View archived traffic on OCS-Archiving

1.

On OCS-Archiving, click Start-> All Programs—> Microsoft SQL Server
2005-> SQL Server Management Studio.

In the Connect to Server window, verify that the Server name is OCS-
Archiving and that the Authentication is set as Windows Authentication,
and then click Connect. This may take a moment.

3. In the toolbar above Object explorer, click New Query.

4. In the query window, type the following query (case-sensitive) and then, in

the SQL Editor toolbar, click Execute.

USE Lcslog
GO
SELECT * FROM Messages

In the query results, scroll over to the Body column and view the results.
You can see the messages from the conversation you just had.
Close SQL Server Management Studio without saving query results.



Lab 9: Installing and Configuring
Communicator Web Access

Objectives

Prerequisites

Scenario

Estimated time to
complete this lab: 30
minutes

After completing this lab, you will be able to:

= Install and configure Communicator Web Access (CWA).
m  Use Communicator Web Access.

Note This lab focuses on the concepts in this module. As a result, it may not
comply with Microsoft security recommendations.

Before working on this lab, you must have completed the previous labs. If you
have not completed the previous labs, this lab will fail.

To make Microsoft® Office Communications Server (OCS) 2007 even more
useful to Litware, Inc.’s employees, management has decided to install and
configure Communicator Web Access. This will give users access to Office
Communicator from any computer in the world that has Internet access.
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Exercise 0
Lab Setup

To complete this lab, you will need to use the DC1 and OCS-Std Virtual PCs
from the previous labs. To mitigate lack of resources, you will need to shut
down the OCS-Archiving server without saving changes and then restart it.

I Shut down the Virtual PC on OCS-Archiving
1. On OCS- Archiving, click Start and then click Shut Down.

2. At the Shut Down Windows prompt, select Shut Down in the drop-down
menu and then click OK.

3. Wait as Microsoft Windows® shuts down, and then at the Close prompt,
select Shutdown and Delete Changes and then click OK.

I£ Restart and log on to the OCS-Archiving Virtual PC on the host
computer
1. On the host computer, in the Virtual PC Console, turn on the OCS-

Archiving virtual PC by clicking OCS-ARCHIVING and then clicking the
Start button.

2. A new OCS-ARCHIVING virtual PC console opens. At the logon screen,
press and hold the right ALT key and then press DELETE.

3. Log on to the Litwarelnc domain as Administrator with a password of
pass@wordl

Important Click OK to any prompts regarding any services that fail to start,
and then review Services to verify that all have started successfully.
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Exercise 1

Installing and Configuring Communicator Web Access

K
1

Request a certificate for CWA

On OCS-ARCHIVING, click Start, click Run, type mmc and then click
OK.

2. Click File and then click Add/Remove Snap-in.
3. In the Add/Remove Snap-in dialog box, click Add.
4. Inthe Add Standalone Snap-in window, click Certificates and then click

Add.

On the Certificates snap-in page, select Computer account, click Next, and
then click Finish.

Click Close and then click OK.

7. Expand Certificates and then click Personal.

8. Right-click Personal, point to All Tasks, and then click Request New

9.

10.

11.
12.
13.

14.
15.
16.
17.

18.

K

Certificate.
On the Welcome page, click Next.

On the Certificate Types page, select the Advanced checkbox and then
click Next.

On the Cryptographic Service Provider page, click Next.
On the Certification Authority page, click Next.

On the Certificate Friendly Name and Description page, in the Friendly
name box, type CWACert and then click Next.

On the completion page, click Finish.
At the Certificate Request Wizard prompt, click OK.
Right-click Certificates and then click Refresh.

Expand Personal, click Certificates, and then verify that the new certificate
is available.

Close the Certificates console without saving changes.

Install Communicator Web Access

On OCS-ARCHIVING, click Start=> All Programs—> Accessories>
Windows Explorer.

1. Navigate to C:\OCS 2007\Setup\i386 and double-click Setup.exe.

On the Deploy Microsoft Office Communications Server 2007 page, click
Deploy Other Server Roles.

On the Deploy Other Server Roles page, click Deploy Communicator Web
Access.

On the Deploy Communicator Web Access page, next to Step 1: Install
Communicator Web Access, click Install.

5. On the Welcome page, click Next.

6. On the License Agreement page, select | accept the terms in the license

agreement and then click Next.
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8.
9.

10.

K
1.

On the Customer Information page, in the Organization text box, type
Litwarelnc and then click Next.

On the Ready to install page, click Next.
On the next Ready to install page, click Install.
On the Setup Complete page, click Finish.

Activate Communicator Web Access

On OCS-ARCHIVING, on the Deploy Communicator Web Access page,
next to Step 2: Activate Communicator Web Access, click Run.

On the Welcome page, wait for the Activation Wizard to gather prerequisite
information. When it has finished, click Next.

On the Select domain service account page, for the Account name, type
CWAService

In the Password and Confirm Password text boxes, type pass@wordl
and then click Next.

5. On the Select Server Certificate page, click Select Certificate.

6. In the Select Certificate window, click the certificate with the Friendly name

CWACert, click OK, and then click Next.

7. On the Ready to activate Communicator Web Access page, click Next.

8. On the completion page, click View Log.

10.

11.

K
1.

Switch to the Deployment Log that has opened.

In the Execution Result column, to confirm the successful activation of
Microsoft Office Communicator Web Access, verify that each task’s result
is Success. Close the Deployment Log window.

Click Finish.

Create an internal virtual server for Communicator Web Access

On OCS-ARCHIVING, on the Deploy Microsoft Office Communicator
Web Access page, next to Step 3: Create a Virtual Server, click Run.

2. On the Welcome page, click Next.

3. On the Select Virtual Server Type page, click Internal and then click Next.

4. On the Select Authentication Type page, leave the default selection of Use

10.

built-in authentication and then click Next.

On the Select authentication method page, verify that both check boxes are
selected and then click Next.

On the Select Browser Connection Type page, verify that HTTPS
(recommended) is selected and then click Select Certificate.

In the Select Certificate window, click the certificate with the Friendly name
CWACert, click OK, and then click Next.

On the Select IP address and port setting page, leave the defaults of All
Unassigned and 443 and then click Next.

On the Name the Virtual Server page, verify that the name is set as
Communicator Web Access and then click Next.

On the Automatically Start Virtual Server page, click Next.
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11. On the Review virtual server settings page, click Next.
12. On the completion page, click View Log.
13. Switch to the Deployment Log that has opened.

14. In the Execution Result column, verify that each task’s result is Success to
confirm the successful activation of Microsoft Office Communicator Web
Access. Close the Deployment Log window.

15. On the completion page, click Finish.
16. On the Deploy Microsoft Communicator Web Access page, click Exit.

£ Test Communicator Web Access from the host computer
1. On the host computer, start Microsoft Internet Explorer.

Important Please turn off all pop-up blockers before continuing.

2. Inthe Address field, type the URL https://OCS-
ARCHIVING.Litwarelnc.com/cwa and then press ENTER.

3. On the Communicator Web Access page, click Sign In.

4. Atthe Connect to OCS-ARCHIVING.Litwarelnc.com login prompt, in
the User name text box, type Litwarelnc\kc and then, in the Password text
box, type pass@word1l and click OK.

5. Open or switch to Office Communicator. If necessary, sign in as
VA@Litwarelnc.com with a password of pass@wordl

6. Switch to the Internet Explorer browser running Communicator Web
Access. Notice that Vivian Atlas shows and that her presence is up to date.

7. Right-click Vivian Atlas and then click Send an Instant Message.

8. In the communications window, type a message to Vivian and then press
ENTER.

9. Reply to the Instant Message from Kevin.
10. On both host computers, close all Office Communicator windows.





